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Preface

This preface contains the following sections:
e Documentation accessibility

* Related resources

e Access to Oracle Support

e Revision History

Documentation accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Related resources

For information about Oracle Argus patches, see My Oracle Support.

All documentation and other supporting materials are available on the Oracle Help Center.

Access to Oracle Support

ORACLE

To receive support assistance, determine whether your organization is a cloud or on-
premises customer. If you're not sure, use Support Cloud.

Cloud customers receive support assistance through Support Cloud

Oracle customers that have purchased support have access to electronic support through
Support Cloud.

Contact our Oracle Customer Support Services team by logging requests in one of the
following locations:

» English interface of Oracle Health Sciences Customer Support Portal (https://
hsgbu.custhelp.com/)

» Japanese interface of Oracle Health Sciences Customer Support Portal (https://hsgbu-
jp-custhelp.com/)

You can also call our 24x7 help desk. For information, visit http://www.oracle.com/us/support/
contact/health-sciences-cloud-support/index.html or visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=trs if you are hearing impaired.


http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1077580.1
https://docs.oracle.com/en/industries/health-sciences/argus-safety/index.html
https://hsgbu.custhelp.com/
https://hsgbu.custhelp.com/
https://hsgbu-jp.custhelp.com/
https://hsgbu-jp.custhelp.com/
http://www.oracle.com/us/support/contact/health-sciences-cloud-support/index.html
http://www.oracle.com/us/support/contact/health-sciences-cloud-support/index.html
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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On-premises customers receive support assistance through My Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Revision History
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Date, Version Description

May 2022, Version 2 The guide has been revised for the following:
¢« Removed obsolete information.
e Added details on behavior of the Allow generation of
report switch.
« Added missing product types for case data and reporting.

April 2021, Version 1 Initial release.



http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs

Introduction

Oracle Argus Safety assists manufacturers of pharmaceuticals and devices by providing a
simple and efficient way to comply with international and domestic regulatory safety reporting
requirements. It also facilitates internal company safety surveillance by providing tools for
signal detection and for analyzing the overall safety profile of both investigational compounds
and marketed products.

# Note:

An * has been placed before fields that have been introduced in a previous release
but are currently non-operational.

For more information, see:

e Oracle Argus Safety Configuration Process Overview
* Usage Conventions

e Getting Started

* Argus Console Architecture

e Administrator Login

Oracle Argus Safety Configuration Process Overview

ORACLE

To configure Oracle Argus Safety, the Administrator must follow a particular sequence of
steps. Steps that fall later in the sequence might depend on those that appear earlier. It is,
therefore, important for the Administrator to use the following flowchart as a guideline for
configuring Oracle Argus Safety.
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Chapter 1
Usage Conventions

Task Purpose

Configure User Sites, Groups Enter user sites, create user groups and user accounts,

and Accounts configure group and individual user access rights.

Configure Products Configure Manufacturers, Ingredients, Formulations, Dosage
Units, Product Families, and Data Sheets.

Configure Licenses Enter license information, countries and products associated
with the license.

Configure Code List Items Configure list maintenance items that are not covered in other
topics, like Action Taken, Clinical Studies, Study Centers, etc.

Configure Workflow Configure case workflow states and rules that determine the
transition of cases between states.

Configure Regulatory Configure Regulatory Agency information and expedited

Reporting reporting rules.

Configure System Options Configure miscellaneous system items like Auto-numbering,
Field Labels, etc.

Configure Case Form Configure Case Form dictionaries, duration calculations, etc.

Configure Letters Create letter templates by using template placeholders.

Configure Database Common Configure the Common Profiles Table to customize the Oracle
Profiles Argus Safety application.

Usage Conventions

The following conventions are used throughout this document to help you identify
specific kinds of information.

Usage Convention Description

Bold User interface elements such as Buttons, Dialog boxes, Check boxes,
Combo boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs,
Text boxes, etc.

"between quotation Information that may appear as-is on screen, or information provided

marks" by the user.

Note: Text Information that should be noted before proceeding with the
instructions.

Important! Text Important information that must be noted to ensure accurate, reliable,
or safe behavior of the system.

Tip: Text Information that enables easier completion of the current task or helps
in completing other tasks.

ALL CAPITALS Keyboard keys

Initial Capitals Names of user interface elements, modules, applications, proper
nouns, etc.

Getting Started

This section introduces the basic tasks for configuring Oracle Argus Safety. To get
started with the configuration process, the person responsible for configuring Oracle
Argus Safety must log on as Administrator to configure the Argus Console.

ORACLE 1-2



Chapter 1
Argus Console Architecture

Refer to the following sections for information pertaining to:

Section Topics Covered

Administrator Login e Logging in and out of the Argus Console
e Changing the Administrator password
e Accessing the Home Page and Online Help

Understanding Argus Read this section for an overview of the Argus Console user interface
Console user interface  components.

Argus Console Architecture

The Oracle Argus Web Administration Console has been designed to enhance ease of
navigation for the Oracle Argus Safety end-users.

The following illustration shows the design and location of the individual components under
the main Argus Console Menu.

" Note:

The menu items that you can access depend on the security permissions that are
defined for your account by the administrator.

omcie ARGUS SAFETY

ORACLE’ Argus Safety Web
| Active Cases | Worklist | CaseActions | Reports | Local Afiliate Utilties | Dashboards || Argus Console

Business Access System
Configuration Management Configuration

Code Lists

Products and Case Priority ICSR Length

Licenses Check
Field Validation

Flexible Data
Re-Categorization

Studies

Field Properties

Expedited Report Crin: LAM System
Rules Numbering

System Management
(Common Profile

Workflow
System Numbering
SMTP Configuration

Enabled Modules

Interchange Mapping

ORACLE"
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Chapter 1
Argus Console Architecture

For more information, see:

* Required Fields
e Standard Buttons

e Standard Icons

Required Fields

Fields that are marked with a red flag image and associated with an orange boundary
are required fields. These fields must be filled in, to proceed with the configuration

requirements.

Standard Buttons

The standard buttons used in this console are described in the following table:

Button Description

Save Use this button to save changes associated with a section.

Cancel Use this button to cancel changes associated with a section.

Print Use this button to print information associated with a sub-section in a
PDF.

Delete Use this button to delete an item associated with a section.

Copy Use this button to create a new editable copy of an item within a
section.

OK Use this button to confirm an action associated with a section.

Yes Use this button to confirm an action associated with a section.

No Use this button to cancel an action associated with a section.

Help Use this button to launch the online manual for the Argus Console.

Add New Use this button to add a new item associated with a section.

Standard Icons

The standard icons used in this console are described in the following table:

ORACLE

Icon

Identifies

w

A required field.

An item placed inside a folder in the tree-view.

1-4



Chapter 1
Argus Console Architecture

Icon Identifies

A closed folder containing sub-folders or nodes.

An open folder displaying sub-folders or nodes.

An open folder that does not contain sub-folders or nodes.

A closed folder that does not contain sub-folders or nodes.

An expandable or collapsible browser tree view.

An option to sort columns alphabetically (when placed next to a column

header).
£
An item appearing under multiple categories (e.g. a user name
appearing under multiple groups).
A withdrawn license in the tree-view of licenses.
L1
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Chapter 1
Administrator Login

Administrator Login

When Argus Safety is installed, an account for the Administrator is automatically
created. The installation program assigns admin as both the User Name and
Password for this account.

Before logging in to the Argus Console, be aware of the following:

e If you enter an incorrect username or password three (3) consecutive times, the
system disables the Login button and displays the following message:

The login button has been disabled due to 3 consecutive incorrect entries of
Username or Password. Please refresh the page to enable the Login button

e The Date/Time 24-hour format used by the Web server: DD-MMM-YYYY
HH:MM:SS.

¢ Note:

The Administrator or System password can be reset from new Argus Key
Management Tool > Reset Password for the default Administrator and
System Account.

For more information, see:

* Logging In as an Administrator

*  Changing the Administrator's Password
* Logging out

* Accessing the Home Page

* Launching Online Help

*  View the Error Log

* Understanding Argus Console GUI

Logging In as an Administrator

1. Enter the Argus URL in your web browser, to launch Oracle Argus Safety.

Tip:
e The modules displayed in bold text identify the modules you have

permission to access.

e Your login user ID and password are valid for all accessible Argus
modules.

2. Enter the User Name and Password to login to Oracle Argus Safety.
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Chapter 1
Administrator Login

< Note:

The password is case-sensitive.

3. Select the database name from the Database list.
4. Press Enter or click Login.

5. When the window opens, click Yes to proceed with the login.

" Note:

If the window does not appear, verify that your browser's pop-up blocker is
disabled.

6. Click Argus Console to launch the Argus Console Administrator screen.

< Note:

If the window does not appear, verify that your browser's pop-up blocker is
disabled.

Changing the Administrator's Password

1. Select Utilities > Change Password in Oracle Argus Safety and the Change Password
dialog opens.

2. Enter the current password and the new password.

# Note:

In case of a Single Sign-On user, the Change Password option is not supported
in Argus Safety.

3. Confirm the new password and click OK.

Logging out
1. Click Close to leave the Argus Console application.

2. To log out at any time from Oracle Argus Safety, click Logout.

Accessing the Home Page

To go back to the Home page, click Home. The default Home page appears.

Launching Online Help

To launch the Online Help, click Help.

ORACLE 1-7



View the Error Log

To view the error log for information about errors that occurred during case processing:

Chapter 1
Administrator Login

1. From the Utilities drop-down menu, go to Logs > View Error Log.

2. To search for error logs based on pre-defined or custom date ranges, in the
Search Conditions section, enter a value, and click Search.

The search results appears in the Total Number of Rows section.

3. Locate the error log you want to view, and click to view the error message text.

4. Click the Zoom icon to view the complete text.

Understanding Argus Console GUI

This section broadly categorizes the sections of the Argus Console GUI with their
associated descriptions.

ORACLE

Section

Sub-Section

Description

Getting Started

Access Management

Business
Configuration

System Configuration

Sites

Groups

Users

Product and License

Studies Configuration

Expedited Reporting
Rules

Case Priority

Field Labels

This section provides information about new
keyboard navigation features for the Argus
Console.

This section enables the administrator to enter
and configure new user sites.

This section enables the administrator to enter
and configure new user groups.

This section enables the administrator to
configure user accounts.

This section helps in capturing Product Details
(product specifics, product licenses, products
involved in the studies.

These can be the products marketed, or under
investigation, by the company.

This section helps in capturing Study information
(study specifics, products involved in the study
licensed countries associated with the study and
the clinical references used in the expedited
reports.

This section helps in capturing Expedited
Reporting Rule configuration.

The Reporting Rules configuration feature
enables the administrator to define the reporting
rules or criteria for the cases to be qualified for
expedited reporting.

This section enables the administrator to
configure rules to determine the priority of new
cases that are entered into the system.

This section enables the administrator to change
field labels, hide and unhide fields in Case form.
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Chapter 1
Administrator Login

Section Sub-Section Description

Field Validation This section enables the administrator to
configure field level validations for the case form
fields.

LAM System This dialog enables the administrator to specify

Numbering the case numbering preferences for LAM cases.

System Management This section enables the configuration of

Common Profile Common Profile Switches that affect the

Switches behavior of the Argus application.

Workflow The section enables the configuration of
workflow states and rules, within the safety
department starting from initial case receipt to
case closure.

The system enables tracking of the progress of
cases between users and states of activity.

System Numbering  This section enables the administrator to specify
the case numbering preferences.

SMTP Configuration  This screen enables the user to configure SMTP
settings.

Interchange Mapping This section enables the user to access the
Interchange Mapping client utility from the Argus
application to set up and configure the Service
INI File.

Code Lists Code Lists This section helps in capturing Code List

Argus information. Code lists appear as drop-downs in
the Argus application.

Tools ICSR Length Check  This screen enables the user to view the ICSR

Length Check report in PDF format.
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Access Management

Site, group, and user configuration takes place in the Access Management section of Argus
Console. Here you can add, copy or delete users, groups or sites.

Each user must be assigned to at least one group in order to determine their security level.

Each group is assigned a specific security level. This security level enables members of the
group to view, modify, or restrict access rights to various sections of the Case Form, and so
on.

The first set of steps in configuring Argus Safety is to create the following exactly in the

listed order:
e Sites
e Groups
e Users
# Note:

The configuration must occur in the exact order specified above.

For more information, see:

*  Configuring User Sites
*  Configuring Groups
*  Configuring Users

»  User Configuration - Roles

Configuring User Sites

Addition of Sites is necessary in order to create Users because every user must be assigned
to exactly one Site. Site information can also be used in automatic numbering of case IDs.

To configure Sites, use the Access Management > Argus > Sites section. The following is
an illustration of that section.

For more information, see:

» Field Descriptions

e Adding User Sites

Field Descriptions

The following table lists and describes the fields on the screen.

ORACLE 2-1



Chapter 2
Configuring User Sites

Field or Control
Name

Description

Description

Abbreviation

Site Type

Protect Patient
Confidentiality -
Default

Protect Reporter
Confidentiality -
Default

Bulk report By form
(Approved reports) -

Default
LAM Sites

Site Printers

Enter a description of the site, like United States.

Enter an abbreviation of the site name. A one to four character
abbreviation is required for each site. Ex: US.

Select the Site Type Argus or LAM (Local Affiliate Module).

Protects or reveals Patient Confidentiality for the specific site.

Protects or reveals Reporter Confidentiality for the specific site.

Allows or protects availability of the Bulk Reports by Form for the
specific site.

Select and add previously created LAM sites.

The Site Printers section is used to configure site printers.

Adding User Sites

This screen helps in capturing Site information (such as user site description,
abbreviated term, site type and LAM site configuration).

ORACLE

Use the following procedure to add a user site.

1. Click Access Management > Argus > Sites.

2. Inthe left panel, select User Sites. The User Sites are listed in the right panel.

Tip:

You can alternatively click Modify to modify an existing site.
Use Copy to make an editable copy of an existing user site.

Use Delete to delete a user site.

3. Select a User Site and click Add New.

4. Enter the user site Description.

5. Enter the user site Abbreviation.

# Note:

A maximum four-character abbreviation is required for each user site.

6. Selectasite Type.

2-2



10.

11.
12.
13.

14.

Chapter 2
Configuring User Sites

< Note:

Each Oracle Argus Safety user must be assigned to exactly one user site.

You cannot change the site type from LAM to Central if the current central site
has an association with a LAM site, the current site is associated with any user,
or the current LAM site has any events assigned to it.

Select the following options as required:

» Select the Protect Patient Confidentiality - Default to protect or reveal Patient
Confidentiality for this specific user site.

* Select the Protect Reporter Confidentiality - Default to protect or reveal Reporter
Confidentiality for this specific user site.

* Select the Bulk Report by Form (Approved Reports) - Default to enable
availability of the Bulk Reports By Form for this specific site.

Add or remove any LAM Sites information.

Tip:

To add more LAM Sites to the Lam Sites list, use the Add>>/ Add All options.
To delete the LAM Sites from the Lam Sites list, use the Remove>>/Remove
All options.

In the Site Printers section, click Add to add a site printer.

Enter the Name of the printer that will be displayed in the application when referring to
the printer. The name can have up to 20 characters.

To delete a site printer, select the printer and click Delete.
Click Print to print the site information.

In the Path text box, enter the full path of the printer on the network. This path name can
have up to 256 characters. The specified path should be accessible from the machine
where Argus Safety Service is installed.

Click Save to save the information and return to the Code List Maintenance dialog.

About Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Access Management section. The filtering browser is
displayed as the Code Filter List

Argus Console helps you to filter information further for the Access Management section.
Using the Code Filter List you can specify whether your search should contain or start with
specific alphabets.

For example: The following filtering criteria enables the system to search for all User Sites
that contain A in the abbreviated term.

ORACLE
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Chapter 2
Configuring Groups

AddNew || ) | I

The right panel now displays the list of User Sites based on the filtering criterion.

Configuring Groups

Each user of Oracle Argus Safety can be a member of one or more user groups. The
access rights of each user group to the menus in the user interface and specific
sections of the Case Form can be configured when the group is created.

Configuration of the user site is done using the Access Management > Argus >
Groups Ssection.

The system enables users to configure access permissions for the Argus Console
from the Argus Console menu options. The available options:

*  Worklist
— Active
— Action items
— Archive

* Reports

— Context Matrix

— Management
*  Alerts Triggered
*  Assessor Statistics Breakdown
*  Pending Actions
*  Signal Metrics Report

— Pharmacovigilance
*  Analysis Report
* Increased Frequency Report
*  Patient Exposure Report

«  Utilities
— Configuration

*  Alert Configuration:

ORACLE" 2-4



Chapter 2

Configuring Groups

Primary Alert
Secondary Alert

Code List Maintenance
Event Group

Global configuration:
Global Alerting Criteria

Global Stop List
Global Template
Patient Exposure

Workflow
View Audit Log

View Error Log

Change Password

The printout displays all group permissions defined by the administrator.

For more information, see:

Field Descriptions

Adding User Groups

Printing

a User Group

About Filtering Criterion

Field Descriptions

The following table lists and describes the fields in the Modify Group Information section.

ORACLE’

Wlcoms crstian Thursda, Mareh 1, 2021 (aRsPopezo) W
CoseLisrs 1 Busivess Contguration) [ L fcoess enagement [ Syeiem Contipunton [ oos

‘GROUPS AND USERS

Browser

Organized by | Groups v | /| ¥ Group Name

Email

" Modify Group Information

Supervisor Email

|[Contains v ||

‘ [Administrator Group.

S+ User Groups.

Countries Selacted Countries
TTest Add>
e
AFGHANISTAN omove,
NI

ERiA
AMERICAN SAMOA
Restrictions

[ Products [Fe) () Studies e
‘ »
Add User Save AddGroup ][ Copy Delete

® Enabled O Disabled
® Enabled O Disabled +

= ARGUS Fie
-0 Administrator Group(26) piva
-2 End of Study Unblinding(0) o
- 20 Full Access Group(10) cony
& Investigator Group(10) P
%[ LS Codelist J restricted group(0) Case Form

[ Patient Rptr All Restricted Access Group(| | || General Information

(23 PatReporter Som Res
4 Product Resticted Group(2)

[ ProductinfoView(2)

-3 Study Resticted Group(2)
(2 VP Product Resticted Group(1)

=5 LOCALAFFILIATE
G20 LAM-Admin(4)

tict Access Grou

Other Relevant History
Product nformation (Drug View)
Dosaae Reaimen (Drua View)

| Advanced Condition
® Modify O View O NoAccess ~ | | ) NoAccess to Creats Advanced Conditions
[0 NoAccess to Share Advanced Conditions
() NoAccess to View and Edit SQL

® modiv O view O NoAccess ™
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Field or Control
Name

Description

Group Name

E-mail

Supervisor E-mail

Menus

Case Form

Advanced Condition

Advanced Condition

Listedness
Determination -
Countries

Restrictions -
Products

Restrictions - Studies

Default report (LAM
only)

Enter a unique name for the group.

Add the group e-mail, used for case priority notification and workflow
routing notification.

Add the Group's Supervisor E-mail as applicable. This e-mail address is
used to send notifications when the maximum time of a case for a
particular workflow state is exceeded.

Lists the menus and sub menus within a Case Form and allows you to
enable or disable each of them.

Lists the sections and sub sections within a Case Form and enables
you to assign the group Modify; View (Read Only); or No Access (hot
visible) to each area.

* If No Access to Create Advanced Conditions is selected, the
Advance Condition will not appear as an option for any user
belonging to the group.

. If No Access to Share Advanced Conditions is selected, any
user belonging to the group cannot share the Advance Conditions
with others.

* If No Access to View and Edit SQL is selected, the SQL option
will not appear for the user belonging to the group.

Allows you to configure advanced condition settings, as applicable. The
options are: No Access to Create Advanced Conditions, No Access to
Share Advanced Conditions, No Access to View and Edit SQL.

Assigns Argus users to the group that has rights to change the
listedness determination for licenses originating in the selected
countries.

When you enable this option and select the products, the users
associated with this product-restricted group can only view the cases
that have the assigned products. The cases that have other products
than those selected in the user group are not accessible.

When you enable this option and select the study, the users associated
with this study-restricted group can only view the cases that have the
assigned study. The cases that have another study than the one
selected in the user group are not accessible.

" Note:

When you select both the product and the
study restrictions for a user group, the
users associated with this group can only
view the cases that contain the study and
the products assigned to that group.

Lists the expedited report forms in the drop-down list.

ORACLE
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Adding User Groups

ORACLE

This section enables the Administrator to configure the security levels for each work group.

Radio buttons enable you to view the group and assign access rights for several specific
sections of the case form, menu, case workflow, and report workflow.

If a user belongs to multiple groups, the access rights for the user will be the sum-total of the
individual group access rights. Consider the following example:

John Smith is an Oracle Argus Safety User and his profile has been added to 2 user groups
with different access level permissions for each group.

John has access rights to the Patient Tab in one group and access rights to the General
Tab in another group.

In this case, John will be able to access both the Patient and the General tabs of Oracle
Argus Safety.

Use the following procedure to create a user group

1.

2.

Click Access Management > Argus > Groups.

Select the filtering criterion to display the list of Groups or Users in the left panel.

Select a Group and click to view the group details in the right panel.

ORACLE
[ RS Tr P e
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GROUPS AND USERS

Organized by | Groups v Supervisor Email

Gontains v | 7?‘
S5 User Groups
S5 Araus
-0 Adminstator Group(26)
-2 End of Sty Unbinding(0)
- A Full Access Group(10)
-2 Invstigaor Group(10)
LS Cod icted group(0)
@~ Patient Rptr All Restricted Access Group(

@ Enabled O Disabled ~

Copy

[Advanced Condiion

o Access.

Patient Information

& NoAccess
&5 0 Stuty Resticted Group(@) Other Relevant History

-2 VP Product Restricted Group(1)
=-iF LOCALAFFILIATE

- LAM-Admin4)

)View O No Access
Product Information (Drug View) iew O No Access.
Dosaoe Reaimen (Drua View) ® 1odife O View O NoAccess ™

Listedness Determination

Selected Countries

Add>
AFGHANISTAN <Remove
ALBANIA
ALGERIA AddAI>>
AVEERICAN SAMOA - <<RemoveAl
Restrictions.
() Products pe) | [ Studies ¥e)
‘ »
‘Add User Save ‘Add Group Copy || Delets Pt

Q Tip:

*  You can alternatively click Add Group to create a new group.
e Use Copy to make an editable copy of an existing group.

e Use Delete to delete a group.
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Enter the Group Name. This should be a unique name associated with this Group.

Enter the Email address, if applicable.

o o &

Enter the Supervisor Email address, if applicable.

7. Inthe Case Form section, select the desired access right option (Modify, View, or
No Access) for the group's access to each of the listed items of Case Form.

# Note:

The following fields are required in order to save a case: Initial Receipt
Date, Country of Incidence, Report Type, Suspect Product, and Event
Description as Reported. Therefore, the group responsible for initial case
entry must have access to these fields in order to save new cases.

The following user group accesses have been renamed:

e Case Patient — Personal Patient Information has been renamed as
Case Patient - Patient Information.

e Case Patient — Patient Information has been renamed as Case
Patient — Patient Details.

8. In the Menus section, enable or disable access of the group, to particular items in
the Oracle Argus Safety menu.

Tip:

Refer to the Oracle Argus Safety User's Guide for information about the
functions of the Case Form sections and the menu items in the Oracle
Argus Safety user interface.

9. In the Listedness Determination section, select a list of countries. This enables the
end user to override the listedness determination in the Event Assessment section
of the Case Form for product licenses that match the countries selected in this
step.

10. In the Advanced Conditions section, select No Access to Create Advanced
Condition, No Access to Share Advanced Conditions, and/or No Access to
View and Edit SQL.

# Note:

Only trusted users should be given access to Advanced Conditions. This
is because users who have this access will have complete access to the
information in the Argus Schema.

ORACLE 2-8



Chapter 2
Configuring Groups

Q Tip:
* If you select No Access to Create Advanced Condition, Advanced

Conditions does not appear as an option for that user group.

« If you select No Access to Share Advanced Conditions, the user group
does not have access to share Advanced Conditions.

« If you select No Access to View and Edit SQL, the SQL... button will not
appear as an option for that user group.

11. In the Restrictions section, select Products.
12. Click Add Product, to open the Available Products dialog box.

13. Select each product you want to add and click OK.

Awvailable Products

= | Products -~
@ [ [ ] Amoxicilin
|¢| [ ] Auto Injecting Syringe
% Ca ()BCG
|¢| [ | Catheter

[ | Combo_Devices

[ ] Combo_Family

[ ] Combo_Insulin

[ ] Combo_Penicillin
[ ] Combo_RabiesVac
[ ] COVID Vaccine

A W P W N W W Wy W W M g

[ | Diabex Family of Drugs
[+ [ ] Drug Eluting Stents
|¢. [ ] Global drugs family
|¢| [ | buprofen
|¢| [ ] Levocetirizine
|¢| [ ] MMR Vaccine Family
|1| [ | Nose Drops
|¢. [ ] Osteotide
|¢. [ | Paracetamol
|¢| [ ]Placebo
|i| & [ |Starzoko -

oK Cancel

14. In the Restrictions section, select Study.
15. Click Add Study, to open the Available Studies dialog box.

16. Click the appropriate checkboxes to select the required studies and click OK.
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Study Selection -- Webpage Dialog

Available Studies

= [ Studies
@- [ [JLs Project
- 3 [ JVPC_Project

OK Cancel

17. Click OK to save the group.
Groups Included with the Factory Data

The following table lists and describes the groups included with the factory data.

Group Description

Administrator This group has access rights to all areas and all the functionality of
Oracle Argus Safety.

Investigator Receives an e-mail alert that can be set up during Clinical Study
Configuration.

About Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Access Management section.

Using Organized by

The system displays the filtering browser in the top-left corner of the left panel. You
can filter based on either of the two combination shown in the following illustration.

ORACLE" 2-10



Chapter 2
Configuring Groups

Browser

Organized by Groups w

|{3{mtain5 v|

=[5 User Gro

. Users
=-L7 ARG

Consider the following.

If you enable Organized by Groups, the generated output displays in a tree-format in
the left panel. The structure is based on the entire categorization of Groups and Users

If you enable the Organized by Users, only the User list is available in the tree view in
the left panel.

Using contains or starts with enables you to specify whether your search should contain or
start with specific alphabetic characters. For example, filtering criterion shown in the following
illustration enables the system to for all Groups that contain the word "administrator.”

Browser

Organized by | Groups w

Contains W |administrat{:r || Filter

ups
us
dministrator Group(26)

Starts with

Printing a User Group

Use the following procedure to print a user group.

1.
2.

Select Access Management > Argus > Groups.

Select the filtering criterion to display the list of Groups or Users (based on the filtering
criterion) in the left panel.

Select a Group and click to view the group details in the right panel.

Click Print to display a Print dialog that enables you to choose to print the entire window
or to print only the text covered by the current selection.

Select the appropriate options and click OK.

The system opens the Print Groups to enable the user select the sections to be printed in
the Group Configuration printout.

By default, the Group Information checkbox is selected and disabled so that it always
gets printed.

ORACLE"
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7. Select the appropriate checkboxes, and click OK.

Argus Console - Print - Webpage Dialog

Print Groups

Group Information
| |Case Form
[ |Menus
| ] Listedness Determination
| ] Advanced Condition Permissions
| | Restrictions - Products

| | Restrictions - Studies

| |Users

Group Configuration Print Out
The following is an illustration of the Group Configuration printout.

» It lists the users which are configured to the groups.

» User are sorted alphabetically by User Full Name in the report section

Full Name User ID Site
aditi aditi us
Administrator admin

alexandra alexandra us
Beena Wood beenawood us
Beena Wood UK only beenawoodUK UK
binchu binchu us
cristian cristian us

About Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Access Management section.

Using Organized by
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The system displays the filtering browser in the top-left corner of the left panel. You can filter
based on either of the two combinations.

Consider the following:

e If you enable Organized by Groups, the generated output displays in a tree-format in
the left panel. The structure is based on the entire categorization of Groups and Users.

e If you enable the Organized by Users, only the User list is available in the tree view in
the left panel.

Using contains or starts with enables you to specify whether your search should contain or
start with specific alphabetic characters. For example, filtering criterion shown in the following
illustration enables the system to for all Groups that contain the word "administrator".

Configuring Users

User Maintenance enables you to add, copy, or delete users for the system.

» Each user must be assigned to at least one group in order to determine security level.

» Each group is assigned a specific security level that defines whether group members can
view, modify, or have no access rights to various sections of the case form, etc.

Configuration of the users is done using the Access Management > Argus > Users
section. If the Enable LDAP Login check box is not checked, you can specify a password
when creating or modifying an individual user account. When updating user records, be
aware of the following:

« If you enter a value in the Password field, the system uses this password to authenticate
at login.

* The Reset Password field is available only when you select Reset Password. The new
password can be up to 30 characters.

» If you leave the value blank, the system uses the default password as defined in the
Common Profile for the system.

*  When you save the user configuration, the system saves the default password you enter.
e During entry, the system displays the password you type.

The following illustration shows the fields associated with this section.

aditia

¥ User Name ¥ UserlD Email Address
aditia aditia [ |
Service User
— LDAP Server Alias
[_JEnable LDAP Login
¥ Application Access Default Application
4 argus Einsight B cConsole Argus v
Access
[ Account Disabled [T Force Passward Change At Login —
- g I —
[ security Disabled Account [ Force Password To Expire Every| | Days
¥ site ¥ UserType Worklist To Display At Login
| Auto_United States ~ | | ARGUS USER v [~None~ v
¥ User Group 2 select| | [UserRoles 2 select| | [Case Form
Administrator Group AC Library Admin Allow Unblinding Of Cases
SG Administrator Gi Copy Configurati
mintator Group 2Py Bonguration Protect From Unblinded Information
Enterprise User -
ESM Admin [ protect From Printing Unblinded Infarmation
Global Admin % Allow Locking Of Cases
Workflow Manager [ alow Local Locking
[J Allow Forced Unlock On Pending Reports.
% Allow Global Unlock On Pending Local Lock
% atlow Closing Of Cases M

For more information, see:
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» Field Descriptions

e Printing Users

Field Descriptions

The following table lists and describes the fields in the Administrator section:

Field or Control
Name

Description

User Name
User ID

Reset Password

E-mail Address

Service User

User Type

Service User

Site

User Group - Select

User Type

User Roles - Select

Application Access

Worklist to display at
login

Enter the full name.
Enter a unique user identification (ID).

Reset the password of a user to a default value specified in the
common profile section.

Enter the user's e-mail address.

Indicates whether the user is allowed to run background services.

If the User Type was previously set to AG Service, this option is now
selected instead.

Select the type of user account as:

e Argus User (default)
*  Affiliate User

If the User Type was previously set to AG Service, the Service User
option is now selected instead.

Mark this check box to specify that user is a Service user that is used in
background processing.

Assigns the user to a site.
The values in this field are populated from the codelist item User Sites.

Attaches the user to pre-configured user groups.

Select the type of user, such as an Argus J user from the drop-down
list.

Attaches the user to pre-configured user roles such as Global Admin.
By default, a Global Admin role is granted to only an Administrator, who
can grant/revoke this role to other Oracle Argus Safety users. Such a
user role should be assigned to users who need access to the Oracle
Argus Safety Global application. Similarly, you can also select from
other roles present within User Roles.

Configure user access settings for Argus Console and Oracle Argus
Safety.

The default application access for the user can be selected from the list.

Configure users to see their worklists immediately upon login. The
options are:

*  None (default) - Does not open any worklist when the user logs into
Oracle Argus. Displays personal Oracle Argus status on login.

e Action Items - Opens Worklist - Action Items screen for the user on
login into Oracle Argus Safety.

*  New - Opens Worklist - New screen for the user on login into
Oracle Argus Safety.

e Open - Opens Worklist - Open screen for the user on login to
Oracle Argus Safety.

e Reports - Opens Worklist - Reports screen for the user on login
into Oracle Argus Safety.
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Field or Control
Name

Description

Enable site security

Enable LDAP Login

Account Disabled

Security Disabled
Account

Force password
change at login

Force password to
expire every

Days

Allow unblinding of
cases

Protect from
unblinded information

Protect from printing
unblinded information

Allow locking of
cases

Allow local locking

Allow Global Unlock
on Pending Local
Lock

If Enable Security is checked, the site-based data security will be
enabled for the user.

If the box is not checked, the user will have full access to data from all
sites.

Authenticates users against the active directory server.

When Enable LDAP Login is selected, all fields inside the Access
section are disabled, excluding the Account Disabled option.

When this option is selected, the user account is temporarily disabled to
prevent users from logging in. This option is different from deleting a
user as it enables the Administrator to re-activate the account at a later
date.

*  When unchecked, the login procedure keeps track of the number
of consecutive unsuccessful attempts at logging into the system. If
the count reaches a certain number, the log in procedure will fail
the password validation to lock the user out. This number is
configurable from Argus Console > System
Configuration > System Management (Common
Profile Switches) > Security > Number of
consecutive failed login attempts before
account 1s locked out.Administrators with rights to user
maintenance can reset the login attempts for the user to unlock the
account.

*  When checked, the login procedure that tracks the consecutive
unsuccessful attempts at logging into the system do not apply.

If this check box is selected, the users must change the password the
first time user logs on to the system after the check box is checked.

Enables the Administrator to force the user's password to expire in the
specified number of days.

Enables the Administrator to enter the number of days after which the
password should expire.
Enables the user to unblind a study case.

For example, a user without unblinding rights will not see the Study
Drug field. A user with unblinding rights sees a yellow Unblind tag next
to concentration of product field and the Broken by Sponsor option in
Blinding Status drop-down list is enabled. User will have to enter
password when user selects Broken by Sponsor' option.

When checked, the user cannot view any unblinded information.

When checked, the user cannot print any unblinded information.

Enables the user, to lock/unlock the cases.

Enables the user, to locally lock/unlock a case for which local Japan
data entry/assessment is complete, triggering the scheduling and/or
generation of the applicable local reports.

Allows users to be set up with the privilege to forcibly unlock a case that
is still pending a local lock.

This option is enabled only if the Allow locking of cases check box
(above) is checked.
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Field or Control
Name

Description

Allow closing of
cases

Route on close case

Enable Checklist on
Route

Allows the user to close the cases.

Opens a routing dialog when the user closes the case.

By default, this check box is selected.

If this check box is not selected, the checklist for the Workflow is not
displayed to the user while routing the cases, even if the rule that is
being used has a checklist.

Printing Users

Use the following procedure to print users.

g A w0 bd P

Select Access Management > Argus > Users.

Select a User and click to view the user details in the right panel.
Click Print to display the Print User dialog.

Select an option and click OK to display a list of Print User options.

Select the appropriate option(s) and click OK.

User Configuration - Roles

User Role

Description

Enterprise User

ESM Admin

Copy Configuration

Global Admin

AC Library Admin

Workflow Manager

This privilege allows administrators to configure a workflow manager
user as an Enterprise user. If Enterprise role is assigned, the user can
view cases of any site outside its site.

This privilege allows the user to access the Interchange Mapping utility
in the Argus Console.

This privilege lets you copy all the configuration data from the
enterprise where they have this role to any new enterprise that they
create through the Global Enterprise Management portlet. The factory
data Administrator user has this role enabled by default.

This privilege lets the administrator allow users to be designated as
Global Users for selected enterprises and not necessarily all
enterprises.

This privilege lets the administrator allow users to perform specific
operation on ACs such as re-assigning the ownership, grant access to
various user groups using Permission, Modification, and Deletion.

This privilege allows the users to perform specific workflow operations
such as routing cases to any workflow state, routing cases to user,
viewing all open cases and all action items present in the system,
changing the priority of a case and changing the assignee of an action
item or a case.

ORACLE
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Business Configuration

This section explains the Business Configuration of the Argus Console, categorized into the

following modules:

Sub-Section

Description

Products and Licenses:

Studies

Expedited Report Rules

This section helps in capturing Product Details such as product
specifics, product licenses and products involved in the studies.
These can be the products marketed, or under investigation, by the
company.

Refer to the following sections for further information on:

e Configuring Product Families

e Configuring Products

e Configuring Licenses

This section helps in capturing Study information such as study
specifics, products involved in the study licensed countries

associated with the study and the clinical references used in the
expedited reports.

This section helps in capturing Expedited Reporting Rule
configuration.

The Reporting Rules configuration feature enables the administrator
to define the reporting rules or criteria for the cases to be qualified
for expedited reporting.

For more information, see:

» Editable and Non-editable Business Configuration Sections

*  Configuring Product Family

*  Configuring Products

»  Configuring Licenses

e Configuring Clinical Studies

»  Configuring Expedited Report Rules

»  Configure Regulatory Reporting Rules

Editable and Non-editable Business Configuration Sections

Each of the three Business Configuration sub-sections supports various views for efficient
access to data. Each view consists of a hierarchical tree-structure comprising various nodes
such as Family, Product, Licenses, and Countries.

ORACLE

The following table list which nodes can be edited and which cannot.
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Editable and Non-editable Business Configuration Sections

Business Organized By Node Editable
Configuration Sub-
Section
Products and Family / Product / Licenses Family Yes
Licenses Product Yes
Licenses Yes
Product / Licenses Product Yes
Licenses Yes
License / Products License Yes
Products Yes
Countries / Licenses Countries No
Licenses No
Countries / License Type / Countries No
Licenses License Type No
Licenses No
Studies Projects / Studies / Products Projects No
Studies Yes
Products No
Studies / Products Studies No
Products No
Products / Studies Products No
Studies No
Countries / Projects / Studies Countries No
Projects No
Studies No
Expedited Report Country / License Type / Reporting Country No
Rules Rule License Type No
Reporting Rule Yes
License Type / Reporting License Type No
Destination / Reporting Rule Reporting Destination No
Reporting Rule Yes
Responsible Group / Reporting Responsible Group  No
Rule Reporting Rule Yes
Inactive Rules Country No
License Type No
Reporting Rule Yes
Active Rules Country No
License Type No
Reporting Rule Yes

For more information, see:
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*  Type Ahead Fields

e Additional Comments Fields

Type Ahead Fields

Some fields in the Business Configuration section of Argus Console are enabled with Type
Ahead-input. This means that these fields are equipped with the ability to guess what the
user is typing.

Based on the text being entered, this feature provides suggestions for the user to choose
from.

Key Ingredients. Add Delete

% Ingredient Name

[PYRIDOXINE |
[NIcoTINIC ACID |

Doxy|

DOXYCYCLINE
DOXYCYCLINE CALCIUM
Doxycyeline carragenate

oxycycline fosfatex

DOXYCYGLINE GUAIACOLSULFONATE
DOXYCYCLINE HYCLATE
DOXYCYCLINE HYDROCHLORIDE
DOXYCYCLINE MONOHYDRATE
DOXYCYCLINE PHOSPHATE
Doxycycline sodium polyphosphate
DOXYLAMINE

DOXYLAMINE SUCCINATE

The following fields have the type-ahead feature:

* Clinical Reference Type (Under Clinical Studies Configuration)
* Ingredients (Under Product Family Configuration)

* Manufacturers (Under Product and License Configuration)

*  Project ID (Under Clinical Studies Configuration)

* Reporting Destination (Under Expedited Reporting Rules)

Additional Comments Fields

Be aware of the following:

e The system has a Comments field that accommodates a maximum of 1000 characters on
the Product Family, Product, and License and Study configurations.

e The Product Configuration permits a maximum of 50 characters in the PSUR Group
Name field. Multiple blank spaces between words will cause the generation of unusable
report templates.

e The License Configuration permits a maximum of 50 characters in the CTPR Group

Name. Multiple blank spaces between words will cause the generation of unusable report
templates.

e The Business Configuration report prints the Comments field, and the system tracks any
changes made to these fields in the audit log.

Configuring Product Family

Each company has a set of products to sell and a set of processes unique to its business.
The Administrator should be aware of the company business processes and/or workflow
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rules. The manner of product configuration in Oracle Argus Safety will depend on how
the company handles its internal workflow related to the release of a product.

Details of the company's products can be added in Oracle Argus Safety using the
Business Configuration section. This feature helps end-users to retrieve details of
company products, without entering significant product information for each case.

Every company product should belong to a product family. Each product within a
product family shares the same key ingredient and data sheets but can have a
different concentration for the key ingredient.

Configuration of the product is done in the Business Configuration >Products
and Licenses section.

For more information, see:

* Field Descriptions
e Adding Product Families
* Creating Data Sheets

* Field Descriptions

Field Descriptions

The following table lists and describes the fields in this section.

Field Description

Product Family Name  Enables you to enter a new product family name.

Product Family Name  Enables you to enter a new product family name in Japanese.

V)
Product Group Enables you to select a product group name.
Search Equation Enables you to enter a search equation number for Literature
Number Import > Bookin.
Ingredient Name Enables you to select the multiple key ingredients for the product
family
e You can sort the field alphanumerically.
e Sorting on the ingredient name in the Product Family
Configuration updates the sort order in all the products which are
part of the same family.
A maximum of 25 items are displayed as the search results in the
drop-down list.
e The Key Ingrediens drop-down list enables you to enter up to 20
active ingredients for a product family.
Ingredient Name (J) Enables you to select the multiple key ingredients for the product

family

e Sorting is not supported.

A maximum of 25 items are displayed as the search results in the
drop-down list.

e This field is optional, non-editable, and auto-populated based on
the value in the English

e The Key Ingrediens drop-down list enables you to enter up to 20
active ingredients for a product family.
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Adding Product Families

ORACLE

The screen helps in capturing the Product Family information. As per the Oracle Argus data
model, the Product Family adds the Ingredients, Data Sheets, and the Product group.

Products are associated with Product families and are created using the Data Sheets,
Dosage form, Strength and unit of the corresponding Product Family. The Product Group field
in the Product Family configuration screen enables the Argus administrator to group the
product families into various Product Groups.

Use the following procedure to add a product family.

1. Inthe Business Configuration section, select Product and Licenses.

2. Inthe left panel, select a filtering criterion. The left panel now displays the tree view of the
Family based on the filtering criterion.

3. Select a Product Family and click to view the product family details in the right panel.

¢ Note:
Ensure that you select the top-level folder to view the details of the product

family.

Product family details appear in the right panel.

Tip:

e You can alternatively click Add Family to create a new family of products.
« Use Copy to make an editable copy of an existing product family.

« Use Copy with Datasheets to make an editable copy of an existing
product family, along with all associated datasheets.

4. Enterthe Product Family Name as applicable.

5. Select the Product Group from the drop-down list. This helps you to group the product
families into various product groups.

6. Select the required Ingredient Name(s) displayed under the Key Ingredients section.
7. Select the required Datasheet configuration.

8. Click Save to save the changes made to the Product Family.

Tip:
If you have added a new Product Family, click Add Family to save the new Product
Family.

About Filtering Criterion
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The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Business Configuration section.

Using Organized By

The filtering browser is displayed in the top-left corner of the left panel. The Products
and Licenses section can be filtered based on any of the three combinations shown in
the following illustration. Consider the following:

* If you enable Organized By Family/Product/License, then the generated output will
be visible in a tree-format in the left panel.

* If you enable the Organized By Product/License, only the Product and License
views are available in the tree view in the left panel.

Browser

Organized By Family / Product / Licenses

Contains 't Family / Product / Licenses

Product / Licenses

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized By, you can specify
whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to
search for all Family/Product/License data that contains the term Cure.

Browser
Organized by  Family / Product / Licenze v

Contsing % [Cure [Fitter ]

Q Tip:

The number displayed next to the folder indicates the number of Products in
the product family.

Creating Data Sheets

Packaged medications (like prescriptions) are marketed with an insert sheet that lists
the known contraindications (side-effects) that may occur as a consequence of taking
the product. These inserts are also referred to as data sheets. It is important to list
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these effects in order to ensure accuracy in reporting. An inaccurate report could result in the
wrong action taken or bring harm to a patient.

The Listed Events & Indications from the data sheet determine the listedness of the adverse
event(s) for the case. Depending on the configured regulatory report rules, the listedness
determination will automatically schedule the expedited reports.

The data sheet in the Product Family is configured using the Business Configuration >

Products Family section.

Field Descriptions

The following table lists the Field Descriptions for this section.

ORACLE

Field or Control Name

Description

Rename

Activate Datasheet

Core Sheet

Include

Other Date

Global /No local labeling assessment
required

Notes

Listed Term

View Revisions

Enables you to rename the datasheet.

Enables you to activate the current data sheet. Be aware of
the following:

*  When you click the checkbox, the system enables the
radio buttons next to Activate Datasheet.

e You can either select the option to activate the data
sheet with Terms added on the current dates or on
another date entered in the Other Date field.

e Once the datasheet is activated, the system disables the
Activate Datasheet text box.

e If you enter a date greater than the current system date,
the system permits you to enable the activation date.

The Core Sheet checkbox enables you to indicate that this
data sheet is the central data sheet. This checkbox is
disabled if another data sheet is marked as the core data
sheet.

The Include checkbox enables you to indicate that this data
sheet includes the particular datasheet selected in the drop-
down list. Be aware of the following:

*  The system populates the drop-down list with the list of
datasheets that do not include other data sheets.

e The system enables the drop-down list only when the
Include checkbox is checked.
If a product family has a single datasheet that is marked
'Core', the system disables the Include checkbox.

This radio button is enabled if the current date is not to be
selected. Select this checkbox and enter any other date, as
required.

Checking this option automatically marks any license using
this data sheet, as assessed, and the license does not
require any local labeling assessment.

On clicking the Notes icon, a pop-up appears to enable
users to enter notes while entering the details of the
Datasheet.

This field displays the listed terms (Preferred Term) for the
datasheet.

Enables users to view a list of term that were added or
removed with the added date.
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Field or Control Name Description

New Name of the Datasheet Name (J)  Enables you to rename the datasheet in Japanese.

The View Revisions dialog displays the datasheet revisions, as shown below:

View Revisions
Datasheet Name |[CORE
There are more than 1000 terms. Only the first 1000 are displayed, Use "Print" to view all the terms
Rev. lo. Terms |added on \Active On
1 Pyrexia | 22-Jan-2012 22.Jan-2012
1 Nasopharynatis ] 22-Jan-2012 22-Jan-2012
1 Rash | 22-Jan-2012 22-Jan-2012
2 ieaiache | 25-dan-2012 25-Jan-2012
2 * Rash | 25.Jan.2012 25-Jan-2012
Event Graup: Intestinal Disorders ' '
1 Ageusia 22-Jan-2012 22-Jan-2012
1 Dysgeusia 22-Jan-2012 22-Jan-20M2
1 Dyspepsia 22-Jan-2012 | 22-Jan2m12
2 |* Dysgeusia | 22-Jan-2012 | 22-an-2012
2 | Lossof Taste | 25.Jan-2012 | 25-dan-2012
| 2 | Epigastiic discomfort ‘ 25-Jan-2012 | 25-Jan-2012
Event Group: Skin Dizorders ‘ !
1 Vitiigo 22-Jan-2012 | 22.08n2m2
1 Leukoderma 22-Jan-2012 | 22-san2m2
loPrint| | ok
\J
«# Note:

In order to facilitate optimum system performance, you can configure a limit
on the number of revised terms that get displayed. If, for example, this value
is set to 1000, the datasheet will display only 1000 revised terms in the list.
This value is configurable in web.config by using the keyname
DataSheetRevisionTermCount. The default value is 1000.

Click Print to view all other revised terms.

Use the following procedure to create a datasheet.

1. Inthe Datasheet section of the Product Family section, click Activate Datasheet
to activate the data sheet associated with the Product Family.

Rename | Revisions | Copy | pelee ||
@® Current Date (] Core Sheet [ Include v
e —

referred Terms Event Groups. ‘

Activate Datasheet

() Global I No local labeling assessment required

# | Listed Term (Preferred Term)

WX R
1. | Pain Notes 2

ORACLE"
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< Note:

If you want to make a copy of the datasheet, click Copy. Ensure that you enter
a new name for the datasheet, if you are making a copy of another datasheet.

Select the Core Sheet check box, if this data sheet is required to be the core data sheet.
Only one core data sheet is allowed per product.

Select the Include check box and select the value from a drop-down list. This helps you
to indicate that this data sheet includes the particular datasheet selected in the drop-
down list.

Select Global/No local labeling assessment required to automatically mark any
license using this data sheet as assessed.

Click Add Term to select the listed terms (Preferred Term) for the datasheet. The
MedDRA browser appears.

Special Category: w

Terminology: | VedDRA - Brows VED | Search AN Levels ™ rull Search e
SOC WLGY HLY (4] LLY Moy

Gen
Metaboliem and rtritich Appetie snd gereral Garer aasiden # | Abdomanal ol ity A Apspmnal obeaty
deorders imAriBonal (EOrters Gere herapes Cachens

Ganersl nutrtonsl Defcabricy arbedian

Sacrdars REC F bt e 10 thrkee.

Gararsl sgna ang F ey dwarner

eyt e Feeding disorder of

Gererained tonc-cione Wnancy o ety

nam— chilahood

Gerspt: mivchondrl Feedng probiem n

sbncrmalbes NEL et

Gartal and WAy ract 'mm‘""

duonders NEC P ——

Gerdourrary necpasms G rad st tson

FRIGRANCY N QANOR premp—

wrapesied

- e

Cantzurrary tract

nigpctions and i | Kweshiorkor ot

H0C 10637413 ietatcm= ad nutTion dmordery

HLGT 10002018 ASDETlE 803 GERET R AUTTON R IS
LA 10018067 Gangral nutrbenyl Snorders NEC
PT 100851 7§ Andomnal peesly

LLT
N

Frot || Gsisa | Canom

The MedDRA Browser available for Datasheets enables the administrator to select either
multiple or all Preferred Terms (PTs) in the following way:

*  Click the required High Level Term (HLT) and select multiple PTs by clicking on each
required PT.
OR

* Right-click the HLT to select all entities available under PT.

Select the Preferred term from the MedDRA browser and click Select.

Q Tip:

You can alternatively click Select and Close, in the MedDRA browser to save
and exit the Product Family screen.

You can use Delete Term to delete the selected listed term(s) from the
datasheet.
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8. Click Select from the Event Groups tab of Datasheet to select an event group.

The Event Group Selection window appears.

9. Press Save to save the data sheet. The Data Sheet name displays in the Data

Sheets list.

Tip:
To view the revision history associated with a Datasheet, click
Revisions. A pop-up appears containing the following information:

¢ Rev. No: Displays the revision number of the datasheet. This
number is updated each time the data sheet is activated.

e Terms: Displays all the terms that were added / removed. In case a
term has been deleted, it is marked with * against the term name.

« Added On: Displays the date when the terms were added in the
datasheet.

« Active On: Displays the date when the datasheet was made active
for that revision.

Configuring Products

ORACLE

Each company has a set of products to sell and a set of processes that are unique to
its business.

The manner of product configuration in Oracle Argus Safety depends on how the
company handles its internal workflow, related to the release of a product. Therefore
the Administrator should be familiar with the business processes or workflow rules of
the company.

Configuration of the product is done in Business Configuration > Products
and Licenses.

When configuring a product, be aware of the following:

*  When the user clicks the Notes link on a data sheet, he/she can enter a maximum
of 2000 characters in the Preferred Terms section of a data sheet as shown in the
following illustration.

*  When the user clicks the Notes link, he/she can enter one note for each term.
» The user can use the standard spell check function.

» If notes have been entered for the term, the system displays the Notes icon to
indicate that notes are present.

*  The system also prints the notes on the Product Family details.

A comments field that can contain up to 1000 characters has been added to the
Product Family/Product/License and Study configuration elements.

»  The Product configuration also has a 50 character PSUR Name.
» The Business Configuration reports print the contents of the Comments fields.

* The system tracks any updates made to the datasheets in the audit log.
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The following illustration shows the fields associated with this section.

\Weicome veena, Wednesday, January 18 2012 (ASTON-ENTP)

ORACLE’
l CodelLists | Business Configuration | Access Management | System Configuration | Toois |
PRODUCTS AND LICENSES
Browser Len
Organized By | Famiy i Product / Licenses v] ¥ Product Family Hame % Product Group
[conteins ¥ | [Emine ] | bestt - I %)
Displaying Rows 1-30 (30) EA R U xov ingredients Ada 1 T 1
g o HLL CHBNG®I (1) 7] W ingredient Name <=
B[ Family - Functional testing (1) s RA‘CF»M-‘UL‘ |
-3 Famiy 1 (1)
5l Famiy 2(1)
[ Famiy GE (0)
-2 Famiy PSL (1)

- GB Test NV Famiy (1)

B[ Glucomater (1)

B[4 Headache (1)

@[l LsFamiyl (2)

-5 Mectropen (3)

-2 Oxygenator (1)

-3 Placeto (1)

-2 Rabifur (1)

-3 Rabipur (1)

B[ SAFFLOWER OL (1)

-3 Somobrin (1)

-0 Tegretol (2)

- [ Test Product Family (1)
-3 Test Product Famiy for test (1)
@[ Test Product Famiy lssue 234566 (0)
& testl (@)

-3 Vitrasent (1)

®-CAVKPF (1)

|€

e pracrmimemes

Activate Datasheet

[¥] core sheet
Other Date i‘&-J»_ﬁ_HQBIZ | [ Global / Ho local labeling assessment required

' Current Date Include

Hasopharyngiis (EROEERE )
Rash (3
| Heagache (i)

Agg New Proguct |

| Save || soa Famity || Copy. |[.Copywit Datesness || Detme || Erint

For more information, see:

» Field Descriptions
* Adding Products

Field Descriptions

The following table lists and describes the fields in this section.

Field Name

Description

Product Family Name

Product Group

Ingredient Name

Datasheet

Enables you to enter the unique family name for the product. The
Product Family Name must be of at least five (5) characters.

Select the product group for the product.

Displays the Ingredients of the Product Family to which the
Product belongs.

You can alphanumerically sort the field.

Sorting on the ingredient name in the Product Configuration
updates the sort order in the corresponding Product Family and
all the other products which are part of the same family.

To view the description of the fields of this section, see Creating
Data Sheets.

ORACLE"
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Field Name

Description

Preferred Terms

Event Groups

Product Name (J)

Generic Name (J)

J Drug Code -- Select
PSUR Group Name

Comments

Displays the Listed Term (Preferred Term) for the product, as
described in the field description table under Creating Data
Sheets.

The Event Group, selected from the Select button > Available
Event Groups dialog, is displayed as follows:
Event Group Name in English.

The event group name is displayed in the following format for
Japanese users:

Event Group Name in English (Event Group Name in Japanese).

The count of the total number of Event Group Names present for
the case is displayed on the header of the Event Groups tab.

For more details about Event Groups, see the section Event
Groups tab tab under Configuring Event Groups.

Contains a unique Japanesse name for the product.

Displays the generic name of the product. Click the Copy from
Ingredient button, to generate the generic name.

Provides the J Drug Code from the Drug Coding dialog box.
This value is used to filter period reports in Oracle Argus Safety.

Enables you to enter the reason for configuring the elements.

Adding Products

This screen helps in capturing Product Details (product specifics, product licenses,
products involved in the studies. These can be the products marketed, or under
investigation, by the company. Every company product should belong to a product
family. Each product within a product family shares the same key ingredient and data
sheets but can have a different concentration for the key ingredient. This data is
reflected in multiple expedited and periodic reports and case form-general information

section.

Use the following procedure to add a product.

1. Inthe Business Configuration section, select Product and Licenses.

2. Inthe left panel, select a filtering criterion.

3. Select a Product and click to view the product details in the right panel.

# Note:

Ensure that you select the second-level folder to view the details of the

product.

4. The details of the product appear in the right panel.

ORACLE
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Tip:

*  You can alternatively click Add Product to create a new product.
* Use Copy to make an editable copy of an existing product.

* Use Copy with Licenses to make an editable copy of an existing product,
along with all associated licenses.

Enter the Product Name and Product Abbreviation.

Enter the Dose information associated with the Ingredient Names in the Key Ingredients
section.

Select the Unit information from the drop-down list, associated with the Ingredient Names
in the Key Ingredients section.

Enter the Generic Name.

Tip:

To copy all the Key Ingredients entered in the previous section, click Copy
From Ingredients. This helps you to modify the list as required, instead of
entering all the names manually

Enter the Dosage Formulation.
Enter the strength of the dosage and select the Units from a drop-down list.

Click Encode to enter the Primary Indication. This enables you to display a primary
indication for the product using either the MedDRA or the ICD-9 Dictionary.

Enter the Model # number associated with the product.

Enter the Manufacturer's name.

Enter the Authorized Representative's name.

Click Select icon to select the WHO Drug Code associated with the product.
Enter the Company Code allotted for the product.

Enter the Lot # and Date associated with the Product.

Tip:

You can click Add to add new Lot# numbers. If you wish to add the current date
in the Date field, use the = sign on your keyboard as a short-cut.
Click Save to save the product details.

Tip:

If you have added a new Product, click Add Product to save the new Product.
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About Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Business Configuration section.

Using Organized by

The filtering browser displays in the top-left corner of the left panel. The Products and
Licenses section can be filtered on the basis of any of the three combinations
displayed below. Consider the following:

* If you enable Organized byFamily/Product/License, the generated output is visible
in a tree-format, in the left panel.

» If you enable Organized by Product/License, only the Product and License views
are in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets.

For example, the filtering criterion defined in the following illustration searches for all
Family/Product/License data that contains the term Cure.

The left panel now displays the tree view of the Product Family > Product
based on the filtering criterion.

Tip:

The number displayed next to the folder signifies the number of licenses
within that product.

Configuring Licenses

Once product configuration is complete, you must create product licenses. Licenses
are issued for pre-market and post-market release of a drug, device, or vaccine.
Investigational (pre-market) licenses are issued for studies done at study centers and
marketed licenses are issued for release of product. Configuration of licenses related
to a product is a key step in the configuration of Oracle Argus Safety.

Configure licenses in the Business Configuration > Products and
Licenses section.

The following illustration shows the fields associated with this section.
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For more information, see:

» Field Descriptions
* Adding Product Licenses

* Using the Product Browser

Field Descriptions

The following table lists the Field Descriptions for the License configuration section.

Field/Control Name Description

Trade Name Enables you to enter the Trade Name under which this product(s) is (are)
authorized by this license.

Trade Name J Enables you to enter the Japanese trade name under which. the product is
authorized by this license.

Award Date Enables you to enter the license award date for this license.

Withdrawn Date Enables you to enter the license withdrawal date for this license. The

withdrawn date cannot be less than the award date.

Market Authorization Enables you to select a manufacturer or co-marketing partner for this license

Holder of the product.

PMDA Re-examination The date of the next PMDA examination.

Date

Biologic / Vaccine Whether the license is for a Biologic/Vaccine (this can impact the MedWatch

report output).

If this is option is checked MedWatch will print PLA# not NDA# in section G5.
It is included to support the Biologic License Application (BLA) and the
Product License Application (PLA) requirements.
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Field/Control Name Description

Not in Tradename An option to indicate that this license name should not appear in the filter
lookup / Not Auto- criteria for Auto Scheduling of Reports or trade name lookup browser.
scheduled When this checkbox is checked, the trade name will not appear for this

license in the Trade Name Lookup dialog and this license will not be
evaluated or allowed for auto scheduling of the reports, but will be available
for manual scheduling of reports.

The license will be displayed in event assessment.

Labeled for Single Use Whether the drug is for single use (such as disposables).
If this option is selected it will mark YES in section H5 of the MedWatch
device form, otherwise it will mark NO.

OTC Product This enables you to specify if the Product has been bought as an Over-the-
Counter Product.
Pre-1938 For non-company products, enter the data.

For company products, this field is updated based on the data available in the
license configuration and is ready-only.

For study products, this field is fetched based on the primary license number
selected inthe Console > Studies Configuration.

When unblinded at case level, data is enabled irrespective of the product
selected in the Study Drug drop-down.

# Note:

The Pre-1938 field available under the Case
Form > Analysis > MedWatch tab will
not be used in eMDR.

Biosimilar For non-company products, enter the data.

For company products, this field is updated based on the data available in the
license configuration and is ready-only.

For study products, this field is fetched based on the primary license number
selected in the Console > Studies Configuration.

When unblinded at case level, data is enabled irrespective of the product
selected in the Study Drug drop-down.

Datasheet URL User can enter a hyperlink to a site giving information about the datasheet of
the product.

Authorization Country  This enables you to select the Country for which this license applies.
The chosen country does not impact the reporting rules algorithm. This field
maps to the Country field in the Reporting rules configuration.

License Type you can select one of the possible six types:
Investigational Drug/Device/Vaccine or Marketed Drug/Device/Vaccine

The chosen license type maps to the License type field under each country
on the Reporting rules configuration.
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Field/Control Name

Description

Datasheet Name

Application Type
License #

Company Item Number
Trade Name J

Clinical Compound
Number

Product Name (J)

Product Name

Hide

Countries List

TIKEN

Status Category of
New Drugs

Risk Category of OTC
Dugs

Medical Device
Terminology

Medical Device
Terminology-Other

Conformity/ Market
Availability

Date of Conformity/
Market Availability

PMA/510(K)#

Basic UDI-DI

Nomenclature Code

The datasheet drop-down enables you to associate a datasheet with the
License.

The field lists the datasheets for all the product families of the added
products.

The Data Sheet drop-down is enabled when one or more products have been
added to the Products list.

Enables you to license application type such as IND, NDA, STN etc.

Enables you to enter the License Number of the Trade name.

Enables you to enter the Company Item number corresponding to the license.
Enables you to enter the Japanese trade name.

The number that identifies the specific chemical compound.

*  You can edit this field when the Authorization Country is Japan and the
license type is either Investigational Drug or Investigational Vaccine.

e The Clinical Compound field is only available to users to Oracle Argus
Safety Japan.

The Product List box displays the list of products (product name, dosage form
and strength) that this associated license covers for regulatory reporting
purposes.

The Product List box displays the list of products (product name, dosage form
and strength) that this associated license covers for regulatory reporting
purposes.

When a product is marked as non display, it will not appear in the Trade
Name Product lookup dialogue associated with the license tradename.

Enables you to select all the countries in which the same license was issued.
The system adds the authorization country to the Countries Lise and updates
the list when you updates the authorization country.

Selecting the TIKEN checkbox indicates that the customer will not send the
investigational report for the other license.

The Status Category of New Drugs field captures the Status category of new
drugs. This information is transmitted in the J.2.4k element of PMDA E2B R3.

The Risk Category of OTC Dugs field captures the risk category of OTC
drugs. This information is transmitted to the J.2.5k element of PMDA E2B R3.

This drop-down field was introduced under the new section header Device
Information with the following options: EMDN, GIVD/EDMS, GMDN, Other,
UMDNS(ECRI).

This field becomes enabled only if the Device Terminology field has the Other
value selected.

This field contains the details of the Conformity of the device product or
Market availability of the device product: First declaration of conformity,
Device first CE marked, First placed on the market, First put into service,
Software, First Available.

This field provides the Date of Conformity or Market Availability of the Device
product.

This field is associated with medical device information and prints in
expedited reports.

This field contains Basic UDI-DI of the device product.

This field is associated with medical device information and prints in
expedited reports.
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Field/Control Name

Description

Nomenclature text

Medical Device
Information

CE Marked

CTPR Group Name
Comments

Device Company
Identification#

Device ldentification#

Risk Class Type

Notified Body ID
number (1)

Notified Body ID
number (2)

Certificate Number of
the Notified Body (1)

Certificate Number of
the Notified Body (2)

This field contains the Nomenclature text or the Device description of the
Device Product.

This field contains the details of Medical Device Information based on the
Risk Class of the Device.

CE marking is a mandatory conformity marking for certain products sold
within the European Economic Area (EEA). For a Marketed or Investigational
Device, this field can be set to Yes or No. For all other license types, this field
is disabled.

This value is used in Argus Safety when filter periodic report data.
Enables you to enter information about the element configuration.

Enables you to capture information about the Device Company Identification
number.

Enables you to capture information about the Device Identification number.

This field contains the Risk Class Type of the Device Product based on the
Medical Device Information.

This field captures the Notified Body ID number associated with the
conformity of the Device product.

This field captures the Notified Body ID number associated with the
conformity of the Device product.

This field captures the Certificate Number of the Notified Body associated
with the conformity of the Device product.

This field captures the Certificate Number of the Notified Body associated
with the conformity of the Device product.

Adding Product Licenses

This screen helps capture License information (License specifics, associated with the
License, Countries where the product is marketed or is under investigation). This data
is reflected in multiple expedited and periodic reports and in case form-product

information section.

Use the following procedure to add a product license.

In the Business Configuration section, select Product and Licenses.

In the left panel, select a filtering criterion.

Select a license and click to view the license in the right panel.

1

2

3. Expand the folders till you reach the license associated with a product.
4

5

The system opens the following screen:
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3 CELECOXIB (Unknown) (3)
{2 ROFECOXIB (Urknown [ | [ocami-o000 v
(23 Copy of PT_data
‘ 4 Codo toxt PMAIS10(K)# Basic UDLDI hd
Swve | Adaticorse ]| Coy ] 0eee e

Enter the Trade Name of the license.

T @

In the Manufacturer list, select the manufacturer of the product.

Select the Authorization Country in which the license was issued.

2 o

Select the License Type. This is the type of license.

e. Enter the license number in License#.

=h

If this license is to be reported under the PLA# and not the NDA# select the Biologicl
Vaccine checkbox. If this checkbox is selected, the PLA# (and not the NDA#) will be
printed in section G5 of the MedWatch form.

Specify if the drug is Labeled for Single Use or not.

5«

Specify if the drug has been bought as an Over-the-Counter (OTC) Product.

" Note:

If the OTC Product checkbox is checked in Business Configuration
> Products and Licenses for a product whose Authorization Country
is US and Withdrawn Date is blank, then the OTC Product checkbox in the
Case Form > Analysis > Medwatch tab will be checked automatically
on selecting the product license if the Initial Receipt Date is equal to or
greater than the Award Date of the license.

i. Specify if the drug is Biosimilar or not.

j- Specify if the drug is Pre-1938 or not.

k. Under Award Date, enter the date the license was granted to the manufacturer.
I.  Enter the Withdrawn date, if applicable.

m. Enter the Company item number in Company item number.
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Enter a URL reference for the license under Data Sheet URL (A URL
reference might be a link to product label or product information).

A world wide web address or an appropriate network path (For example: http://
anydomainname/anypath or \FILESERVER\LOCATION) can be entered in
this field.

Select Not in Tradename lookup/Not Auto-Scheduled if this license is not to
be involved in reporting.

In the Countries List, select the countries that define whether the case will be
classified as domestic or foreign for regulatory report scheduling algorithm.
The list of countries field in the product license screen used to display the 1ISO
A3 codes assigned to each country. But since the new countries do not have
ISO A3 codes, this field now displays the full country names with the
semicolon as delimiter.

Tip:
To modify this list, use the Modify option (placed next to the
Countries List).

Select the Data Sheet Name associated with the license, from the drop-down
list.

Click Add in the Product Name/Dosage Form/Strength to add a product to the
License

Tip:
You can alternatively click Add License to create a new license.

Use Copy to make an editable copy of an existing license.

The Product Browser dialog opens.

Enter the name (partial or full) of the product and select Full Search.

Select the appropriate product in the search results and click Select. Enter all the
required products in this manner.

Using the Product Browser

Click Add Products to add products.

ORACLE

1.
2.

3.

The Products Browser window opens:

Enter the Ingredient key word for the search. The ingredient is displayed in the
first column.

Select the Ingredient to obtain the Family it is associated with.
Select the Product Name to view the associated Trade Names.

Select the Trade Name required.

Select is now enabled at the bottom of the window.
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4. Click Select to add the product details under the Product Name section. The Product
Name is displayed in under the Product Name section.

T —

[ Full Search | Glaae Drug Code Country UNTED STATES Search
Ingredient Family Product Name Trade Narme
ALTEPLASE Actrease Activase (hjgchion) , 200mg Activase, 1545 (UNMED STATES 1543) A

Active Meomty Drog 0100 (UNITED STATES &
Arthe Moty Drug 0200 (UNTED STATES
dciive Moty Drug 0300 (UNITED STATES &
Amgacilin (UNITED STATES US Mariaed 1004
Bée« (UNITED STATES BA+7)

Cogy of Licanad for 200 Ingradients (UNTED
Doxorubicin HCL 0401 (UNITED STATES 040
Daxarubican HCL, 0401 (UNITED STATES 040
Descorabicn HCL, 11-4221 (UNTED STATES
Daxanubican HCL, 232131 {UNTED STATES 2
Desorabicin HCL, 56-1191 (UNTED STATES
Gilscometer, 2001 (UNITED STATES 2001)
Heart Wake, 4001 (UNTED STATES 4001)
Hyprmater. G000 (UNTED STATES 5001)
BUPROFEM (UNITED STATES 1100)

nsuln 2001 (UNITED STATES 2001}

£ *
Family Actase Model 2

Ingredient ELTEPLASE Drug Code unk

Product Name [activase (njection) , 200mg Indication

Trade liame \Acthase, 1549 (UNITED STATES 1545)

Sale Cancal |

5. The product browser available for datasheets, enables the administrator to select either
multiple or all Product Names as follows:

*  Click the Family name and select multiple Product Names by clicking on each
required Product Name.
OR

* Right-click the Family name to select all entities available under Product Name.

6. Click Save to save the changes.

Q Tip:

If you have added a new License, click Add License to save the new License.

Configuring Clinical Studies

It is important to configure clinical studies in the Argus Console because it helps the system
categorize the source of information for the cases that have been registered. This screen
helps in capturing Study information (study specifics, products involved in the study licensed
countries associated with the study and the clinical references used in the expedited reports.

Configuration of the product is done using the Business Configuration > Studies section.
When configuring clinical studies, be aware of the following:

e The IND Reference Number drop down displays only those reference numbers (license
numbers) associated with a product with a License Type of Investigational.

— Console > Business Configuration > Studies > Clinical Reference section (in middle
of screen).

ORACLE 321



ORACLE

Chapter 3
Configuring Clinical Studies

— The Reference Number drop down field should be limited to IND
(Investigational) US Licenses Number only.

The Study Name on the Study Configuration can be a maximum 70 Characters
(same as the Product name)

When configuring clinical studies, be aware of the following:

The Study screen has a J Data Entry button that is available only to J users.

When you click the J Data Entry button, the system presents a message telling
you to enter data in the required fields (Study ID, Project ID, and at least one (1)
Product) before opening the Japanese translation window.

The Study Type value displays in Japanese and can be one of the following:

— Single Blinded
— Double Blinded
— Not Blinded

The License Type value displays in Japanese and can be one of the following:

Investigational Drug

Investigational Device
— Investigational Vaccine
— Marketd Drug

— Marketed Device

— Marketed Vaccine

When you click Add J Drug, the system opens the J WHO Drug Lookup Window
to enable the user to add a J Drug. The system adds the drug to the product
section of the pop-up.

The WHO Encoded column has an Encode button. Click this button to open the
WHO Drug browser. This enables you to associated the corresponding WHO drug
with the J Drug if it is available. The associated WHO drug appears in the product
section of the English screen.

Before closing the J pop-up, the system reminds the user to associate
corresponding WHO drugs with the J drugs.

All error messages are in English.

After saving the data in the pop-up window, the system makes the same changes
on the English screen.

In browser view, the system displays the Englich product name by default. If the
English product name is not availabe, the system displays the Japanese product
name.

Clicking Save closes the window and saves the data, if all J drugs are WHO
encoded. If they are not WHO encoded, the system presents the following
message: Some J drugs are missing WHO drug association. Do you still want to
close the J Data Entry dialog?

Spell check is notavailable in the Study description dialog.

When you click Auto Encoding on the J-popup, the system opens the Auto
Encoding dialog.
The following fields appear in the dialog box:
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— Drugs

— Events & Indications

— Prevent manual encoding for event

— Require Events & Indications encoding before case closure

*  When you click the Centers - Modify button, the system opens the Modify Study Center
dialog box.
This dialog box contains the following fields:/controls

— Center
— Selected Center
— Add
— Add All
— Delete All
— Delete
- OK
— Cancel
*  When you copy data, the system does not copy the equivalent Japanese data.

*  When you copy data, the application puts Copy of at the beginning of the data in the
Name field.

* You can save a duplicate last name if the English ID is unique. If the ID is not unique, the
system presents the following message: A duplicate Study ID already
exists!

» If the Japanese name is not unique, the system presents the following message: 2
duplicate ID already exists!

* When navigating from the English screen to the J pop-up for an existing study:

— When you click the J Data Entry button, the system prompts you to save the data on
the English screen before opening the J screen: Do you want to save the
changes before opening the Japanese screen?

— If you choose to save the data, the system saves the data and the changes appear
on the J screen.

— If you choose not to save the data, then changes made on the English screen will not
appear on the J screen.

e When entering a new study:

— When you click the J Data Entry button, the system asks you to save the data on the
English screen before opening the J screen. The message is: Data must be
saved before opening the Japanese screen. Do you want to save?

— If you choose to save the data, the system saves the data and the equivalent data
appears on the Japanese screen.

— If you choose not to save the data, the system will not open the J screen.

The following illustration shows the fields associated with this section.
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¥ Study Id ¥ Project ID Other 1D Observe Study Type (E2B)
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For more information, see:

» Field Descriptions

e Adding Clinical Study Configurations
e Adding WHO Drug Details

e Adding Product Details

e Configuring Auto Encoding

e Configuring Study Reporting

Field Descriptions

The following table lists and describes the fields in this section.

Field or Control Description

Name

Study ID This is the Study ID.

Project ID This is the project ID for the study.

Other ID Enter any other ID associated with this study.

ORACLE"
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Field or Control Description
Name

Observe Study Type This enables you to select the study type from a drop-down list.
(E2B) e This element is populate from the Case From Clinical Study section
of the application.
e The value selected in Study Configuration, Observe Study Type
(E2B) is populated in the Case Form Study section when you
selects the Clinical Study.
e The system updates the standard E2B profiles (EMA, FDA, and
ICH) to populate the tag.

Template Only Select this checkbox to select only a template for the study.

Study Development  Enables you to choose the study phase.
Phase

* Non-Interventional  Enables you to identify a study as a non-interventional study. The
Study available options are Yes and No. The default value is set to No.

This field is not used in the application (Case Form, Reports) for this
release.

The following table lists and describes the arms available in this section.

Arms Field or Control Description

Name

Study Name Enter the name of the study. This is a mandatory field. You can add upto 99
Arms to a study.

Study Type Enter the type of study.

# Note:
The Study Name and the Study Type fields
must be unique for a study.

Primary License Select the applicable primary license from the list of licenses available in this
drop-down list. These licenses are displayed as per the products that have
been selected for the Arm.

This drop-down list is displayed as blank for a new Arm.

Copy Click this button to copy a selected Arm.

Delete Click this button to delete a selected Arm.

The following table lists and describes the product fields available in this section.

Products Field or Description
Control Name

Product Name (Dosage Provides information about the Product Name along with the (Product
Form /Strength/Units)  formulation/Product Concentration/Product Units).
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Products Field or Description

Control Name

Blinded Check this checkbox to configure a blinded study. You cannot check this
checkbox if the Study Type for that Arm is not blinded.

# Note:

A Study is eligible for Unblinding checkbox is
enabled when a study has at least one Arm with
Study type as Blinded (Single/Double).

The Study is eligible for Unblinding checkbox
should be unchecked in study configuration. If
this checkbox is checked, you will be able to see
the complete case data even if he has
protection enabled.

Product Type Allows you to select a Product Type from the drop-down list. The possible
values are:

Investigational Product - This value indicates that the study product is
an experimental drug being studied in the clinical trial.

Comparator - This value indicates that the study product is an approved
drug, and it is used in the clinical trials for comparing results with the
investigational product.

Placebo - This value indicates that the study product is a dummy drug.
This drug is used in the studies to eliminate bias that might occur due to
knowledge of who receives which treatment.

No Study Drug Given - This value lets you classify an event into the No
Study Drug Given category if a serious adverse event occurs even before
a patient has started taking any study drug.

Additional Study Drug - These are additional or background drugs that
are given as part of a combinational therapy. These drugs are generally
given with both investigational products, and comparators. The additional
study drug does not impact the case categorization, but it is an attribute
for this configuration in the product temp table.

In PBRER and DSUR reports, count of events are stratified against the
product type values: Investigational Product, Comparator, and Placebo.

Products -Add WHO Opens Search Screen for selecting a non-company product.

Drug

Products -Add Product Opens Search Screen for selecting a company product.

Products -Delete Deletes the selected product row.

The following table lists and describes the clinical reference fields available in this

section.

Clinical References Description

Field or Control

Name
Reference Type Shows the various reference types that can be setup for this study.
Country Enables you to select a country for the clinical reference type.
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Clinical References
Field or Control
Name

Description

Reference Number

Add
Delete
Countries

License

Product Abbreviation

Centers

Study Description

Investigator Alert

Investigator Alert -
select

Study is eligible for
Unblinding

Enable Study
Specific Encoding

Autoencoding:
Drugs(dict)

Autoencoding:
Events & Indications

Captures the reference number that will be reflected on the regulatory
reports.

Enables you to add another clinical reference.
Enables you to delete the selected clinical reference.
Enables you to select a country for the clinical reference type.

This is the license of the primary (company) product participating in the
study.

This enables you to enter an up to 5 character abbreviation of the study
name which would be used in Case numbering when Product' is
selected in the system numbering configuration in case of study cases.

The system displays the selected study centers for the study.

Enables you to enter a brief description of the study.

Opens the study description in zoom mode and provides a spell check
dialog.

Opens the multi lingual dialog allowing you to choose the language from
the list. The global language icon is displayed if the study description
data is entered in a language different than English or Japanese.

Enables you to select an existing Advanced Condition. Under
Investigator alert, an advanced condition can be created / selected.
When this condition is satisfied, the system automatically sends an e-
mail to the investigator group associated with this study.

Opens up the Advance Condition browser.

Check this box if the study can be unblinded. If the Study Type selected
is Not Blinded", this field is disabled. This checkbox is enabled when a
study has at least one Arm with Study type as Blinded (Single/Double).

User checks this box if Study specific Auto encoding has to be enabled.

If unchecked (default state) the study will use the dictionaries configured
using the Case form Configuration options.

If checked, the Auto encoding button is activated.

Select this field to enable the system to encode Events & Indications
using the dictionary you selects from the list.

The following table lists and describes the study reporting fields available in this section.

Study Reporting
Field or Control
Name

Description

Products -Add Product Opens the Search screen for selecting a company product.

Products -Delete

Inherent Reporting
Rules Form

Deletes the selected product row.

This drop-down list is populated from all the Study templates which are
configured for SUSAR Reports. Users can use the pre-defined SUSAR
reports by selecting the applicable template from the drop-down list.
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Study Reporting
Field or Control
Name

Description

Always report

Country

License Type

Reporting Destination

Time Frame

Possible Report Forms

Usually the study-specific reporting is configured to handle reporting
requirements for non-company products, e.g. Placebo or a comparator, as the
company-based reporting is taken care by the license based reporting logic
utilized in Argus.

However, checking this checkbox will force Argus to check for qualifying
expedited reporting rules based on the country, license type and reporting
destination specified even if no non-company products are identified as study
drugs.

If the checkbox is unchecked then expedited reports based on the study-
specific reporting rule will only be scheduled if there is a non-company
product identified as a study drug.

Specifies what country's reporting rules the console should consider. The list
includes countries for which the expedited reporting rules exist.

Specifies what license type to consider for the specified country. Only
applicable license types, i.e. Marketed Drug, Device, Vaccine or
Investigational Drug, Device, Vaccine are displayed in this drop down list.

For example if a country Germany" only has reporting rules for investigation
drugs, then Investigational Drug" is the valid drop-down element.

This field is optional and by default will have the value All.

Specifying any value in this list limits the reporting rules to be evaluated to the
selected country, license type and reporting destination. The drop-down list is
filled with valid destinations (regulatory authorities) for the country and license
type selected based on the expedited reporting rules.

For example, if you has selected Germany, Investigation Drug and there are
reporting rules for Germany with destinations of BfArM" and Drugs R us" then
only these two destinations (LM: regulatory authorities) are displayed.

This field cannot be searched or altered, but is included for informational
purposes.

Based on the country, license type and reporting destination selected, the
system determines and displays all possible time frames in ascending order
separated by a comma.

This field cannot be searched or altered, but is included for informational
purposes.

Based on the country, license type and reporting destination selected, the
system should determine and display all possible report forms in alphabetical
order separated by a comma.

Oracle Argus Safety Japan specific fields

Field or Control Name Description

Clinical Compound
Number

Target Disease
Indication

Study Development
Phase

Enables you to enter clinical compound information.

Enables you to enter disease information.

Displays a list of all valid study development phases configured in the
study development code lists.
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Field or Control Name Description

Are any subjects given  Select from the available options, or enter as desired.
this investigational

drug?
Comments Enables you to enter relevant comments regarding the study.
J Data Entry This button appears only to Argus J users. When you click J Data

Entry the application opens the Study Configuration dialog box with
Japanese localization.

Adding Clinical Study Configurations

This screen helps capture study information (study specifics, products involved in the study
licensed countries associated with the study and the clinical references used in the expedited
reports). Study Information is required if a case has been reported while conducting a study
and the participating product(s) belong to the company. This data is reflected in multiple
expedited and periodic reports and case form-general information section.

Be aware of the following:

* The IND Reference Number drop down displays only those reference numbers (license
numbers) associated with a product with a License Type of Investigational.

— Console > Business Configuration > Studies > Clinical
Reference section (in middle of screen).

— The Reference Number drop down field should be limited to IND (Investigational) US
Licenses Number only.

e The Study Name on the Study Configuration can be a maximum 70 Characters (same as
the Product name).

Use the following procedure to add a study:

1. Inthe Business Configuration section, select Studies.
2. Inthe left panel, select a filtering criterion.

3. Select a Study and click to view the study details in the right panel.

< Note:

Ensure that you select the study-level folder to view the details of the study.

4. The details of the study appear in the right panel.
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* You can alternatively click Add Study to create a new study.

e Click Copy to copy of the Study Name and the Study Type data to
the new Study.

e Click Copy with Products to copy the Study Name and the Study
Type data, as well as to copy the blinded and open products.

Enter the Study IDand Study Name associated with the Study.
Select the Project ID for the Study, from the drop-down list.
Select the Study Type associated with the Study, from the drop-down list.

Enter the Other ID. This will be an alternative id for the Study.

© © N o O

Select Template to associate a template with the Study.
10. Select the Observer Study Type(E2B) from the drop-down list.
About Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Business Configuration section.

Using Organized by

The filtering browser displays in the top-left corner of the left panel. The studies
section can be filtered based on of any of the three combinations shown in the
following illustration. The generated output is visible in a tree-format, in the left panel,
based on the entire categorization of Projects, Studies, Products.
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Browser

Organized By Family / Product / Licenses
Contains ' Family / Product / Licenses =

Displaying

Product / Licenses

Contains | Family / Product / Licenses

| Product / Licenses

=
.:I:i.:.] ADevic
-2 AMOX
3:] Antipyr
Lﬁ:] Aniﬁciﬁl Countries / License Type / Licenses

License / Products

Countries / Licenses

If you enable the Organized by Study/Products, only the Study and Product views will be
available in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business Configuration
section. Once you have selected the Organized by, you can specify whether your search
should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to search for all
Projects/Studies/Products data that contain the term Cure.

e )
Organized By | Projects [ Studies / Products v|
cure [ Fiter

Contains 117 (17)

1D IU3rgdio (u)

1610482419 (D)

The left panel displays the tree view of the Projects/Studies/Products based on the
filtering criterion.
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Tip:

The number displayed next to the folder signifies the number of studies/
products within that project/studies family.

Adding WHO Drug Details

Use the following procedure to add WHO Drug detail information.

1.

Select Add WHO Drug in the Products section to add the WHO Drug details
associated with the Study.

Click WHO Drug to add WHO drug details (using the WHO Drug browser window)
associated with the Study. The system opens the WHO Drug browser window.

Select the Trade Name or the Ingredient radio-button, to search for the WHO
Drug term associated with either the Trade Name or the main Ingredient of the
drug.

Click Search to execute the search. The data is displayed as follows.

Select the required component/row (this can be the key Trade Name or
Ingredient).

The row now appears highlighted and the Drug Details section displays the
associated information.

Click Select to add this drug information in the Product Name section of the
Studies Configuration window.

The WHO Drug browser window closes and the drug appears in the Product
Name section.

Adding Product Details

Use the following procedure to add details about the Product in the Product Browser.

1.

w

N o g &

ORACLE

Select Add Product in the Products section to add the products associated with
the Study.

Click on Add Product to add products. The Product Browser window appears.

Enter the Ingredient key word for the search. The ingredient is displayed in the
first column.

Select the Ingredient to obtain the Family it is associated with.
Select the Product Name to view the associated Trade Names.
Select the Trade Name required.

Select is now enabled at the bottom of the window. Click Select to add the
product details under the Product Name section. The Product Name is displayed
in under the Product Name section.

3-32



Chapter 3
Configuring Clinical Studies

Tip:

To delete a product, select the product and click Delete (placed next to Add
Product). A pop-up appears asking you to confirm the action.

8. Select the Reference Type associated with this Study, from the drop-down list.
9. Select the Country associated with this Study, from the drop-down list.

10. Enter the Reference Number associated with the Reference Type in this Study.

Tip:
* To add more Reference Types in the Clinical Reference section, simply
click Add. A new row is added to this section.

* To delete the Reference Type, select the Reference Type and click Delete
(placed next to Add). A pop-up appears asking you to confirm the action.

11. The Countries field is a display only field. You can Add or Delete this list based on your
requirements.

12. Select the Product License from the drop down list. This is the license of the primary
(company) product participating in the study.

13. Enter the Product Abbreviation.

14. The Centers are displayed as per the centers you choose to associate with the Study. To
modify this list, click Modify (placed next to Centers). Using this option you can add and
delete Centers associated with the Study.

Tip:
e To add more Centers to the Study Center list, use the Add>>/Add All
options.

e To delete the Centers from the Study Center list, use the Delete>>/Delete
All options.

15. Enter the study Description associated with the Study.

16. Click Select placed next to Investigator Alert to select or create an Advanced Condition
for this Study.

17. Select Study is eligible for Unblinding to enable the study to be unblinded.
18. Select Enable Study Specific Encoding to enable the study specific Auto Encoding.

Configuring Auto Encoding

The Auto Encoding features helps you to configure your own dictionary of encoded data.
Using this enables you to:
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»  Configure studies to use dictionaries different from the dictionaries configured
using the Case Form configuration.

» Retrieve coded Events, Drugs and Events & Indications and codes from the lists
associated with this section.

» Ensure that the expedited reports display the correct verbatim and coded terms.

Use the following procedure to configure Auto Encoding.

1. Click Auto Encoding to open the Auto Encoding dialog.
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2. Select the encoding options as required for Drugs and Events & Indications. Use
the items in the list to encode. For Study Encoding, go to Console > Business
Configuration > Studies > Study Encoding to support Central
Encoding for Events & Indications for study cases, in a similar way as for non-
study cases. Checking the Central Encoding checkbox (next to the Event &
Indications Checkbox) also ensures that Central Encoding also gets reflected (as
configured here) in the Oracle Argus Safety Case Form, for study cases.
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3. Select Prevent manual encoding for Events & Indications, if you want to disable
manual encoding by users.

4. Select the Require event term encoding before case closure, to ensure that the
expedited reports display the correct verbatim and coded terms.

# Note:

If this feature is not selected, then the study will use the dictionaries configured
using the Case Form Configuration options.

Cases where the report type does not include clinical trial cases, will always
encode with the dictionaries configured through the Case Form configuration
options.

5. Select Inherit Reporting Rules From using the drop-down list to configure study-based
reporting requirements.

Configuring Study Reporting

ORACLE

Study Reporting is provided in the Study Configuration section to configure study-based
reporting requirements.

The reporting rules are not directly defined in the study, but rather identify which reporting
rules to check from the already configured expedited reporting rules.

The identification is based on specifying what set of reporting rules to evaluate, as per the
criteria of:

e Country

e License Type

* Reporting Destination

Use the following procedure to configure study based reporting.

1. Click Add in the Inherit Reporting Rules From section. The Study Reporting dialog
opens.

2. Select Always Report as required.

Tip:

Select this checkbox to force the application to check for qualifying expedited
reporting rules. These rules are based on the country, license type and
reporting destination specified. Refer to the Field Descriptions for details.

3. Select the Country from the drop-down list.

Tip:

This field specifies which country's reporting rules should be included. The
drop-down list includes countries for which the expedited reporting rules exist.

4. Select the License Type from the drop-down list.
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Tip:

This field specifies the license type to be considered for the specified
country. Refer to the Field Descriptions for details.

Select the Reporting Destination from the drop-down list.

Tip:

This field is optional.

The Time Frame and Possible Report Forms cannot be searched or altered, but
is included for informational purposes.

* To add information pertaining to inheriting reporting rules in the Study
Reporting section, click Add.

* To delete information pertaining to inheriting reporting rules in the Study
Reporting section, select the reporting rule and click Delete. A pop-up appears
asking you to confirm the action.

Click Save to save the changes made to the Studies section.

Tip:

If you have added a new Study, click Add Study to save the new Study.

Configuring Expedited Report Rules

This section describes the configuration of Expedited Reports using pre-defined rules.

These reports are required by Regulatory Authorities. The Administrator is responsible
for entering information about Regulatory Authorities to which regulatory reports will be
submitted.

ORACLE

This information is entered in the Regulatory Agency Information screen. Information
about the local company contact for a regulatory authority can also be entered in this
screen.

Configuration of the expedited report rules is done using the Business
Configuration > Expedited Report Rules section.

When configuring expedited reporting rules, be aware of the following:

If the user does not have permission to access Advanced Conditions on the
Expedited Reporting Rules, the system does the following:

— Displays the advanced condition name instead of displaying a blank.
— Does not permit the user to modify or view advanced condition details.
— Disables the Advance Condition button.

The system enables the user configure the Blinding Study Products option for
those included in the case (default unchecked).

— The system track updates to this field in the audit log.
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— The Reporting Rules reports print the new options

For cases where expedited reports are due, the user can force-distribute expedited
reports even if processing is incomplete.

Due Dates for expedited reports differ from Country to Country regulations. For Group 1
countries, the Due Date is based on the Aware Date received globally for the case.

For Group 2 countries, the Due Date is based on the Aware Date when the affiliate or a
company representative of that country received information about the case. In that case,
the Due date for these reports could be 15 days after the report was actually generated
based on the aware date received globally.

When reports are scheduled and generated, the Due Date for Group 2 countries is
calculated. The Due Date for a Group 2 Country = Report Generation Date + Additional
days for Group 2 countries. The Due Date for a Group 2 country can be adjusted as per
the holidays and weekends, through the Adjust Due Date for Group 2 countries by
XXX days field.

If two or more duplicate reports have different due dates (regardless of license type), the
system schedules the report with the earliest due date.

The reporting rules have a Force Distribute XXX days before due checkbox. The
default is unchecked.

— If the user checks the Force Distribute option, the # of days before due field is
entered and automatically checks the Auto Distribute checkbox on the reporting rule
(grayed out).

— The user can enter the number of days from 0 - # of days defined within the time
frame.

— If the user enters a value greater than the defined time frame, the system displays
the following message: Please enter a value less than the Time Frame
defined for the Reporting Rule.

— If the user has not checked Force Distribute, the system disables the days before
due.

The system tracks updates made to the new Argus Console fields in the audit log.

The system prints an audit log and print out that shows the expedited report rules
information as shown in the following illustration.

A super rule is a rule that overrides other rules when it finds a match. Be aware of the
following:

— The system executes a super rule before executing any other reporting rules.

— If a super rule matches, it executes all the super rules but does not execute other
rules.

— If the super rule does not match, the application executes the other rules.

When user configures a Reporting Rule for MIR Report from Console > Business
Configuration > Expedited Reporting Rule, and the user selects MIR Report
in the Form drop-down, the system will show the Message Type drop-down with Blank as
a default value, and it will be disabled.
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As of 05 January 2

Expedited Rep&n Rules
2

Expedited Report Rule Information

Country UNITED STATES
License Type Marketed Drug
Report Name US1997000003 & 6
Reporting Destination CDER
Origin of Events to Include ' Domestic [] Foreign
Timeframe 3days
(ﬁ.tﬁust Due date for Group 2 Courtries by 3 4o )
Advanced Condition Adv Condn for investigator alert
Responsible Group US Distribution
Cover Letter
B Active Rie [J Auto Distribute Reports [ Protect Reporter & Patient Confidentiality
O Active Mosety [ Blind Study Products B Report on Study Drug not Administered
O Force Distribute days before due 0 HCPCase [0 No Follow-up or Downgrade
Reporting Category
License Category

[ Super Rule - Cease evaluation of normal rules upon match

For more information, see:

e Field Descriptions

e Expedited Reporting Rules Algorithm

e Adding Expedited Report Rules

Field Descriptions

The following table lists and describes the fields in this section.

Field or Control
Name

Description

Report Name

Report Destination

Active

Auto Distribute
Reports

Enables you to view or enter the name of the Report.

Enables you to select the name of the agency to which the report will be
scheduled.

Enables you to specify whether the configured rule is active or inactive.

»  Only active rules are considered for report scheduling.
e Inactive rules are not checked when the report scheduling
algorithm runs.

Enables you to distribute reports automatically. Except the E2B
Reports, all the Expedited Reports that are selected for auto-distribution
are tracked under the Worklist > Bulk Transmit screen. The
E2B Reports which are transmitted automatically, are tracked from
Worklist > Bulk Transmit E2B.

ORACLE"

3-38



ORACLE

Chapter 3
Configuring Expedited Report Rules

Field or Control
Name

Description

Protect Reporter and
Patient Confidentiality

HCP Case

Report on Drug Not
Administered

Active Moiety

No Follow-up or
Downgrade

Origin of Events to
Include - Domestic

Origin of Events to
Include - Foreign

Timeframe

Enables you to configure Protect Reporter and Patient Confidentiality

» If this option checked and a report is generated or draft is viewed,
the Patient and Reporter information will be hidden.

e This option will override the check-boxes on the case form (for
Protect Reporter and Protect Patient) if it is checked.

« If this option is unchecked, the Case Form check-boxes will take
effect.

»  The Reports listed below will check for the Reporting Rule
Confidentiality Flag:
—  EU Device Initial
— EU Device Final
—  French CERFA Report
— CIOMS Report
— MedWatch Report
—  Vaers Report

When checked, the system check for any reporter in the case where
HCP=Yes. This enables the report to be scheduled if other parameters
for the reporting rules are satisfied.

The default is unchecked.

If this checkbox is checked, system schedules report for the suspect
products (study or non-study products) that are marked as 'Drug not
administered' along with the other suspect products in the case.

If this checkbox is unchecked, system ignores suspect products (study
or non-study products) that are marked as 'Drug not administered' and
Reports are scheduled for other suspect products in the case for which
'Drug not administered' is not marked.

Enable this check-box to enable rule to act exclusively as an active
moiety rule for that country.

When this option is enabled the system will disable and ignore the
county when evaluating the domestic/foreign causality sections.
Listedness will be evaluated at the case level.

The system does not schedule a follow up or a downgrade report for
the case when the the initial report was scheduled based on the current
rule.

Enables you to select the inclusion of domestic or foreign cases based
on their country of incidence.

»  Domestic: The event is marked as Domestic, if the country of
incidence appears in the list of selected countries.

*  This list is displayed in the Countries tab, in the List Maintenance
Licenses (section) for the license(s) of the suspect product(s)
under examination.

Enables you to select the inclusion of domestic or foreign cases based

on their country of incidence.

»  Foreign: The event is marked as Foreign, if the country of
incidence does not appear in the list of selected countries.

e This list is displayed in the Countries Tab on List Maintenance
License (section) for the license(s) of the suspect product(s) under
examination.

This field specifies the report's scheduled due-date based on the

number of days, after the initial receipt or significant follow-up date.
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Field or Control
Name

Description

Adjust due date for
Group 2 countries by
xxx days

Form

Local Comment Type

Clinical Reference
Type
Language

Message Type

Listedness

Seriousness - Fatal/
Life Threatening

Seriousness -
Serious (Case)

Seriousness -
Serious (Event)

Seriousness -
Severity

This field allows you to specify the number of days by which the due
date for a report may need to be adjusted for a Group 2 country.

This is the drop-down list of expedited report forms.

This field is used to extract the local evaluator comment from case data
(French CERFA 65-0044, CIOMS-I (Local)). This field is only enabled
for CIOMS-I (Local) form.

This field is used to get information from the study configured for a
case. This field is enabled for CIOMS-I and other forms.

Enables you to select language type.
e English is the default language of choice.
*  The system does not support other languages at this time.

. Reports such as the German BfArM, German PEI, and French
CERFA can utilize some field values in their corresponding
language (For example: narrative).

Enables you to select the message type.

" Note:

This field is displayed when an E2B or
eVAERS report is selected as the Report
Form. If the Report Form is selected as
eVAERS, then the Message type is set to
ICHICSR and is disabled.

Enables you to check if the license being evaluated for reporting is
listed. The possible values are:

e Listed
e Unlisted
e Ignore (default)

Enables you to check if case level seriousness assessment is 'Death or
Life Threatening'. The possible values are:

e Yes
. No
e Ignore (default)

Enables you to check if case level seriousness assessment is 'Serious'.
The possible values are:

*  Yes
* No
e Ignore (default)

Enables you to check if the event level seriousness assessment (for any
event) is 'Serious'. The possible values are:

e Yes
. No
e Ignore (default)

Enables you to select a term descriptive of the severity of the event.
E.g. Mild, Moderate, severe, unknown.
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Field or Control
Name

Description

ORACLE

Product Specific -
Family Name

Product Specific -
Product Group

Causality - Most
Conservative

Causality - Include
Non-Clinical Trial
Cases

Causality - Causality
as Reported (Event)

Causality - Causality
as Determined
(Event)

Causality - Causality
as Reported (Case)

Causality - Causality
as Determined
(Case)

Enables you to configure product specific reporting rules.

Enables you to configure product specific reporting rules.
Product Group drop-down always lists the configured Product Groups.

If this check box is marked, the system will look at the event level

reported causalities, event level determined causalities and case level

causalities, and if any of these three causalities is Yes then the case will

be considered Reportable.

If checked, the following options are hidden and set to Ignore:

e Causality as Reported (Event)

e Causality as Determined (Event)

e Causality as Reported (Case)

e Causality as Determined (Case)

e Causality is ignored when scheduling reports for non - study cases.
This only Study cases.

Enables you to include the Spontaneous Cases (Non Clinical Trial
Cases) for causality assessments.

Assesses As Reported causality in conjunction with the Listed value (if
any) specified in the rule for the license/event combination being
assessed. Ignored for non-study cases. Only applies to Study cases.
The possible values are

*  Reportable

*  Non-reportable

e Ignore (default)

Assesses As Determined causality in conjunction with the Listed value
(if any) specified in the rule for the license/event combination being
assessed. Ignored for spontaneous, literature and regulatory authority
cases.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

*  Reportable

*  Non-reportable

e Ignore (default)

Most conservative of the As Reported causalities in event assessment
for ANY event.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

*  Reportable

*  Non-reportable

e Ignore (default)

Case Level Causality, as observed on the Analysis tab for the Case
Level Causality.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

*  Reportable

e Non-reportable

e Ignore (default)
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Field or Control Description
Name

Advanced Conditions This field enables the selection of an advanced condition to further
restrict cases that meet the criteria for the rule.

Advanced Conditions Enables you to open the Advanced Condition Browser.

- Select You can click this button to open the Advanced Conditions browser to
select / create an Advanced Condition.

Responsible Group ~ Enables you to select a group to whom reports scheduled by this rule
will be assigned.

Super Rule - Cease  Enables you to provide a super rule.
evaluation of normal
rules upon match

Reporting Category  Enables you to configure the relevant reporting category.

Device Reporting Enables you to configure the relevant device reporting category.
Category

License Category Enables you to configure the relevant license category.

Cover Letter Enables you to use letters that have been configured for reporting

template use.

Comments Enables you to enter reporting rule comments, up to 2000 characters.

Expedited Reporting Rules Algorithm

ORACLE

The expedited reporting rules algorithm affects the following:
e Suppression of Duplicate Reports

* Blinded/Forced Distribution

* Letter Placeholder for the IND Cover Letter
Suppression of Duplicate Reports

You can suppress duplicate expedited reports to be scheduled at the reporting
destination level by using the Suppress Duplicate Reports option.

This option:

» Determines the system to use the following attributes to determine whether the
reports are duplicates of other reports:

* — Report Form
— Reporting Destination
— Aware Date
e Only applies to drug reports. It does not apply to device reports.

- Does not reduce the number of reporting rules the system evaluates. However, it
does prevent the system from scheduling and generating expedited reports that
match the duplication criteria.

Blinded/Forced Distribution

You can configure the Blinded Study option for products in a study to blind the
products for the report being sent to the reporting destination. The functionality is
similar to the corresponding option from the Bulk Reporting dialog box.
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If you select either of the Blinded Study product options (Reporting Rules or Bulk
Reporting), the system blinds the study product information on the report form.

The system blinds only active blinded studies. It does not blind the following case reports
even if the Blind Study product is selected.

— Open Label Studies.

— Study is eligible for unblinding - If the Study is Unblinding checkbox is not kept as
unchecked in study configuration, the user will be able to see the complete case data
even if he/she has protection enabled.

In cases where expedited reports are due, the system permits the user to force-distribute
the reports based on user-defined reporting rules, even if case processing is incomplete.

When you select the Force Distribution rule, the following occurs:

— If a case encounters a rule where a report is due is locked, the system schedules the
report based on the rule and does the following:

*  Generates the report on the due date.

*  Dynamically replaces the current case comment with the force distribution case
comment.

*  Transmits the report based on the preferences defined by the reporting
destinations.

*  Displays the status in the Worklist Bulk Transmit/Transmit ICSR dialog boxs.

— The AG Service Force Reporting process for expedited reports completes the
process by:

*  Checking the reports required for force distribution.
*  Locks the case (if it's not already locked).
*  Generates the reports and makes sure it is ready for transmission.

— The notes for the Case Locking/Unlocking are the same as those defined as the
common profile value for the Forces Distribution option; SYSTEM is the user.

Adding Expedited Report Rules

The Reporting Rules configuration feature enables you to define the reporting rules or criteria
for the cases to be qualified for expedited reporting.

ORACLE

Use the following procedure to add expedited report rules.

1.
2.

In the Business Configuration section, select Expedited Report Rules.

In the left panel, select a filtering criterion. The left panel now displays the tree view of the
Country/License Type/Reporting Rule based on the filtering criterion.

Select a Reporting Rule and click to view the reporting details in the right panel.

# Note:

Ensure that you select the reporting rule-level icon/folder to view the details of
the reporting rule.
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Tip:

*  You can alternatively click Add Rule to create a new reporting rule.

* Use Copy Rule to make an editable copy of an existing reporting
rule, along with all associated expedited reporting rule information.

Enter the Report Name.

Select the Report Destination from the drop-down list. This is the name of the
agency to which the report will be scheduled.

Select Auto Distribute Reports to distribute reports automatically.

Select Active to specify if the configured rule is active or inactive.

" Note:

Only active rules are considered for report scheduling

Select Origin of events to include-Domestic to include domestic cases based
on the country of incidence OR Select Origin of events to include-Foreign to
include foreign cases based on the country of incidence

Select Report on Drug not Administered. This option ensures that all drugs that
are not administered are reported.

Select Active Moiety if you want to enable this option.
Select the required Form from the drop-down list of expedited report forms.

Select the Local Comment Type from the drop-down list. This field is used to
extract local evaluator comments from case data.

Select the Clinical Reference Type from the drop-down list. This field is used to
obtain information from study configured for a case.

Tip:
This field is enabled only for CIOMS-I and other forms.

Select the Language and Message Type from the drop-down list.

Select the Listedness from the drop-down list. This ensures that the license being
evaluated for reporting is listed.

Select the Seriousnhess- FatallLife Threatening option from the drop-down list.
This field ensures that cases that contain Death or Life Threatening seriousness
criteria for an event are evaluated.

Select the Serioushess- Serious (Event) option from the drop-down list. Enable
this field to check if the event level seriousness assessment is Serious.

Select the Serioushess- Serious (Case) option from the drop-down list. Enable
this field to check if the case level seriousness assessment is Serious.

Select the Serioushess- Serious (Severity) option from the drop-down list.
This enables you to define the Severity as Mild, Moderate, Severe and Unknown.
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Select the Product Specific - Group Name from the drop-down list. This field enables
you to configure product specific reporting rules.

Select the Product Specific - Family Name from the drop-down list. This field enables
you to configure product specific reporting rules.

Select Causality-Most Conservative. This ensures that the system looks at event level
reported causality, event level determined causality and case level causality.

Select Causality-Include Non-Clinical Trial Cases. This enables you to include the
Spontaneous Cases (Non Clinical Trial Cases) for causality assessments.

Select Causality - Causality as Reported (Event) as required, from the drop-down list.

Select Causality - Causality as Determined (Event) as required, from the drop-down
list.

Select Causality - Causality as Reported (Case) as required, from the drop-down list.
Select Causality - Causality as Reported (Case) as required, from the drop-down list.

Select or create the Advanced Condition to restrict cases to the advanced conditions
defined here.

If any of these three causalities are confirmed, then the case will be considered as
reportable.

¢ Note:

Use the Advanced Conditions browser to select or create an Advanced
Condition by clicking Select.

Select the Responsible Group from the drop-down list. This is the group to which the
reports scheduled by this reporting rule will be assigned.

Select the Cover Letter from the drop-down list. Use this field to select cover letters that
have been configured for reporting template use.

Enter any regulatory report comments under the Comments text box.

Click Save to save the changes made to this section.

Tip:

If you have added a new Reporting Rule, click Add Rule to save the new
Expedited Reporting Rule.

About the Filtering Criterion

The filtering criterion is essential as it helps you to search for specific items. The Argus
Console provides this option for the Business Configuration section.

Using Organized by

The filtering browser is displayed in the top-left corner of the left panel. The Expedited Report
Rules section can be filtered on the basis of any of the five combinations shown in the
following illustration.

ORACLE
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Browser

Organized By Country / License Type / Reportin w L ¥ Report

| Contains ~ | Country / License Type / Reporting Rule

Displaying Rows

=T
-l AFGHA
'ﬁ'j ARUB/ Active Rules

#-_J EURO
.jj:] FRAN QLUEL Yt

Consider the following examples:

License Type / Reporting Destination / Reporting Rule

Responsible Group / Reporting Rule

« If you enable Organized by Country/License Type/Reporting Rule, then the output
generated will be visible in a tree-format, in the left panel, based on the entire
categorization of Country, License Type and Reporting Rule.

« If you enable the Organized by Responsible Group/Reporting Rule, then only the
Responsible Group and Reporting Rule views will be available in the tree view in
the left panel.

Q Tip:
* Enable the Organized By filter for Active Rules, to obtain the list of
active reporting rules.

* Enable the Organized By filter for Inactive Rules, to obtain the list of
inactive reporting rules

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets or words.

For example, the filtering criterion defined in the following illustration for all Country/
License Type/Reporting Rule data that contain the term Canada.

Bowwr

Organized By | Country / License Type / Reportin V|

Contains w | || Filter

1-8 (8)

Starts with

ANISTAN (3)
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Sorting of Expedited Report Rules

The Reporting Rules are sorted in an alphanumeric order. The logic of ordering of Reporting
rules based on Organized by is as follows:

1. Country/License Type/Reporting Rule

For each country, there will be a folder for license type. Within each folder, the active and
inactive reporting rules will be presented together in alphanumeric order.

2. License Type/Reporting Rule

For each license type, there will be a folder for each reporting destination. For each
destination, the active and inactive reporting rules will be presented together in
alphanumeric order.

3. Responsible Group / Reporting Rule

There will be a folder for each reporting group. Within each folder, the active and inactive
reporting rules will be presented together in alphanumeric order.

4. Active Rules

Only active rules will be presented. For each country, there will be a folder for license
type. Within each folder, active rules will be presented in alphanumeric order.

5. Inactive Rules
Only inactive rules will be presented.

For each country, there will be a folder for license type. Within each folder, inactive rules
will be presented in alphanumeric order.

Configure Regulatory Reporting Rules

The regulatory reporting rules are mainly configured to look at Seriousness, Listedness,
Causality, and Outcome. Out of these, Listedness and Causality can be captured and
controlled (using the event assessment section) down to an individual license basis.

This granularity allows individual license holders to override the normal listedness and
causality assessment to control the need for submissions to their local regulatory authority.
Each affiliate could either suppress the need for a report by demoting the criteria, or add the
requirement for a report by promoting the listedness or causality.

This serves to promote the global reporting automation while maintaining the level of
individual local affiliate control that is often needed.

To obtain an assessment of the adverse event, the product must be in the company's suspect
product and the event must be encoded.
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Work with the Dictionaries

For each dictionary, you need to create a schema with the Dictionary Management Tool
and then load the dictionary.

Schema Name Action

MedDRA Schema To enable MedDRA, create this schema by using the MedDRA
Loader option when MedDRA is loaded to the new database
tables.

WHO Schema To enable WHO, create this schema by using the WHO Drug
Loader option when WHO is loaded to the new database
tables.

J Drug Schema To enable J Drug, create this schema by using the J Drug
Loader option when J Drug is loaded to the new database
tables.

For more details, refer to the Oracle Argus Safety and Oracle Argus Insight Installation Guide
> Create Argus Safety Database Schema.

For more information, see:
* MedDRA Dictionary

*  WHO Drug Dictionary
e J Drug Dictionary

MedDRA Dictionary

In this section:

e Prerequisites

e Load MedDRA or MedDRA J Dictionary

e Overwrite an Existing MedDRA or MedDRA J Dictionary
* Recode MedDRA

Prerequisites

ORACLE

e The system where these dictionaries will be installed has a minimum of 50 MB space.

e In order to perform MedDRA recode, an enterprise must have at least one case. An
enterprise is eligible for selection only if it has associated cases.

e The system has Oracle client installed, including the following:

SQLPLUS (Exe=sqglplus)
SQL*Loader (Exe=sqglldr)
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There is an updated TNSNAMES file and Oracle client to connect to the Oracle
Argus Safety database.

The Dictionary Management Tool is installed.
An Oracle database instance is available.

A SYSTEM or DBA user account is created.

# Note:

The smg_list.asc and smg content.asc files containing SMQ data
must be placed in the same folder as the other dictionary files.

Load MedDRA or MedDRA J Dictionary

Use these instructions to load a new MedDRA or MedDRA-J dictionary while not
overwriting any MedDRA dictionary versions you may already have loaded.

1.

5.

Open the Dictionary Management Tool and click MedDRA Loader. The Oracle
Database Connect dialog box appears.

Enter the SYSTEM or DBA username and password, the database name, and
click OK. The MedDRA Dictionary Loader dialog box appears.

Do the following:
* Toload MedDRA dictionary for the first time, select Load to New Tables.
* Toload a MedDRA J dictionary, check MedDRA J checkbox.

* To create a new MedDRA user, click Create User, enter the parameters, and
click OK.

» To create a new role, click Create Role, enter the parameters, and click OK.
The New MedDRA Role dialog box appears.

In the Dictionary to Load section, do the following:

a. From the drop-down, select the MedDRA Version.

b. Click Browse and select the dictionary files.

c. Select the MedDRA Browser checkbox.

d. From the Tablespace and Index drop-downs, select a table and an index.
e. Click Load.

The system loads the dictionary and a confirmation message appears.

Click OK.

Overwrite an Existing MedDRA or MedDRA J Dictionary

ORACLE

1.

Open the Dictionary Management Tool and click MedDRA Loader. The Oracle
Database Connect dialog box appears.

Enter the SYSTEM user password, the Database name and click OK. The
MedDRA Dictionary Loader dialog box appears.

Do the following:
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Select Overwrite.

To load a MedDRA J dictionary, check the MedDRA J checkbox.

From the User drop-down, select a user.

Enter the user password in the Password field; re-enter it in the Verify Password field.
From the Role drop-down, select a role.

From the Current Version to Overwrite drop-down, select the version to overwrite.
From the MedDRA Version drop-down, select the MedDRA version to load.

Click Browse and select the dictionary files.

Check the MedDRA Browser checkbox.

From the Tablespace and Index drop-downs, select a table and an index.

Click Load. The Oracle Database Connect dialog box appears.

4. Enter the SYSTEM user password, the database name and, click OK. When overwriting
the dictionary is complete, the Dictionary Load dialog box appears.

5. Click OK.

Recode MedDRA

The MedDRA Recoding tool displays the following options for each case with the existing
data elements after the case number in the XLS export or tab delimited file:

e Current Workflow State

*  Current Workflow Group

These options are available for the end user logs.

The SOC/HLGT/HLT/PT/LLT and Synonym columns in the MedDRA schema and the
MedDRA table have been expanded to 250 characters to conform to the ICH guidelines.

Oracle Argus Safety Database Location in the application

Table

CASE_PAT_HIST Oracle Argus Safety > Case Form > Patient Tab > Parent
Section > Other Relevant History

CASE_EVENT Oracle Argus Safety > Case Form > Events Tab > Event
Information

CASE_PROD_INDICATIONS Oracle Argus Safety > Case Form > Products > Products
Indication

CASE_ASSESS Oracle Argus Safety > Case Form > Events Tab > Event
Assessment > Event PT (Description)/LLT

CASE_DEATH_DETAILS Oracle Argus Safety > Case Form > Events Tab > Seriousness
Criteria > Death Details > Cause of Death & Autopsy Details

CASE_LAB_DATA Oracle Argus Safety > Case Form > Patient Tab > Lab Data

LM_ALWAYS_SERIOUS_TERM Argus Console > Code Lists > Always Serious Term List

LM_LABELED_TERM Argus Console > Business Configuration > Products and

Licenses > Datasheet

LM_PRODUCT Argus Console > Business Configuration > Products and

Licenses > Primary Indication

4-3



Chapter 4

MedDRA Dictionary
Oracle Argus Safety Database Location in the application
Table
LM_LAB_TEST_TYPES Argus Console > Code Lists > Lab Test Type

For more information, see:

Logic to Recode MedDRA
Run the Dictionary Management Tool to Recode Events

Recode MedDRA terms at the Enterprise level

Logic to Recode MedDRA

ORACLE

1.

Get the Lower Level Term (LLT).

For a case or LM data, if LLT (J) is different from the LLT (E), and either of them is
moved to a different PT group in new MedDRA version, then the MedDRA Recode
tool resolves the conflict by replacing LLT(J) with LLT(E) and recode as per the
new MedDRA dictionary.

Check LLT_Code column in the MEDDRA_PREF_TERM_LLT table to see if LLT is
not current (LLT_CURRENCY = N).

Decisions:

e If LLT cannot be found in MEDDRA_PREF_TERM_LLT then record as
exception to be noted in LOG file.

» |If for arecord LLT(J) term is non-current as per the new upgrading MedDRA
Dictionary but LLT(E) is current, then MedDRA recode only refreshes the
hierarchy of both LLT(E) and LLT(J).

Note that for the records for which hierarchy is refreshed, the LLT Term's text
and currency is also be refreshed based on the respective LLT codes.

If for a record, LLT(E) becomes non-current, then the MedDRA recode tool
when recoded with the MedDRA J dictionary, replaces LLT(E) and LLT(J) with
the PT code and recode if the Process Non-Current Terms checkbox is
checked.

e If LLT is current then keep LLT as itis.

e Ifacurrent LLT can be found in previous step then continue with next step
else go to 1 and select the next set of Terms.

Based on the LLT, get the Preferred Term (PT_CODE) from
MEDDRA_PREF_TERM_LLT. Get the rest of the hierarchy from
MEDDRA_MD_HIERARCHY, based on PT_CODE and PRIMARY_SOC_FG ="Y".

Match all 5 levels of Code and Description and update the data, if required.
Populate the following columns:

e DICT_ID = Current MedDRA Dictionary ID, present under Case Form
Configuration.

 CODE_STATUS =1 (displaying that this set of terms has been encoded).

When you create an Event Group by selecting a term at PT level, and that event
group is attached to a datasheet, the hierarchy stored in the datasheet is based on
the Primary SOC flag, which is always current.
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In the LM_LABELED_TERMS table:

» If only the English hierarchy is populated, then the application fetches data for the
Japanese hierarchy based on the English hierarchy populated, and performs
recoding based on the new MedDRA dictionary.

» If only the Japanese hierarchy is populated, then the application uses the PT code to
populate the English hierarchy, and performs recoding based on the new MedDRA
dictionary.

» If neither the English hierarchy, nor the Japanese hierarchy are populated in the table
but the PT code or term is populated, then the application uses the PT code or term
to populate both the English hierarchy and the Japanese hierarchy, and performs
recoding based on the new MedDRA dictionary.

For case or LM data, if LLT(J) is different from LLT(E), and either of them is moved to a
different PT group in the new MedDRA version, then the MedDRA Recode tool resolves
the conflict by replacing LLT(J) with LLT(E), and recoding based on the new MedDRA
dictionary.

For case or LM data, if MedDRA terms are coded with the English dictionary, then during
MedDRA Recode, the Japanese hierarchy is populated based on the English hierarchy
for both the case and LM data variables.

7. The following log files are created with detailed old and new values:

Log filename Scenario Message

(Case Form) - When LLT(E) is LLT(E) is non-current in target
MedDRA_Recode_Success_YYYY_ Non-Current MedDRA dictionary: LLT(E) and
MM_DD_HH_MIN LLT(J) replaced with PT

(LM Data) -

MedDRA_Recode_Success_LM_YY
YY_MM_DD_HH_MIN

(Case Form) - When LLT(E) and LLT(E) and LLT(J) not under same
MedDRA_Recode_Success_YYYY_ LLT(J) not under hierarchy in target MedDRA
MM_DD_HH_MIN same hierarchy dictionary: LLT(J) replaced with
(LM Data) - LLT(E)

MedDRA_Recode_Success_ LM_YY
YY_MM_DD_HH_MIN

(Case Form) - When LLT(E) is LLT(E) and LLT(J) not under same
MedDRA_Recode_Success_YYYY_ Non-Current and hierarchy in target MedDRA
MM_DD_HH_MIN LLT(E) and LLT(J)  dictionary: LLT(J) replaced with
(LM Data) not under same LLT(E). LLT(E) is non-current in
MedDRA Recode Success LM Yy hierarchyintarget target MedDRA dictionary: LLT(E)
YY MM DD HH MIN - MedDRA Dictionary and LLT(J) replaced with PT

8. If you execute the MedDRA Recode with English MedDRA the preferences for executing
will be limited as explained in the function flow for re-coding with J MedDRA.
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Run the Dictionary Management Tool to Recode Events

1.
2.
3.
4,

ORACLE

Open the Dictionary Management Tool, click MedDRA Loader.

Enter the SYSTEM or DBA user password, the database name, and click OK.
In the MedDRA Dictionary Loader dialog box, click Re-Code.

In the Event Re-Coding dialog box, do the following:

a. Inthe Enterprises field, select an enterprise to recode. In order to perform
MEDRA recode, an enterprise must have at least one case. An enterprise is
eligible for selection only if it has associated cases.

" Note:

If Oracle Argus Safety is setup in Single Tenant Mode, you will only
have one option here. If you are setup as a Multi-Tenant Database,
you can choose which Enterprises to recode. Multiple enterprises
can be selected.

b. Inthe Oracle Argus Safety MedDRA Version to Re-code field, select the
existing version of MedDRA that needs to be re-coded.

* Select a specific version to only recode data coded with that version.
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» Select All to recode all existing coded data regardless of the version it is coded
with.

c. Inthe Data Update/View Options [Currency determined at LLT Level Only] field:

e Check one or all of the Process Current Terms, Process Non-Current Terms
and/or Update dictionary version checkboxes.

» Select one of the following options:
— Update Data to reflect the updates in cases and audit log.

— View Only to view what events will be coded without making any updates to
cases and audit log.

d. In the Output Log File Options, select an output log file option and directory path for
the log files.

e Delimited Text
*  Excel Sheet output
e. Click the Execute button to start the recoding process.

f.  When the system displays the Connect to Database dialog box, enter the Schema
Owner name, password, and database. Click OK.

» Enter the schema owner name in the Argus Schema Owner field.
» Enter the password in the Password field.
* Enter the database name in the Database field.

g. The system recodes the following fields from Case Form and Code List.

Recode MedDRA terms at the Enterprise level

For multi-tenant environment, the Dictionary Management Tool allows recoding of MedDRA
terms at the Enterprise level.

The MedDRA Recoding tool displays an additional multi-select list of all active Enterprises.
This lists all active Enterprise Short Names in the alphabetical order.

New Schema Owner is no longer required. As per the recoding logic, cases are also re-coded
to the MedDRA version that is configured in Console.

Displays a note below the Existing MedDRA Version to Re-Code list.

The MedDRA recoding tool only re-codes the items that match the selected Enterprises and
values selected in the Existing MedDRA Version to Re-Code list.

The log file specifies the Enterprise Short Name with every log record that is processed for a
particular Enterprise.

WHO Drug Dictionary

ORACLE

In this section:

* Prerequisites

* Load WHO Drug Dictionary to New Tables
e Overwrite an Existing WHO Drug Dictionary
* Load WHO Drug Dictionary Format C
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Windows workstation is available to load the WHODrug data.
The system has Oracle client installed, including the following:

SQLPLUS (Exe=sqglplus)
SQL*Loader (Exe=sqglldr)

There is an updated TNSNAMES file and Oracle client to connect to the Oracle
Argus Safety database.

The format of the WHO Drug Dictionary data files is Text and alternate rows are
not blank.

# Note:

WHODrug is loaded using sql*load with DIRECT=TRUE option. Because
of sgl*loader restrictions, no one should have access to the Oracle
Argus Safety system while WHO-DRUG is being loaded.

To display the WHO Drug Dictionary version in Oracle Argus Safety, the
CFG_DICTIONARIES_GLOBAL.VERSION column fetches data from Version.txt
file.

If version. txt file is missing during WHO Drug Dictionary load then WHO Drug
Dictionary version is displayed based on the value available in
CFG_DICTIONARIES.VERSION_NUMBER column only.

Load WHO Drug Dictionary to New Tables

ORACLE

< Note:

By uploading a version of WHODrug Enhanced, WHODrug Global or other
UMC products, you confirm holding a valid license granted by the UMC for
the uploaded UMC product.

Open the Dictionary Management Tool and click Who Drug Loader. A disclaimer
message pop-up appear. Click OK.

Enter the SYSTEM or DBA user password, the database name, and click OK.
In the WHO Drug Dictionary Loader dialog box, do the following:

a. To load the dictionary into a separate schema, click Load New Tables.

b. From the Dictionary Format drop-down, select an option.

c. To create new user, click Create User. Enter the information required to create
a new user and click OK.

d. To create new role, click Create Role. Enter the New Role name and click OK.

e. From the drop-down, select the Dictionary Version.
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Click Browse, navigate to the dictionary files, and click Select.

4. Click Load.
5. Click OK.
6. Enter the SYSTEM or DBA user password, the database name, and click OK.

Overwrite an Existing WHO Drug Dictionary

1. From the Dictionary Management Tool, click Who Drug Loader.

2. Enter the SYSTEM or DBA user password, the database name, and click OK.

3. Inthe WHO Drug Dictionary Loader dialog box, do the following:

a.
b.

C.

-

k.

Click Overwrite.

From the Dictionary Format drop-down, select an option.

From the User drop-down, select a user.

Enter the user password in the Password field; re-enter it in the Verify Password field.
From the Role drop-down, select a role.

From the Current Version to Overwrite drop-down, select the version to overwrite.
From the drop-down, select the Dictionary Version.

Click Browse, navigate to the dictionary files, and click Select.

From the Tablespace and Index drop-downs, select a table and an index.

Click Load.

View the WHO Drug Dictionary log file.

4. Enter the SYSTEM or DBA user password, the Database name and click OK. A
confirmation message that the dictionary is loaded successfully appears.

5. Click OK.

Load WHO Drug Dictionary Format C

For information about format C, go to http://who-umc.org.

1. Open the Dictionary Management Tool and click Who Drug Loader.

2. Enter the SYSTEM or DBA user password, the database name, and click OK.

3. Inthe WHO Drug Dictionary Loader dialog box, do the following:

a.

b.

ORACLE

To load the dictionary into a separate schema, click Load New Tables.

Select Dictionary Format—Format C or Format C3.
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J Drug Dictionary

In this section:

Prerequisites

ORACLE

4
5.
6
7

d.

e.

f.

Chapter 4
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< Note:

For Dictionary Format, Format C3, WHODrug schema will have
the table named WHO_DRUG_C3 MASTER and
WHO_DRUG_C3_MEDICINAL_PRODUCT, instead of table
WHO_DRUG_C_MASTER and
WHO_DRUG_C_MEDICINAL_PRODUCT. These table will have
the DRUG_NAME as Varchar2 (1500).

Besides, this schema will also have views as
WHO_DRUG_C_MASTER and
WHO_DRUG_C_MEDICINAL_PRODUCT which will point to the
tables WHO_DRUG_C3_MASTER and
WHO_DRUG_C3_MEDICINAL_PRODUCT but the Drug Name
is updated to Varchar2 (250).

For Dictionary Format, Format B3, WHODrug schema will have
the table named WHO_ B3 DRUG_DICT and

WHO_B3 ATC_CODE, instead of table WHO_DRUG_DICT and
WHO_ATC_CODE. These table will have the DRUG_NAME as
Varchar2 (1500) and ATC_TEXT Varchar2 (110).

Besides, this schema will also have views as
WHO_DRUG_DICT and WHO_ATC_CODE which will point to
the tables WHO B3 DRUG_DICT and WHO_ B3 ATC CODE
but the Drug Name is updated to Varchar2 (250) and Varchar2
(120).

To create new user, click Create User. Enter the parameters and click OK.
To create a new role, click Create Role. Enter the parameters and click OK.
From the drop-down, select the Dictionary Version.

Click Browse, navigate to the dictionary files and click Select.

Click Load.

From the Tablespace and Index drop-downs, select a table and an index.

Enter the SYSTEM or DBA user password, the database name, and click OK.

When the dictionary is loaded successfully, click OK.

Prerequisites

Create and Modify Required File

Load J Drug Dictionary

Overwrite an Existing J Drug Dictionary

The system where these dictionaries will be installed has a minimum of 50 MB

space.
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* The Dictionary Management Tool is installed.
* An Oracle database instance is available.
A SYSTEM or DBA user account is created.
*  The dictionary distribution organization name and contact
— Organization Name: MT Kyogikai
— Contact Information:
— URL: http://www.iyaku.info/
— TEL: +81-3-3230-2867
— FAX: +81-3-3239-3954

— e-mail:mtk@iyaku.info

# Note:

J-Drug Dictionary distributor organization (MT Kyogikai) is a different
organization from Oracle thus there is a possibility that their specifications or
procedures may change in future as per their own discretion.

Create and Modify Required File

J drug loader loads the following files using Dictionary Management Tool:
e All Data.txt

e formulationcode.txt

e drugnameenglish.txt

All the files must be present to load the dictionary, and the file names must be same as
mentioned above.

For more information, see:

* Create All_Data.txt file

* Create formulationcode.txt file
* Create drugnameenglish.txt file
*  Modify the.mdb file

Create All_Data.txt file

ORACLE

Sy
Copy the i‘ﬁ:t)ﬂ' file received from MT Kyogikai to 211 Data.txt without character
code conversion. This file must be a file which contains all the drug data records. A file that
contains only the delta (difference from the previous release) must not be used for
All Data.txt.

Sample A11 Data.txt files:
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Create formulationcode.txt file

The file formulationcode.txt is a text file containing the drug formulation code
information. You need to create this text file on your own. The drug formulation
information is provided from MT Kyogikai on a document titled Drug Name Data File
and English Name Sub File Summary. The formulation code list section provides the
contents of the formulationcode.txt file.

Format of the file formulationcode. txt:

- Physical file name: formulationcode.txt

- File format: CSV (Comma Separated Value) with 4 fields.
- Character Code: Shift-JIS code. (This file contains Kaniji.)

- Field Information:

Field#1: Route of Administration --either of 1,4,6,8
(For example, 1=, a=11 873 6=51 FZE, a=m I HEEH)

Field#2: Code --00, 10, 11, etc.

Field#3: Formulation name (lapanese)

(For example, FIRRZEE, 845, 7, etc.)

Field#4: Formulation name (English)
(For example, medicine, Powders, <null=, etc.)

Sample formulationcode.txt:
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1,10,8%%], Powders

) &

1,12,8%,

1,13, 0%, Fine granules

8,46, B 725, Spray
8,47,7 2 B F,
8,50,0E{15, Attach
8,70, £ 51 F Injection

The complete formulationcode. txt file as of Feb.2011 is available at:

https://support.oracle.com/epmos/main/downloadattachmentprocessor?
parent=DOCUMENT&sourceld=1293240.1&attachid=1293240.1:formulationcodeé&clickstrea
m=yes

Create drugnameenglish.txt file

g
Copy the %@ Ixt file received from MT Kyogikai and rename the file to
drugnameenglish.txt. This file is added in order to support English Names in J dictionary.

Sample drugnameenglish.txt

Ilm{)": L] 1112 ?‘D‘D‘Dl", L] FLU DTH&N E rl, Ll rl, Ll rl, Ll rl, Ll rl, e
"0000060","1114700","ANESTHETIC ETHER","1","","","1010","B"

IIDDDDDBD”, FI1115FD1 "]."THIAM"‘LAL SDDIUM“: I:Ij_I:IJI IIIIJI IIIIJI "93{]5“: Flcll

Modify the.mdb file

The current .mdb file shows only a single drop-down value for the release version on the J-
drug dictionary loader. Modify this file to use the latest version of the dictionary.

1. Open the jdrug.mdb from the following location:

disk:\Program Files\Oracle\Argus\DBInstaller

A table appears with J_Drug table supported versions (second column).
2. To add a new version, modify the MedDRA Version column.

For example, if 2015-OCT is the last version added, add 2015-DEC, (note that you must
append a comma).
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Tables -4 V] - Meddraversion = MeddraTableMame
T JprRuG # 150 ,2007-APR, 2012-APR, 2014- APR, 2014-AUG, 2004-0CT, 2015 JPN_DRUG_DICT

- APR,2005-0CT,

T J_DRUG_Constaaint

O ) bRuUG EH

T 1 oRUG Ine 131 ,2007-APR, 2012-APR, 2014-APR, 201 4-AUG, 2014-0CT, 2015- JPN_FORMULATION_CODE_LIST
T 1_DAUG Index 2008

APR, 5-0CT,

T LDRUG Sals

T LDRUG Merdons 231, 200T-APFR, 2013-APR, 2014- APR, 2014-AUG, 2014-0CT, 2015 IPM_DRUG_DICT_ENG_SUB
T mecdrbrowsersal APR,2015-0CT, '

T sguioadernrn

T wWHO_BE AFTER_LOAD * [ Mew]

Similarly, modify other rows and tables wherever the previous version number
exists.

Load J Drug Dictionary

The J Drug Dictionary loader in the Dictionary Management Tool now supports loading
the English name from the English sub file that is part of J Drug Dictionary.

1.
2.
3.

Open the Dictionary Management Tool and click J Drug Loader.
Enter the SYSTEM or DBA user password, the database name, and click OK.
In the J Drug Dictionary Loader dialog box, do the following:

a. Select Load to New Tables if a J-Drug dictionary has not already been
loaded.

b. To create a new J-Drug user, click Create User, enter the parameters, and
click OK.

c. To create a new role, click New Role, enter the parameters, and click OK.
In the Dictionary to Load section and do the following:

a. Select the J-Drug Version to be loaded from the drop-down.

b. Click Browse, navigate to the dictionary files and select the files.

c. Check the J-Drug Browser checkbox.

In the Tablespace Information section, select a table and an index from the drop-
downs.

Click Load.
Click OK.

< Note:

Oracle Argus Safety will use and display J Drug data from the latest J
drug dictionary which is loaded in the database.

For the example, if JIDrug_Aug_2015 dictionary and JDrug_OCT_ 2015
dictionary are loaded in the database, then Oracle Argus Safety will use
data from JDrug_OCT_2015 dictionary.

Overwrite an Existing J Drug Dictionary

1.
2.

ORACLE

Open the Dictionary Management Tool and click J Drug Loader.

Enter the SYSTEM or DBA user password, the database name, and click OK.
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In the J Drug Dictionary Loader dialog box, Loading Options section, do the following:

a.
b.

C.

h.

Select Overwrite.

Select the user from the User drop-down.

Enter the user password in the Password field; re-enter it in the Verify Password field.
Select the appropriate role from the Role drop-down.

Select the J Drug dictionary version to load from the Dictionary Version drop-down.
Click Browse, navigate to the dictionary files and select the files.

In the Tablespace Information section, select a table and an index from the drop-
downs.

Click Load.

Enter the SYSTEM or DBA user password, the database name, and click OK. The
Dictionary Load dialog box appears.

Click OK.
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This chapter provides information about configuring the system as described in the following

table:

Section

Description

Case Priority

Field Validation

Field Properties

LAM System Numbering
System Management (Common
Profile Switches)

Workflow

System Numbering

SMTP Configuration

Enabled modules

Interchange Mapping

This screen enables the administrator to configure rules to
determine the priority of new cases that are entered into the system.

This screen enables the administrator to configure field level
validations for the Case Form fields.

This screen enables the administrator to configure field properties.

This section enables the administrator to specify the case
numbering preferences for LAM cases.

This screen enables the administrator to configure common profile
switches.

This screen enables the administrator to configure Workflow states
and rules.

This screen enables the administrator to specify the case numbering
preferences.

This screen enables the administrator to configure SMTP for e-
mails.

This screen enables the administrator to segregate modules per
enterprise.

This screen enables the administrator to access the Interchange
Mapping Utility in the Argus Console.

For more information, see:

e Configuring Case Priority

e Configuring Field Validations

e Configuring LAM System Numbering

e Configuring System Management - Common Profile Switches

e Configuring Workflow

e Configuring System Numbering

e Configuring Field Properties
e Adding User Defined Fields

e Configuring User Defined Fields

e Configuring Local Data Entry

* Enabled Modules
* Interchange Mapping
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Configuring Case Priority

Configure rules to determine the priority of new cases that are entered into the system.
Based on these rules, the system assigns each case a priority that is displayed in the
Worklist.

Each row in the Case Priority Configuration screen represents the priority level
assigned to a case that meets the specific criteria selected for that level. This data is
reflected in multiple expedited and periodic reports and case form-product information
section.

e The user can select the priority level for which the criterion is to be configured.

e Select System Configuration > Case Priority toview the Case Priority
page.

ORACLE Welcome cristian, Wednesday, January 13, 2021 (AS6230-Eni2) LI SN0

CASE PRIORITY

Case Assessment First Report Due Date
Unlisted Causal Other Due Soon #Warning days

Priority g Advanced Conditions
erious.

On. ] bR [Ac ]
2 C— 1 R[ e ]
3 ] RJ[ac ]
4 1 B[ ~c |
s ] R [ac ]
s C— 1 B[~ ]
. 1 B [ac ]

[ Run all Case Priority jination on Middle Tier save || Print ] ‘

For more information, see:

» Field Descriptions

Field Descriptions

ORACLE

The following table lists and describes the fields in this section.

Field or Control Name Description
Priority Enables you to select the priority level whose criterion is to be
configured.

You can disable only the last enabled priority. Example: If a user
has priority 1-4 checked, the priority can be disabled only in the

order of 4-1.
Case Assessment - Enables you to configure the seriousness for case assessment.
Serious +  Select Yes from the drop-down list to give priority to cases

that are serious.

e Select No for non-serious cases to be considered for this
priority level. Seriousness is considered at the case level.

e Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.
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Configuring Case Priority

Field or Control Name

Description

Case Assessment -
Unlisted

Case Assessment - Causal

Report Due Date-Due
Soon

First Report Due Date -
Ignore

No. of Warning Days
Before Due

Advance Condition Drop
Down List Box

AC Button

Run All Case Priority
Determination on Middle
Tier

Enables you to configure the priority level for unlisted case

assessment.

*  Select Yes from the drop-down list for unlisted cases to be
considered for this priority level.

*  Select No for listed cases to be considered for this priority
level. Listedness criteria is considered at the case level.

*  Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.

Enables you to configure the priority level for causal case

assessment.

e Select Yes from the drop-down list for causal cases to be
considered for this priority level.

*  Select No for non-causal cases to be considered for this

priority level. Causality criteria is considered at the case level.

*  Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.

Enables you to configure the report date due soon.

If this option is selected, the case is given the specified priority if
at least one expedited report is due after the number of warning
days specified from the current system date.

Enables you to configure the first report due date to ignore status.

This option is used to ignore this parameter when assessing the
priority.

Enables you to enter the number of days before a case's report
due date when the priority is raised to Due Soon.

Enables you to select an existing advance condition from the
drop-down list.

Enables you to create a new advanced condition set or modify an
existing one.

Enables you to run all case priority determination on Middle Tier.

«  If unchecked, the application assesses priority during every
case save operation in Web.

e If checked, the application does NOT assess priority during
every case save operation in Web and Client/Server. The
initial priority is calculated by the report scheduling and after
that, all the priority updates are done by the AG Service
Priority process.

Use the following procedure to configure Case Priority

1. Select the priority level whose criterion is to be configured.

2. Select the Case Assessment - Serious. The options in the drop-down list are Yes, No,

Ignore.

3. Select the Case Assessment - Listed. The options in the drop-down list are Yes, No,

Ignore.

4. Select the Case Assessment - Casual. The options in the drop-down list are Yes, No,

Ignore.

5. Select First Report Due Date as Due Soon or Ignore. Enter the #Warning days for Due

Soon.
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Select the Advanced Conditions from the drop-down list.
Use the AC button to create a new Advanced Condition.

Select Run All Case Priority Determination on Middle Tier to ensure that the
application does not assess priority when a case is saved in Web and Client/
Server.

Click Save to save the changes made.

Configuring Field Validations

This screen enables you to configure field level validations for the Case Form fields.
Be aware of the following:

ORACLE

These validation rules are expressed as an advanced condition, with their criteria
marked as required or warning.

The field level validations feature helps in automatic checking of data as it is
entered on the Case Form, to ensure consistency of data as per company
requirements. Consider the following example:

Suppose that the year in the patient's date of birth is entered as 1860. The
patient's date of birth probably could not have been prior to 1880; hence, a
warning is issued to ensure the accuracy of the entered data.

A field level validation message such as this one is a "warning violation" and the
user can therefore enter a justification and continue working on the case.

An example of a mandatory violation would be a dosage regimen stop date that
occurs before the dosage regimen start date. Cases cannot be saved without
correcting mandatory violations.

For dependent fields, Oracle Argus Safety is pre-loaded with several field level
validations. Some of these validations are protected and cannot be disabled.
Others can be disabled, if required by company policy.

The system displays the Advance Condition Description for field validations on the
case form after the Advanced Condition name in the following format: Field:
XXXX:YYYYReason: ZZZZ

where:

XXXX—Is the Field Label Tree view followed by the field label as configured in the
field label configuration.

YYYY—Is the Advance Condition hame configured for the field validation.

Z2777—1Is the advance conditions descriptions as configured for the Advance
conditions. This text prints only if there is a description available for the Advanced
Condition. Otherwise, the system disables the field label.

Select System Configuration > Field Validation to view the Case Form
Field Level Validation screen.

Tip:

The Case Form tabs appear on the left panel and are categorized as folders.
Each folder contains all the field labels associated with that section.
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Consider the following example:

The General Tab in the Case Form contains sections such as Study, Follow-up, Case
Literature, etc. To view the list of field names associated with the Study section, click Study in
the left panel. The field names associated with Study appear in the right panel.

For more information, see:

* Field Descriptions
*  Modifying Field Validations

Field Descriptions

The following table lists and describes the fields in this section.

Field or Control Name Description

Field Displays the name of the field.

Condition for Warning Displays the advanced condition for warning.

Table Displays the name of the selected sub-folder as displayed in the browser
tree view. This field cannot be edited.

Field Displays the name of the selected field label in the browser tree-view.
This field cannot be edited.

Condition for Warning Displays the advanced condition for warning.

Condition for Mandatory Displays the advanced condition for mandatory exception.

Exception

Print All Displays a list of validations on all tables, fields and advanced conditions

of each Group in the Case Form as a PDF.

Modifying Field Validations

ORACLE

This section enables the user to edit the information already entered in fields.
Use the following procedure to modify a field validation.

1. Select the Case Form folder and field for which, the validation rule is to be modified.

Tip:

The information of the selected field is displayed in the Modify section.

2. Click Select icon to create/select advanced conditions for Condition for Warning and
Condition for Mandatory Exception.

Tip:

Click here for details on Advanced Conditions.
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< If all validation rules are met, a green icon is displayed.

* If a condition for warning is met during field validation, an orange
icon is displayed.

» If a condition for mandatory exception is met during field validation, a
red icon is displayed.

3. Click Save to save the changes made.

# Note:

Label Changes will not be reflected in Oracle Argus Safety Case Form
unless IIS is reset.

Configuring LAM System Numbering

This section enables you to specify the case nhumbering preferences for LAM cases.
The system provides the ability to use multiple case numbering schemes for global
use. For example, if site is used in the numbering, the system provides the option to
keep separate sequences for each site.

Select System Configuration > LAM System Numbering to view the LAM

System Numbering screen.

For more information, see:

e Field Descriptions

Field Descriptions

The following table lists and describes the fields in this section.

ORACLE

Field or Control Name

Description

Manually Number Cases

Automatically Number
Cases

Start at

Separate sequence for each
site

Separate sequence for each
report type

The option is used to enable the user to manually number the
cases on booking or while copying the case, using the save as'
option on the case form.

On selection, the system automatically numbers the cases as
defined by the user in the numbering format.

Enables the user to initialize the counter of the sequence
number.

Enables the user to separate the sequence numbering for cases
on site by site basis. If there are cases being entered from two
different sites then each site will have different sequencing of
case numbers.

Enables the user to separate the sequence numbering for cases
by the report type of the case.
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Field or Control Name

Description

Separate sequence for each
year

Separate sequence for each
month

Separate sequence for each
product abbreviation

Numbering Format

Placeholder

Enables the user to reset the sequence numbering for cases
after each year, based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases
after each month, based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases for
each different product abbreviation.

Enables the user to select the numbering format by selecting the
different placeholders.

»  Define the numbering format by typing in custom keywords
to print on every case number and selecting different
placeholders.

*  [YY][MM]-[###] is the default format.
Enables the user to enter a placeholder.

»  Placeholders are used to pickup values from the database
to be used in the Case numbering format.
*  The possible values populated in this list are:

—  # - Number: defines the digits to be used as the
sequence number in the format. The field is used to
display the sequence number on the case numbers.

—  CC- Country code: When selected, this uses the A2
code for the country of incidence for the case number.

— DD - Day: When selected, this uses the date of the
Initial receipt date' field of the case.

— MM - month: When selected, this uses the month of the
Initial receipt date' field of the case.

— P -When selected, this uses either of the two values:

If report type is Spontaneous or other during booking:
the system uses the value of the Product Abbreviation'
field specified in the Product configuration for the
selected Primary suspect product.

— SSS - User Site: When selected this uses the Site
abbreviation of the site belonging to the user who
booked in the case.

— TTT - Report Type: When selected this uses the report
type abbreviation of the report type selected during
bookin of the case.-

— YY- Year: When selected, this uses the year of the
'Initial receipt date' field of the case.

Use the following procedure to configure LAM Numbering.

1. Select the Numbering feature as required. This can be manual numbering or automatic

numbering of cases.

Tip:

Select the Sequencing Options as required.

For the complete explanation of the sequencing option refer to the Field

Descriptions.

Select the Numbering Format. Use Placeholders to enter the required format.
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Tip:

To customize the Numbering Format, use the placeholder values.
Consider the following example:

To select Country Code, Month and Year (as values to be incorporated
from the database ) as the Case numbering format, execute the following
steps.

a. Click on Country Code. This appears in the Numbering Format field.

b. Click on Month. This appears in the Numbering Format field next to
the Country Code.

c. Click on Year. This appears in the Numbering Format field next to
the Country Code and Month.

d. The final data listed in the Numbering Format field is the Case
Numbering Format.

4. Click Save to save the changes made.

Configuring System Management - Common Profile
Switches

This section lists the configurable sections for Common Profile Switches.

Select System Configuration and then System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

" Note:

If any change is made in the System Management (Common Profile
Switches) screen, the Argusvr2.exe and Argusvr2a.exe should be
killed from each Web Server and the IIS on Oracle Argus Web / Report
Servers must be reset, in order to reflect the changes made in the
application.

The following table provides the list of configurable sections associated with Common
Profile Switches.

ORACLE 5-8



ORACLE

Chapter 5

Configuring System Management - Common Profile Switches

Section

Sub Section

Description

Advanced Conditions

Argus Dossier

Argus Insight

Argus J

Argus Mart

Background Services

Case Form Configuration

Case Processing

Database

Document Management

Help

Local Labeling

Network Settings

Report Configuration

E2B
Reporting

Device Report
Responsible Officer

Assessments

Always Show Literature
Data

Auto Archiving

Case Numbering
Dictionary Browser
Enable Local Unlocking
Group Data Access

Lot Number Processing
Performance

LAM

The Advanced Conditions configuration
screen enables you to specify the
number of rows to be displayed on the
Advanced Condition search screen.

The Oracle Argus Dossier screen
enables you to modify the customizable
fields of Argus Dossier.

If Oracle Argus Enterprise products are
enabled, the Oracle Argus Insight URL
can be provided here.

The Argus J Configuration screen
enables you to modify the customizable
fields on the Argus J form.

If Argus Enterprise products are
enabled, Oracle Argus Mart related
settings can be configured here.

This screen enables you to configure the
Common Profile Switches that affect the
behavior of Background Services.

This screen enables you to configure
Common Profile Switches that affect the
behavior of the Oracle Argus application

This section enables you to configure the
case processing fields and items.

The database related parameters can be
maintained here.

Calculation functions for Case
Seriousness, Listedness and Causality
calculation.

This screen enables you to configure the
Documentum fields and items for
Documentum.

Centralized Online Help URL.

The Local Labeling Configuration screen
enables you to modify the options
available through local labeling.

The Network Settings screen enables
you to modify the settings on the Argus
Safety Load Balancer Server and Proxy.
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Section

Sub Section

Description

Reporting

Security

Session Timeout

Single Sign-On

User Interface

Workflow

BIP Reporting

E2B

eMDR

eVAERS

Expedited

Expedited - BfArM
Expedited - Canada
Expedited - CIOMS
Expedited - MedWatch
MedWatch Configuration
Periodic

Scheduling
Cryptography

LDAP

Session expiration time
in minutes

The Reporting Configuration screen
enables you to modify the options
available for reporting.

The Security Configuration screen
enables you to modify the options
available for security.

The maximum idle time allowed for a
user's session. Valid range for this value
is 5-1440. Default value is 30 min. Note
that long running processes like CDA are
controlled through the table
CMN_URL_ACCESS_GLOBAL where
user can specify a timeout value local to
that process. Further, the user would
need to set the process as
IS_LONG_RUNNING = 1. By default, the
following are categorized as long
running:

'/REPORTS/CIOMSII/
CIOMS2_SAVING.ASP'

'/AUDITLOG/AUDITLOGLIST.ASP";
'IREPORTS/CDA/CDAGENERATE.ASP',

The Single Sign-On screen enables you
to modify the options available for Single
Sign-On such as enabling or disabling it,
its HTTP Header, Logout URL, and using
Oracle Access Server SDK for LDAP
Validation.

Note that in a SSO configured
environment, for the SSO to take effect,
the session timeout value should be set
to maximum value.

The User Interface screen enables you
to modify the options available for User
Interface.

The Workflow Iltems screen enables you
to modify the options available for
Workflow Items.

For more information, see:

e Configuring Advanced Conditions

ORACLE
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Configuring Background Services
Configuring Case Form (System Management)
SMTP Configuration

Configuring Case Processing
Configuring Database
Configuring Assessments
Configuring Auto Archiving
Configuring Case Numbering
Configuring Lot Number
Configuring the Dictionary Browser
Configuring Group Data Access
Configuring WHO Drug
Configuring Performance
Configuring Documentum

Local Labeling

Network Settings

User Interface

Configuring Reporting
Configuring Security

Configuring Single Sign-On

Error Messages

Configuring SMTP

Configuring Workflow Iltems

Configuring Advanced Conditions

ORACLE

Q Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels

associated with that section.

Field Descriptions

Select System Configuration > System Management to view the Common Profile
Configuration screen.

To configure the rows to display on each page of an advanced condition screen, click the
Advanced Conditions folder in the left panel.

The following table lists and describes the fields in Advanced Conditions Configuration.
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Field or Control Name

Description

Number of rows to display per page on the
Advanced Condition Search screen

Comma separated list of allowable
parameters for custom advanced
conditions

Enables you to specify the number of rows to be
displayed on the Advanced Condition search
screen.

This feature allows the Advanced conditions to
store and execute customer SQLs containing bind
variables through the Ul. The application supports
the bind variables defined in a comma separated
format. The bind variables defined here are case
insensitive. This switch supports a maximum
length of 1000 characters.

In OOTB configuration, the following bind
variables are supported:

« P_CASE_ID

e P_SEQ_NUM

e P_REG_RPT_ID

e P_REG_REPORT_ID

+ P_REPORT_FORM_ID

Use the following procedure to configure Advanced Conditions.

1. Enter the Number of rows to display per page on the Advanced Conditions Search

screen.

2. Click Save to save the changes made.

Configuring Background Services

This screen enables you to configure the Common Profile Switches that affect the

behavior of Background Services.

To view the list of field names associated with the Background Services section, click
the Background Services folder in the left panel. The field names associated with the
Background Services appear in the right panel.

Field Descriptions

The following table lists the fields available under Background Services:

Field or Control Name Description

Number of cases to be processed  The number of cases that can be processed by a single
by single Report Scheduling AG instance of the Report Scheduling AG Process.
Process The range of allowed values is 0-999.

The default value is 50.

Number of cases to be processed  The number of cases that can be processed by a single
by single Scheduling Check AG instance of the Scheduling Check AG Process.

Process The range of allowed values is 0-999.
The default value is 100.

ORACLE
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Configuring Case Form (System Management)

ORACLE"

This screen enables you to configure Common Profile Switches that affect the behavior of the
Argus application.

Q Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To view the list of field names associated with the Case Form Configuration section, click the
Case Form Configuration folder in the left panel. The field names associated with Case
Form Configuration appears in the right panel.

The Case Form Configuration dialog helps you customize the case processing activities in
order to meet the company's requirements. The Administrator can configure the following
items by using the Case Form Configuration dialog shown in the following illustration.

ORACLE Welcome cristian, Wednesday, January 13, 2021 (A5823U.En2) LSOl

l Code Lists. | Business Configuration | Access Management | System Configuration | Tools.

COMMON PROFILE - CASE FORM CONFIGURATION

oy Caso s Costrgaton
|| ]
e

Drugs WHODRUG DDE B3 September 1, 2020
Events & Indications MedDRA J Brows V23 1J vl 0O

Centralized Coding
s

Coding Web Service

The Case Processing Dictionary Browser common profile switches are segregated by
enterprises to allow different configurations for different enterprises. However, the URL and
other configuration for WHO Drug and MedDRA web services remain in configuration XML on
the Web Servers as per existing design and hence remain common across all enterprises.

In a multi-tenant installation, if the provider chooses to operate using Coding via web service,
they should use the same web service across all enterprises.

Auto Encoding, Dictionary and Central Encoding

To enable the use of standardized medical terminology throughout the adverse event
reporting process, dictionaries can be used to encode certain terms in the Case Form.
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The dictionaries that will be used to encode drugs, Events & Indications, and events
can be specified in the Autoencoding section of the Case Form Configuration dialog.

Field Descriptions

The following table lists and describes the fields in this section.

Field or Control Description
Name
Central Coding You can independently turn On/Off Centralized Coding for individual

enterprises from the Argus Console - System Management
> Case Form Configuration by marking the checkbox next to
the Events & Indications MedDRA dictionary version drop-down list.

The enterprise can use its own MedDRA version using the Argus
Console > System Management > Case Form
Configuration > Centralized Coding >
Centralized Coding Configuration

Drugs The Drugs dictionary list enables the selection of the WHO-DRUG
dictionary. Select the Drugs check box and tab out of the product name
field in the Case Form to search the company product followed by the
license trade names.

* If no matches are found, the WHO drug dictionary (drug names) is
searched.

»  Tab out of the generic nhame field in the Case Form to search the
product/product family ingredients (it displays the select dialog if
more than one product is found with the ingredient).

e If no match is found, the WHO drug dictionary (ingredients) is
searched.

Events & Indications  Select Events & Indications to be prompted for the term as you enter
it to be encoded on the Events & Indications tab. If an exact match is
found in the dictionary, the term populates automatically. If an exact
match is not found, the Event Coding dialog is displayed to select the
desired event.

Auto encodes primary indication for the drug encoding, Patient
Condition description in Other Relevant History section and Death
Details dialog.

Prevent manual Prevents users from encoding the Events & Indications manually.
encoding for Events &
Indications

Require event term Ensures that users encode the events prior to formally closing a case.
encoding before case
closure

Automation

The Automation section enables the user to generate an Auto narrative based on one
of the templates configured by the method described in this topic.

Field Descriptions

The following table lists and describes the fields in the Automation dialog box.
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Field or Control Name Description

Auto Regulatory This enables the user to configure the manner in which Oracle Argus Safety
Scheduling handles the Auto-scheduling of Regulatory Reports.

The available options are:

* None

*  Always

*  Significant

*  Manual

When the common profile switch is set to Always, the system does not wait
for a lock to schedule reports, it tries to auto-schedule each time user the
saves the case. However, the only criteria to run auto-scheduling algorithm is
that the case must have product, event and event assessment.

Report Generation The Report Generation option helps you to configure how the system
responds to new data when generating auto-scheduled regulatory reports.

*  When new data is entered, the system re-runs the regulatory report-
scheduling algorithm to determine which reporting rules apply to the
case.

* If Overwrite Existing Reports is selected, the system updates the
existing scheduled reports with the new data entered. This setting
ensures that follow-up numbering is specific to each health authority.

* If a MedWatch report for the FDA has already been scheduled for this
case, that report would then be updated with the new information
entered.

* If Create as Follow-up is selected, the system uses the new data to
create new reports marked as follow-up reports. This setting ensures
that the same number would identify a follow-up report worldwide. Users
will be unable to submit follow-up reports before one of the following
events occur on the initial or previous follow-up report.

Aware date and Due date of a scheduled report can be overwritten or

retained with original dates based on the internal common profile switch

"Scheduled Report Update".

If Scheduled Report Update is set to Update to current aware date and
new due date, the current Aware date is used and due dat is updated based
on the current aware date while overwriting a scheduled report.

If Scheduled Report Update is set to Keep original aware date and due
date the aware date/due date are not updated based on current aware date
while overwriting a scheduled report.

If the common profile switch Report Generation is set to Create as Follow-up
then, system allows generation of follow-up reports irrespective of submission
status of previously scheduled reports based on the settings made to the
common profile switch Allow Report Generation.

Case Locking for The Administrator has the option of indicating whether cases that are not
Report locked can appear in periodic reports.

* If Allow Unlocked cases to be included is selected, then a check box
on the periodic report configuration dialogs will allow unlocked cases to
appear in periodic reports.

e To prevent unlocked cases from appearing in periodic reports, select
Prevent unlocked cases from appearing.
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Field or Control Name Description

Report On

Diagnosis Default on
Event

Event Assessment On

Prevent Modification of
Autonarrative

Case Autonarrative

Selecting Diagnoses will only list the events marked as diagnoses plus
events unassociated with a diagnosis in Regulatory Reports.

The Event Assessment section of the case form will only list diagnosis
and unrelated events. If there are no diagnoses, all events are listed. You
can configure a default setting for selecting the Diagnoses state at a
system level.

Selecting All Events will always list all events, regardless of their
relationship in the Event Assessment section of the case form. The
system will take into consideration both events marked as diagnoses and
events marked as symptoms when running the regulatory report
algorithm.

The options are Yes or No

Selecting Yes will set the default Events Diagnosis to Yes whenever a
new event is entered.

Selecting No will set the default Events Diagnosis to No whenever a new
event is entered.

The Event Assessment section of the case form will only list diagnosis and
unrelated events. If there are no diagnoses, all events are listed. You can
configure a default setting for selecting the Diagnoses state at a system level.

Selecting Diagnoses will include in Event Assessment only those events
that are associated with a diagnosis or symptoms that are not associated
with any of the diagnoses.

Selecting All Events will include all events when the Event Assessment
is performed.

Selecting the Preventing Modification of Autonarrative check box will
prevent users from modifying autonarratives.

Selecting the Case Autonarrative check box enables the user to generate an
Autonarrative based on one of the templates configured by the method
described in this topic.

Templates

Clicking the Templates button enables the Administrator to create a new Autonarrative
template, modify/copy an existing template, or delete an existing template.

Use the following procedure to create a new Autonarrative template.

1. Click the Templates button in the Case Form Configuration dialog to open the
Autonarrative Configuration dialog.

2. Click New to open the Narrative Configuration dialog.

3. Under Template Name, enter a name for this new template.

4. Click the Add button at the bottom of the dialog. A new row for entering a phrase
and its associated logic will appear.

5. Enter a text phrase in the Phrase field. The text can include placeholders that will
be substituted by the appropriate case data when the Autonarrative is generated.
For the example: A phrase might be entered as: "The patient was [age] at the
onset of this event". When the Autonarrative is being generated, the "[age]"
placeholder will be substituted for the actual age of the particular patient in the

case.

6. Click the ellipsis button to the right of the Logic column. Select or enter an
Advanced Condition for the logic section.
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This search will be used to determine whether or not the corresponding phrase will
appear in a narrative for a particular case. For the example: An advanced condition
can be specified such that only cases involving children younger
than five years old will have the phrase.

The patient was [age] at the onset of this event in the Autonarrative.

7. Repeat steps 4 through 6 to add other text phrases to the template. Click OK to save the
template or Cancel to exit the dialog without saving the changes.

" Note:
Selecting the Preventing Modification of Autonarrative checkbox in the Case
Form Configuration dialog will prevent users from modifying autonarratives.
Creating a Template in Another Language
Use the following procedure to create a template in another language.

1. Once atemplate is created, double-click the Narrative Templates folder to expand the
template tree in the Autonarrative Configuration dialog.

Tip:

To open the Autonarrrative Configuration dialog, click the Autonarrative button
in the Case Form Configuration dialog.

2. Expand the selected template folder to display the languages for this template. To
configure this template in a language other than English, double-click the appropriate
language icon.

3. Configure the foreign language template as described in steps 4 through 7 of the
procedure for creating the Autonarrative template above.

4. Click Close to exit the Autonarrative Configuration dialog.

# Note:

Autonarrative placeholders in a language other than English will get substituted
by text from that particular language. If no text is available in that language,
English language text will be used to substitute the placeholders.

Copying a Template to Another Language
Use the following procedure to copy a template to another language.

1. Select the original language from which the target language copy is to be created. The
original language can be selected in the tree-view of the Autonarrative Configuration
dialog.
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Tip:

To open the Autonarrrative Configuration dialog, click the Autonarrative
button in the Case Form Configuration dialog.

Click Copy. The Autonarrative Copy dialog will appeatr.

# Note:

In the Autonarrative Configuration dialog, the Copy button for a selected
language template will only be available if a template has already been
created in that language.

Select the language to which the narrative template is to be copied and click
Copy.

The contents of the original language template will now be copied into the selected
language template.

Deleting Templates

Use the following procedure to delete templates.

1.

To delete a language template, select the appropriate language icon for the
template in the Autonarrative Configuration dialog and click Delete.

To delete the entire Autonarrative template, select the template folder icon in the
Autonarrative Configuration dialog and click Delete.

Duration Calculations

The following table lists and describes the fields associated with this section.

Field or Control Description
Name
Event The Duration Calculations section is used to indicate whether the

system should calculate event duration (the time from Event Onset Date
to Event Stop Date) in an inclusive or an exclusive manner.

For instance, select Inclusive to calculate a range from 01 January to
10 January as ten days. Select Exclusive to calculate a range from 01
January to 10 January as nine days.

If the user has entered both the date and time, the exclusive/inclusive
designation is ignored.

Drug The Drug Duration Calculations section is used to indicate whether the

system should calculate drug duration in an inclusive manner or an
exclusive manner, as described under Event Duration Calculations.

Documentum Common Login

The Documentum Common Login information is used to connect to the Documentum
server to perform Documentum related activities to the case form. The system uses
this information only if the common profile switch to use the common login is set. This
option is only available if the system is configured to use Documentum.

The following table lists and describes the fields associated with this section.

5-18



ORACLE

Chapter 5
Configuring System Management - Common Profile Switches

Field or Control Name Description

Username

Password

This is the username associated with the Documentum Common Login.

This is the password associated with the Documentum Common Login
username.

Custom Routines

The following table lists the Field Descriptions associated with this section.

Field or Control
Name

Description

Custom Routine Before
Save

Custom Routine Before
Commit

Custom Routine After
Commit

Custom Routine Before
Lock

Attachment File Size
Limit (in Megabytes)

The function behaves the same way as the Custom Routine Before Commit.
The case ID is passed as a parameter to the function. The return value is a
string format. If a null string is returned, the system assumes the procedure
executed without any error, and continues with the case save operation. If any
numeric/string value is returned, the case save routine is aborted and the
system displays the returned string as an error message to the user.

This is the Custom routine to be called before case save. Ensure that the
custom routine is present in the database, and the application has access to
it.

This is the after-save Custom routine to be called after case save. Ensure
that the custom routine is present in the database, and the application has
access to it.

Select the Table Config button to select the tables that are being modified in
the post-save script.

This is the Custom routine to be called before case lock Ensure that the
custom routine is present in the database, and the application has access to
it.

The file size entered in this field enables you to specify the maximum size
limit for attaching a file. The upload limit defined here can be seen in the
Attachments and References section of the Bookin screen.

The default size for uploading an attachment is 30 MB. You can also
configure the file size as per your requirement, up to 300 MB.

Table Config Button

The Table Config button enables you to fetch only the delta table data after post-save, so that
the entire case is not reloaded. This button is enabled only when the Custom Routine After
Commit checkbox is selected.

Use the following procedure to remove case tables.

1. Select the Custom Routine After Commit checkbox and click the TableConfig button.

Initially, all case tables open under the Available Tables list box.

2. Select the required table(s) and click Add>> to include them to the Selected Tables list.

Alternatively, you can select the required table(s) and click <<Remove to exclude them
from the Selected Tables list.

3. Click Cancel to close the screen without making any changes or click Save to save this

configuration.

* The Case Save routine gets modified to retrieve only the table data from the Selected
Tables in the configuration.
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* If no Post Save is configured, the Case Save does not execute the Case Load
routine.

Modify Data Lock Point

This section is displayed only if the DLP_SETUP switch is set to ON in the database
schema in the CMN_Profile_Global table.

Modify Data Lock Point

Enable Data Lock Point
Data Lock Point Revision

(U Use Last Completed Version

® Use Next Completed version (Includes Data Cleaning)

The following table lists and describes the fields in this section.

Field or Control Name Description

Enable Data Lock Point Enables you to activate a data lock point by selecting this
checkbox. If this checkbox is not selected, the Modify Data
Lock Point section displays only this field as editable.

Use Last Completed Version Enables you to use the last completed version.

Use Next Completed Version Enables you to use the next completed version that

(Includes Data Cleaning) includes data cleaning.

Run Expedited and E2B Reports Enables you to execute expedited and E2B reports on DLP

on DLP database and these reports are scheduled on a previous
aware date.

SMTP Configuration

ORACLE

The Oracle Argus Safety Service and the Interchange Service use the SMTP
configuration utility for e-mail transmission if it has been enabled and configured in
Argus Safety. Case Letters are also sent using SMTP.

To configure SMTP:

1. Navigate to Argus Console > System Configuration > SMTP
configuration.

2. When the SMTP Configuration dialog box appears, enter the following parameters:
e SMTP Server IP address or name
*  Port number (Default value is 25)
* User name

3. Check the Enable SMTP checkbox.

4. Enter FQDN (Fully Qualified Domain Name).

5. Enter a valid e-mail address in the Global From Address field. When e-mails are
sent from Oracle Argus Safety, the From address for all e-mails is set to the e-mail
specified in Global From Address.
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Click Validate and Save, to connect to the e-mail server as per the configuration data. If
the connection is successful, then the configuration data is saved and a test e-mail is
sent. If the connection is not successful, the error is displayed in the Status field and the
configuration is not saved.

System Configuration : SMTP Configuration -- Webpage Dialog

SMTP Configuration

Enable SMTP?

— Server Configuration

Server IP or Name internal-mail-router oracle.com Port 25

FQDN oracle.com

Global From Address | rajani deverhalli@oracle.com

— Authentication Configuration

Authentication Mo Authentication + | S5L Start Mode | pgne v
SMTP UserName SMTP Password

SMTP Header Configuration

Custom SMTP Header Confidential : Please Treat this as confidential

Status:

Validate and Save Cancel

All e-mail messages sent using the following processes are sent as Confidential;
* AG Service: Bulk Transmit Email

* AG Service: General Email

* ESM Service: Business / User / IT Email

The Audit Log tracks updates to this field.

Configuring Case Processing

ORACLE"

This section enables you to configure the case processing fields and items. Select System
Configuration -> System Management to view the Common Profile Configuration screen

< Note:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders.
Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing section, click the Case
Processing folder in the left panel.

The field names associated with Case Processing Configuration appear in the right panel.
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The Case Processing folder has been further categorized into the following sub-

folders:

e Configuring Assessments

*  Configuring Always Show Literature Data

*  Configuring Auto Archiving

e Configuring Case Numbering

*  Configuring Dictionary Browser

e Configuring Group Data Access

e Configuring Lot Number Processing

*  Configuring Performance

Field Descriptions

The following table lists the fields available under Case Processing Configuration:

Field or Control
Name

Description

Create follow-up on
unblinding

Manually Schedule
reports

Events to Display on
Assessment Tab

Enable Local
Unlocking

Search product on
Case Form

Select Type of WHO
drug search for auto
drug encoding

Action Item Code
when QC info is
entered

Valid Attachment File
Types

ORACLE

The available options are Yes and No.

The available options are:

*  Report scheduling will schedule follow up reports

e Report scheduling will not schedule follow up reports
The available options are:

«  Event Assessment will display all Events

«  Event Assessment will display Diagnosis Events only

Provides a system level control permitting local users to locally unlock a
case and make any corrections to the previously entered local data.
Enables you to select whether to locally unlock a case or not.

The available options are:
e Yes
. No
The available options are:

e Product Name product lookup. Based on products configured in the
system.

e Trade Name product lookup. Based on the licenses configured in
the system.

The available options are:

. Default WHO schema
*  Use alternate who tables

The available action item codes are listed in the drop-down list box.

Allows users to attach files in Case Form with the file types mentioned
in this parameter.

5-22



ORACLE

Chapter 5
Configuring System Management - Common Profile Switches

Field or Control
Name

Description

SQL to prevent case
unlock when reports
are pending
generation

Allows customization to prevent users from unlocking the case from
Case Form, E2B, and LAM if there were reports pending generation.

You can configure this behavior by adding a SQL or database function
in the given text field.

1. If the value returned is greater than 0, then the system shall
behave as described below:
If the Value of Allow forced unlock (Global and Local) is Yes,
Report Status (Global or Local) is Pending (i.e. the value from SQL
check returned > 0), a warning message is displayed.

The case is unlocked using the existing "Locked Case" dialog if
user selects "Yes" on the warning message. This means that the
pending global reports will not be generated on unlock and may be
overwritten or removed depending on case data on the subsequent
global lock.

If the Value of Allow forced unlock (Global and Local) is No, Report
Status (Global or Local) is Pending (i.e. the value from SQL check
returned > 0), the case is not unlocked and an error message is
displayed.

If the Value of Allow forced unlock (Global and Local) is N/A,
Report Status (Global or Local) is Generated /Submitted (i.e. the
value from SQL check returned 0 or no SQL has been configured),
the case is not unlocked.

2. If the value returned is 0 or no SQL has been configured, the
system shall allow users to global unlock the case without any of
the other checks.

The default for this configuration will stop the users from unlocking the
case if there are scheduled reports pending generation.

DLP_EXPEDITED_E2B_REPORTS is set to O (i.e., DLP is not enabled
for Expedited Reporting feedback.

The checks for reports pending generation are applicable only when the
parameter Run Expedited and E2B Reports on DLP is unchecked (i.e.,
DLP is not enabled for Expedited Reporting).

Make sure that the name that is being used for the bind parameter is
P_CASE_ID.
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Field or Control
Name

Description

Generate auto-
narrative for the other
language without
user confirmation

This common profile switch helps to suppress user confirmation during
generation of auto-narrative for the other language while the user
performs the operation in the English side or Japanese side.

Click Yes to generate or No (default) to not generate the auto-narrative.
If auto-narrative is being performed prior to global lock:

If a user is performing the auto-narrative from the Japanese side of the
case form and if the auto-narrative template has any other language
other than Japanese configured, and if the new common profile switch
"Generate auto-narrative for the other language without user
confirmation” is set to "No", the system shall first prompt the user if they
wanted to generate the English and other language narratives as well.
The system shall proceed with all the non-Japanese language narrative
generation steps only if the user chose Yes to this dialog (note that
existing generation steps and prompts still hold good) or if the new
common profile switch "Generate auto-narrative for the other language
without user confirmation" is set to "Yes. If they chose No to the user
prompt, the system shall proceed with only Japanese narrative
generation (note that existing generation steps and prompts still holds
true). If they chose Cancel, the system shall not proceed with auto-
narrative generation for any language.

If a user is performing the auto-narrative from the English side of the
case form and if the chosen Narrative template has Japanese language
configured, and if the new common profile switch "Generate auto-
narrative for the other language without user confirmation” is set to
"No", the system shall first prompt the user if they wanted to generate
the Japanese narrative as well. The system shall proceed with the
Japanese language narrative generation steps only if the user chose
Yes to this dialog (note that existing generation steps and prompts still
hold good) ) or if the new common profile switch "Generate auto-
narrative for the other language without user confirmation” is set to
"Yes". If they chose No to the user prompt, the system shall proceed
with only the non-Japanese (English and all other languages except
Japanese) narrative generation (note that existing generation steps and
prompts still holds true). Note that the prompt shall not display if
Japanese language was not configured in the template. If they chose
Cancel, the system shall not proceed with auto-narrative generation for
any language.
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Field or Control Description

Name

Truly Local Case Provides a system level control allowing customers to define SQL or
(Note: Bind PL/SQL block or specify database function to test if a case with suspect

variable :P_CASE_ID Local (Japanese) License product is a Local PRPT case. This field is a
must be used in SQL) multi-line text fields with a limit of up to 1000 characters. It is partitioned
by enterprises for multi-tenant customers.

The SQL or PL/SQL block or the database function shall accept a bind
variable :P_CASE_ID representing the case from which this switch is
being invoked. If the value returned from the configured SQL or PL/SQL
block or the database function is > 0, the system shall consider the
case with suspect products having local (Japanese) license as a Local
PRPT case.

If the value returned is 0, the system shall not consider the case a Local
PRPT case (unless there is already a local report pending generation
i.e., Scheduled or New data available report states).

If there is no SQL or PL/SQL block or database function configured in
this switch, the system shall consider that the switch returns a default
value of 1.

The system does not allow illegal data manipulations (e.g., UPDATE/
INSERT/DELETE statements) to the underlying Argus schema via this
switch.

This switch is also used to determine if a report is a Local report.

Always show When configured to Yes, the application always displays the literature
Literature Data section in the Case Form and Book-in.

section on Case Default: 0

Form

Use the following procedure to configure the case processing options.

Select the required option in Create follow-up on unblinding.
Select the required option in Allow User to regenerate reports.
Select the required option in Manually Schedule reports.

Select the required option in Events to Display on Assessment Tab.
Select the required option in Access on Patient Information.

Select the required option in Search product on Case Form.

N o o M w bdh PR

Select the required option in Select Type of WHO drug search for auto drug
encoding.

8. Select an action item code from the drop-down list in Action Item Code when QC info is
entered. This code will be used to populate the Action Item Code field of the action item
created by the system whenever a user adds QC information to a case through the Case
form > Products tab. If you do not select any value from the list, then no Action Iltem Code
will be set.

9. The Auto Upload Letters feature is no longer available. You are requested to select only
the Manually Upload Letters option.

10. Click Save to save the changes made to this section.
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Configuring Database

This screen enables you to configure the case processing fields and items for the
database. Select System Configuration > Database to view the Common
Profile Configuration screen.

To view the list of field names associated with the Case Processing > Database
section, click the Database folder in the left panel.

The field names associated with Modify Database appear in the right panel.
Field Descriptions

The following table lists the fields available under Modify Database:

Field or Control Description
Name

Database Server OS The database server timezone can be specified here. This value can be

Timezone configured during the Oracle Argus database installation. Note that the
timezone selected here should be in sync with the database, web and
transaction servers. For further information, see "GMT Offset
Calculation" below.

Override Case If this configured in Common Profile Switches > Database

Seriousness > Modify Database, the configured function is executed.
Calculation Function

(Note: Default

function shall be used

if left BLANK) # Note:
Default function shall be used if left
BLANK.
Override Case If this configured in Common Profile Switches > Database
Listedness > Modify Database, the configured function is executed.
Calculation Function
(Note: Default
function shall be used .
if left BLANK) «# Note:
Default function shall be used if left
BLANK.
Override Case If this configured in Common Profile Switches > Database

Causality Calculation > Modify Database, the configured function is executed.
Function (Note:

Default function shall

be used if left .

BLANK) # Note:

Default function shall be used if left
BLANK.

GMT Offset Calculation
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The system uses the time zone of the DB server to perform GMT calculations. This time zone
is initially loaded during the Oracle Argus database installation.

To set up the time zone:

1. GotoArgus Console > System Configuration > Database.

2. From the Database Server OS Timezone drop-down list, select a time zone.

3. Alternatively, update the DATABASE_TIMEZONE key in the CMN_PROFILE table.

Make sure that Argus is using the gss_util.gmt_offset function to derive the GMT OFFSET
which impacts the calculation of GMT date and time.

Assume that Daylight Saving Time starts on the first Sunday of April at 2:00 AM and ends on
the last Sunday of October at 2:00 AM.

To find out the time zone offset for the time zone regions, execute the following query:

SELECT tzname, tz offset (tzname) offset, tzabbrev FROM gvstimezone_names;

Configuring Assessments

ORACLE

This screen enables you to configure the case processing fields and items for assessments.
Select System Configuration > System Management to view the Common Profile
Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To view the list of field names associated with the Case Processing > Assessments
section, click the Assessments folder in the left panel.

The field names associated with Assessments Configuration appear in the right panel.
Field Descriptions

The following table lists the fields available under Assessments Configuration:

Field or Control Name Description

Display warning when  The available options are Yes and No.
Case Level

Assessment does not

match with Event Level

Assessment

Criteria for case level  The available options are:

causality assessment . perive the case level causality based on the As Determined event level
causality.

e Manually select case level causality.
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Field or Control Name Description

Criteria for case level  The available options are:

Seriousness «  Derive the case level seriousness based on the events. If any event is
determination serious, case level will be serious.

e Manually select case level seriousness.
SUSAR Ciriteria Enables you to enter an SUSAR criteria as an SQL query.
An SUSAR is identified as a Serious, Unexpected, Related Case.

" Note:

The SQL should not exceed 2000 characters.

Use the following procedure to Configure the Case Processing Options

1. Select the required option for Display warning when Case Level Assessment does
not match with Event Level Assessment.

2. Select the required option for Criteria for case level causality assessment.

3. Select the required option for Criteria for case level Seriousness determination.
4. Enter the SUSAR Criteria.
5

Click Save to save the changes made.

Configuring Auto Archiving

This screen enables you to configure the auto-archiving. Select System
Configuration > System Management to view the Common Profile
Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

The default rule requires that the following options must be completed before a case is
auto-archived:

* All Action Items Closed

e All Reports Submitted or Marked required for Non-Submission
« All Events are encoded

* All Letters are sent

* All Cases are locked

Apart from this default rule, you can also configure additional rules/criteria for auto-
archiving cases from this screen.
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Workflow State (Configurable by the user) - This option enables you to select Workflow
States. Cases that fall in the specified workflow states can be auto-archived.

Advanced Conditions selection (Configurable by the user) - This option enables you to
specify advanced conditions. Cases that meet the specified advanced conditions, can be
auto-archived.

This feature enables you to define rules for automatically archiving those cases that meet the
defined rules.

To view the list of field names associated with the Case Processing > Auto Archiving
section, click the Auto Archiving folder in the left panel.

The field names associated with Auto Archiving Configuration appear in the right panel.

Field Descriptions

The following table lists the fields available under Auto Archiving Configuration:

Field/Control Name Description

Workflow States The Select button enables you to select workflow states from a list of

workflow states. The selected workflow states are displayed in the text box.
Cases that belong to these workflow states are marked to be auto-archived.

Advanced Condition Enables you to specify advanced conditions for auto-archiving cases. Cases

that meet the advanced conditions are marked to be auto-archived.
Refer to Advanced Conditions for details on creating advanced conditions.

Case Archiving Enables you to enter a pre-defined case close comment, of up to 200
Comment characters. The information entered in this field is displayed in the Case

Routing and Case Archive notes.

Execution Period (in Enables you to define how often the cases will be archived.
Days)

# Note:

You can enter up to 99 days only.
If no value is entered, the cases will not be auto-
archived.

Use the following procedure to configure the auto archiving options

1
2
3.
4

Select the workflow states for auto-archiving cases from Workflow States.
Create the advanced conditions for archiving cases in Advanced Condition.
Enter the Case Archiving Comment as a pre-defined case close comment.

Enter how often the cases will be archived, as per number of days, under Execution
Period.

Click Save to save the changes made.

Configuring Case Numbering

This screen enables you to configure the case processing fields and items for case
numbering. Select System Configuration > System Management to view the
Common Profile Configuration screen.

ORACLE
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Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To view the list of field names associated with the Case Processing > Case
Numbering section, click the Case Numbering folder in the left panel. The field
names associated with Case Numbering appear in the right panel.

Field Descriptions

The following table lists the fields available under Case Numbering Configuration:

Field or Control Description

Name

Date to use for The available options are:

numbering year «  Use initial receipt date of the case entered for the automatic system
placeholder

numbering.
«  Use date on the local machine for the automatic system numbering.

Use the following procedure to configure the case numbering options.

1. Select the required option for Date to use for numbering year placeholder.
2. Click Save to save the changes made.

Configuring Lot Number

A common profile switch determines whether a user can override an un-validated lot
number and enter them in the case form.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

To view the list of field names, go to Case Processing > Lot Number

Processing in the left panel. The field names associated with the Lot Number
appear in the right panel.

The following table lists and describes the fields available under Lot Number
Processing:

Field or Control Description
Name

Allow Users to enter Enables you to select whether or not to allow users to enter non-

non-configured Lot configured lot numbers. Select Yes to allow, and No to diallow.
Numbers

Use Centralized Lot Enables you to select whether or not to allow centralized lot number
Number Validation validation. Select Yes to use, and No to not use this option.
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Field or Control
Name

Description

Lot Number Web
Service Configuration
XML File

Lot Number Web
Service XSLT

Enables you to select and/or edit (if required) the Lot Number Web
Service Configuration XML File. The file path textbox is a read-only
field, which displays the path of the uploaded file. This field stores the
configuration of the Centralized Lot Number Web Service in XML
format. The Edit button is enabled only after the XML file has been
successfully uploaded.

Enables you to select and/or edit (if required) the Lot Number Web
Service XSLT File. This field stores the XSLT associated with the
Centralized Lot Number Web Service. The file path textbox is a read-
only field, which displays the path of the uploaded file. The Edit button
is enabled only after the XSLT file has been successfully uploaded.

Yes is the default. This enables the user to select the options for the Lot Number Validation
as current functionality This message box displays the following message:

No matching lot number was found.

If centralized lot search is used, the system hides the Lookup button since a list is
automatically returned and displayed.

* No: The system does not permit the user to keep the existing value. The user can only
obtain it from a Look up dialog that lists the available Lot Numbers.

* The system hides the Keep button.
A common profile switch determines whether lot validation uses Oracle Argus Safety or a
centralized lot validation.

— No (default): This enables the user to select the options for the Lot Number Validation
as current functionality from within the Oracle Argus Safety Product Families Lot

Numbers.

— Yes: This enables the system to query outside the Oracle Argus Safety system
through a web service return the following parameters for Lot Number Validation

*  Oracle Argus Safety sends the user-entered lot number to central system for
validation/look-up and retrieves a response to act on.

*  The message format for the retrieved lot is as follows:

<Lots>
<Lot>

<Lot Number>: Lot number
<Expiration>: Lot expiration date
<Custom name=name metadata=text>: Custom data to a lot number

* If more than one lot number is returned, the system displays a lot selection dialog.

The Custom Node

* The metadata attribute is as labels in the selection dialog that displays the data. The
name attribute is used to identify the case form field to be populated with the data in the

node.

e Clients can use an XSLT document to map the custom data to case fields present on the
active case form page.

If an error occurs during the web service transaction, a message box will appear with the

proper error message.
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Configuring the Dictionary Browser

This screen enables you to configure the case processing fields and items for
MedDRA Browser.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

A switch in Oracle Argus Safety enables you to use either local MedDRA Coding or
Central System MedDRA Coding (Web Service Method).

* Local (Default): Current functionality of Dictionary browser using Local Dictionary
within the Database.

*  Web Services: Returns the MedDRA hierarchy via the configured Web Services.

This enables the User Local MedDRA if term is not found by Web Service function.

To view the list of field names associated with the Case Processing >
Dictionary Browser section, click the Dictionary Browser folder in the left panel.
The field names associated with Dictionary Browser are in the right panel.

Field Descriptions

The following table lists the fields available under Dictionary Browser Configuration:

Field or Control Description
Name

Term Selection in The available options are:

Dictionary Browser . gelect any term to code if multiple are returned for the search.

e Select the Primary SOC term for encoding if multiple terms are
returned from the search.

Allow User to Add The available options are:
Non-Current o

Case irrespective of Country of Incidence
MedDRA Terms for

Case where Country of Incidence is other than Japan

On change of LLT The available options are Yes or No.
Term Sync English
and Japan LLTs,
irrespective of the
currency

This profile switch is enabled only when the user configures the Allow
User to Add Non-Current Meddra Terms for to Yes.

Use the following procedure to configure the Dictionary Browser.

1. Select the required option for Date to use for numbering year placeholder.
2. Click Save to save the changes made.

Dictionaries
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All dictionaries are stored in database schema separately outside Oracle Argus Safety and
Interchange schema. The Oracle Argus-supported dictionaries are:

e MedDRA

e MedDRAJ
*  WHO Drug
* JDrug

Only one copy of each dictionary version is maintained in the database and it is not
segregated by enterprise. The dictionary version that is applicable for a particular enterprise/
client is defined in these common profile switches: Case Form Configuration > Auto
Encoding, Dictionary & Central Encoding. Since these switches are segregated by each
Enterprise, these dictionaries can have different versions for different enterprises, as
required.J Drug dictionary is not configured through Console common profile switches (Case
Form Configuration > Auto Encoding, Dictionary & Central Encoding), and is internally
maintained as single version, therefore, it remains a common J Drug dictionary for all
enterprises.

Configuring Group Data Access

This screen enables you to configure the case processing fields and items for Group Data
Access.

Field Descriptions

The following table lists the fields available under Group Data Access Configuration:

Field or Control Description
Name
Access on Patient The available options are:
Initials -« Initials part of Patient Details access group
e Initials part of Patient Information access group
Access on Patient The available options are:
DOB - Date of Birth part of Patient Details access group

- Date of Birth part of Patient Information access group
Parent - Initials The available options are:

e Initials part of Parent Details access group
e Initials part of Patient Information access group

Access on Parent The available options are:

DOB - Date of Birth part of Patient Details access group
- Date of Birth part of Patient Information access group

Configuring WHO Drug

ORACLE

Oracle Argus Safety supports WHO-Drug encoding using a locally installed version of the
WHO-Drug dictionary through the WHO-Drug browser.

e A switch in Argus enables you to use either local WHO-Drug Coding or Central System
WHO-Drug Coding (Web Service Method) under the Dictionary browser category.

— Local (Default): Uses the current functionality of WHO-Drug browser that uses the
Local Dictionary in the Database.
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— Web Service: Returns the WHO-Drug fields via the configured Web Services.

— The system enables the User Local MedDRA if term is not found by Web
Service.

Configuring Performance

ORACLE

This screen enables you to configure the case processing fields and items for
performance.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To view the list of field names associated with the Case Processing >
Performance section, click the Performance folder in the left panel. The field names
associated with Performance appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under Performance
Configuration:

Field or Control Description
Name

When to process field Enables you to configure the frequency of field level validation. Select
level validation Only on case save to validate only when a case is saved.

Alternatively, select Every page update to validate fields whenever a
page is updated.

Use Oracle Text for Enables you to select Oracle Text for duplicate search querying. Click

duplicate search Yes to enable this feature.

querying

Refresh Oracle Text Enables you to configure the interval (in minutes) between each

Index interval (in refresh of an Oracle Text Index.

Minutes) This feature is useful while searching for duplicate cases. It is
advisable to enter a high interval for low number of cases and vice
versa.

Start Time for Oracle  Enables you to specify the time when the Oracle text will be refreshed.
Text Refresh

Use the following procedure to configure performance.

1. Select the required option for When to process field level validation, as
applicable.

2. Select the required option for Use Oracle Text for duplicate search querying, as

applicable.
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3. Enter the time difference between each refresh (in minutes), under Refresh Oracle Text
Index interval (in Minutes).

4. Enter the time (in military format) when the Oracle text refresh will begin, under Start
Time for Oracle Text Refresh.

5. Click Save to save the changes made.

Configuring Documentum

The system enables you to configure to choose Document Management from the Common
Profile Switches: Document Management.

ORACLE Welcome crstian, Thursday, March 25, 2021 (ARSPDBSZ3)
| Cotslis | Business Contigwation | s [ Systom Confguation_|_Touls

COMMON PROFILE - Document Management

~ (| Common Login

Usemame [Aominisiatod

Password [

Docbase [sp3docum

Domain [10.17884.167

Enable storage of ICSR reports in Document Repository

[Database

CaHelp

in D t Repository and additionally the searching and attachin
Cabinet Name

Documen it Type

Cabinet Name Reports

Document Type argus_document_typet

*  You may select from the following:

— Documentum: Cabinet Name and Document Type textboxes are only enabled when
the "Documentum” radio option is selected. These text boxes allow upto 255
characters.

 Docbase and Domain are textbox fields. These fields can be a maximum of 255
characters.

*  Configure the following for Document Management:
— EZ2B Reports
— Expedited Paper Reports
— Periodic Reports
— Attachments saved within the cases
— E2B Reports:

* If the E2B switch is enabled and the user transmits an E2B Report (Before submission to
the Gateway), the system stores the E2B XML Message in Documentum.
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When the Report Submission is successful and the report is marked as submitted
in Oracle Argus Safety, the system updates a flag in the Documentum database to
designate the same.

Expedited Reports

If the Expedited switch is enabled and the user submits an expedited report,
the Oracle Argus Safety Service inserts the report into Documentum as a PDF
file.

When the Report Submission is successful and the report is marked as
submitted, the system updates a flag in the Documentum database to signify
the same.

Periodic Reports:

If the Periodic Switch is enabled and a Periodic Report is approved in Argus,
an Argus Safety Service exports the report as a PDF file and saves it in the
Documentum database.

When the Report Submission is successful and the report is marked
submitted, the system updates a flag in the Documentum database to indicate
the same.

Attachments:

When this switch is enabled, a new button is available on the Argus
Attachments screen, LAM Attachments Section label Attach Documentum
Link.

The Argus Bookin dialog has an additional drop down option for attaching to
Documentum.

When the Links Switch is enabled, the system stores all Argus Attachments in
the Documentum database.

Clicking the Attach Documentum Link button opens a search dialog to enable
the user to search the Documentum database for a document. This document
is then linked as an attachment within Oracle Argus Safety.

When the user clicks the Attach Documentum Link button, the following
occurs:

The system presents a search dialog to enable the user to search for a
document in the Documentum database.

The user must select a Table to Search. This list is a distinct Table List from
the Documentum_table_info Table.

After the user selects a Table, the system populates the Column drop down
with all the columns available for that table based on configuration from the
same table.

When the user selects the Full Search option, the system performs a like
search in Documentum.

If LDAP is enabled, the system automatically send the login information from
Oracle Argus to Documentum.

After selecting a document from the Search results, the system saves the URL for
the Oracle Argus attachment.

If the user clicks the URL, Oracle Argus automatically opens the document from
Documentum.
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»  Oracle Argus refers to two (2) that enables you to specify which tables/columns can be
searched in Documentum and which Table Fields to display in the Search Results.

— documentum_table_info - This table holds the table or fields the user will be able to
search.
Type_Name - Table to Search.

Attribute_Name - Field in the Table to Search.
Attribute_Type - Type of field being searched.

— Documentum_display_info - This table stores the Return Search Parameters.
Type_Name - Table to Search.

Attribute_Name - Field in the Table to Search.
Sort_Id - The order in which the fields will be displayed.

— The Document Management (Central or Documentum) database gets a new
document each time a document attachment is added as a new attachment. Existing
documents are modified for changes.

— The system does not create a new document in the Document Management (Central
or Documentum) database each time a case /event is saved in Oracle Argus Safety
or Oracle Argus Affiliate.

— When cases are copied, the document copy has the same DOC ID (Object ID) as the
original case. If the Document is modified after the cases are copied, the system gets
a new DOC ID only for the case attachments that were modified.

— Theicon is similar to the Additional Info requirements for attachment types.

— When the user clicks the attachment to open it, the system retrieves the attachment
from Documentum.

— When events from the Oracle Argus Affiliate are accepted in Oracle Argus Safety as
Argus cases, the system keeps the DOC ID(Object ID) from the Affiliate Event.

— Attachments can be entered to the case / affiliate event via
Affiliate Events

Bookin in Argus or Affiliate
Case Form / Affiliate Event Form
Intake WL

e Error Messages

— If the system cannot connect to the document system, it displays the following
message:

Oracle Argus was unable to connect to the document management system. Please
contact your Administrator for more details.

— If the document system does not return any rows, the system returns a dialog with
the message: No documents returned.

— Select System Configuration > System Management to view the Common
Profile Configuration screen.

ORACLE 5-37



Tip:

Chapter 5
Configuring System Management - Common Profile Switches

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To view the list of field names associated with the Case Processing >
Documentum section, click the Documentum folder in the left panel. The field names
associated with Documentum appear in the right panel.

Field Descriptions

The following table lists the fields available under Documentum Management:

Section

Field and their Description

Common Login

Enable Storage of E2B Reports
in Document Repository

Enable Storage of submitted
expedited reports in Document
Repository

Enable storage of case
attachment files in the
Document Repository

Enable storage of submitted
periodic reports in the
Document Repository

Use Common Login Password - Users use a common
login password to access the system.

Docbase - The name of the document database.
Domain - The name of the domain where the database
resides.

Documentum - Enables the system to store E2B reports
in the document repository.

Argus (Default) - Enables the system to store E2B
reports in the Argus document repository.

Cabinet Name - The storage location of the E2B reports.
Document Type - The type of document that is being
stored.

Documentum - Enables the system to store submitted
expedited reports in the Documentum document
repository.

Argus (Default) - Enables the system to store submittedd
expedited reports in the Argus document repository.
Cabinet Name - The storage location of the submitted
expedited reports.

Document Type - The type of document that is being
stored.

Documentum - Enables the system to store case
attachment files in the Documentum document
repository.

Argus (Default) - Enables the system to store case
attachment files in the Argus document repository.
Cabinet Name - The storage location of the case
attachment files.

Document Type - The type of document that is being
stored.

Documentum - Enables the system to store submitted
periodic reports in the Documentum document
repository.

Argus (Default) - Enables the system to store submitted
periodic reports in the Argus document repository.
Cabinet Name - The storage location of the submitted
periodic reports.

Document Type - The type of document that is being
stored.

ORACLE
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Use the following procedure to configure Documentum:

1. Select the Common Login to configure the login for the user.

2. Select the option for Enable Storage of E2B Reports in Documentum.

3. Select the option for Enable Storage of submitted expedited reports in Documentum.
4

Select the option for Enable storage of case attachment files in Documentum and
additionally the searching and attaching files already existing in Documentum to a case.

o

Select the option for Enable storage of submitted periodic reports in Documentum.

6. Click Save to save the changes made.

Local Labeling

ORACLE

This section enables you to configure the common profile switches for Local Labeling and
includes discussions of the following:

e Configuring Local Labeling
e Configuring Local Labeling LAM

Configuring Local Labeling

The Local Labeling Configuration screen enables you to modify the options available through
local labeling. Select System Configuration > System Management to view the
Common Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To configure the fields associated with the Local Labeling section, click the Local Labeling
folder in the left panel. The configurable fields associated with Local Labeling appear in the
right panel.

Field Descriptions

The following table lists and describes the fields available under Local Labeling:

Field or Control Description

Name

Number of Cases This field enables the user to configure the number of cases that are returned
returned in local in the local labeling dialog.

labeling dialog: default gxample: If the value is entered as 20 then 20 cases are returned in the local
X labeling dialog.

Action to be taken The available options are :
after timeout . Discard
e Submit
Timeout for This field enables the user to enter the minutes after which the time-out for
assessment data lock assessment data lock is applicable.
(in minutes)
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Use the following procedure to configure local labeling

1. Enter the number in Number of Cases returned in local labeling dialog: default.
2. Select the option for Action to be taken after timeout.

3. Enter the value in minutes for Timeout for assessment data lock (in minutes).
4. Click Save to save the changes made.

Configuring LAM

The Local Labeling LAM Configuration screen enables you to modify the options
available through local labeling for LAM.

Field Label Updates

The Argus Console Field Labels option enables the user to modify the field labels for
the Argus Affiliate Event Information form.

* The existing Argus fields are under the Oracle Argus Safety folder structure.

* Please refer to the tables in the LAM Information section for the details about the
Help Text for the fields.

e The system enables the user to hide the field on the LAM form.
e The system prints the Oracle Argus Affiliate field labels.

e The system tracks all field label updates in the audit log.

Field Validation Updates

Oracle Argus Affiliate enables the user to configure Validations for Mandatory and
Warning for the LAM Event fields.

* The existing Argus fields are under the Oracle Argus Safety folder structure.
» Refer to the table for LAM Event Info for the fields in the Field Validations.

* The Oracle Argus Affiliate fields for advanced conditions are only visible for field
validations. They are not visible to the rest of the application.

e The system prints the information for the configured field validations.
* The system tracks all updates to field validations in the audit log.

*  The system displays the standard Justifications dialog to enable the user to enter
the justifications for overriding the warnings, but does not permit the user to save
the case for a mandatory error.

Select System Configuration > System Management to view the Common
Profile Configuration screen

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Local Labeling LAM section, click the Local
Labeling folder in the left panel. The LAM sub-folder is displayed in the left panel.
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Click LAM sub-folder to configure the LAM options. The configurable fields associated with
Local Labeling Lam appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under Local Labeling LAM:

Field or Control Name

Description

Report Scheduling when Labeling
Changes from the Local Labeling
Screen

Re-evaluate all scheduled and
generated reports related to a case
when the labeling is changed from
the Local Labeling dialog

Report Scheduling for LAM

The available options are:

e Report Scheduling will not be executed when the Local
Labeling is changed.

*  Report Scheduling will occur for those Licenses where the
Labeling has changed.

*  When this common profile switch is set to 1 (one), local
labeling is done by AG Service and the AG Service locks
the case before doing anything.

*  When this common profile switch is set to 0 (zero), local
labeling is done live and it does not go through AG Service.
In this scenario, the case is not locked.

The available options are:

e The system will not re-evaluate generated reports.

* Re-evaluate general reports.

The available options are:

*  Perform live scheduling on screen.

e Perform scheduling using AG service.

*  When this common profile switch is set to 1 (one), local
labeling is done by AG Service and the AG Service locks
the case before doing anything.

*  When this common profile switch is set to O (zero), local
labeling is done live and it does not go through AG Service.
In this scenario, the case is not locked.

Use the following procedure to configure local labeling for LAM.

1. Select the option for Allow hiding of the Local Labeling dialog from Users.

2. Select the option for Report Scheduling when Labeling Changes from the Local Labeling

Screen.

3. Select the option for Re-evaluate all scheduled and generated reports related to a case
when the labeling is changed from the Local Labeling dialog.

4. Click Save to save the changes made.

Network Settings

The settings for Proxy set up can be configured under Network Settings > Proxy.

The following table lists the fields available:

ORACLE
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Configuration
Parameter

Valid Values and Description

SSLStartMode

(Determines how the
component starts the
SSL negotiation.)

Auto Detect Proxy

Proxy Type Determines
the type of Proxy to
connect through

Proxy Host Holds the
Name or IP address of
Proxy serve

Proxy Protocol Holds
the HTTP_PROTOCOL
component of Proxy

URL. Maximum length is

20 characters.

Proxy Port TCP Port for
the Proxy Host

Proxy Domain/
UserName

Proxy Password

Use Proxy settings for
ESM DTD Validation

Use Proxy settings for
SMTP/S

Automatic—If the remote port is set to the standard plain text port of
the protocol (where applicable), the class will behave the same as
when SSLStartMode is set to sslExplicit. In all other cases, SSL
negotiation will be implicit (sslimplicit).

Implicit—The SSL negotiation starts immediately after the connection
is established.

Explicit—The class first connects in plaintext, and then explicitly
starts SSL negotiation through a protocol command such as
STARTTLS.

None (Default)—No SSL negotiation, no SSL security. All
communication will be in plaintext mode.

Checking this field lets the application detect the proxy automatically
if applicable.

None - No proxy (Default)

Tunnel - Connect through a tunneling proxy. ProxyPort is set to 80

SOCKS4 - Connect through a SOCKS4 Proxy. ProxyPort is set to
1080

SOCKSS5 - Connect through a SOCKS5 Proxy. ProxyPort is set to
1080

If the Proxy Host is specified, this property along with Proxy
Password is used to connect and authenticate to the given Proxy
Server.

If the Proxy Host is specified, this property along with Proxy Domain/
UserName is used to connect and authenticate to the given Proxy
Server. This field expects the password to be in encrypted state, use
Cryptography Key Editor to encrypt the password.

Checked (Enabled by default)

Unchecked

Enables or disables the usage of Proxy settings for ESM.
Checked

Unchecked (Disabled by default)

Enables or disables the usage of Proxy settings for SMTP/S.

User Interface

This section enables you to configure the common profile switches for User Interface.

Configuring User Interface
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The User Interface Configuration screen enables you to configure the user interface, as per
the options available. Select System Configuration > System Management to view
the Common Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To configure the fields associated with the User Interface section, click the User Interface
folder in the left panel. The configurable fields associated with User Interface appear in the
right panel.

Configuring Reporting

ORACLE

The Reporting Configuration screen enables you to modify the options available for reporting.
Select System Configuration > System Management to view the Common Profile
Configuration screen

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To configure the fields associated with the Reporting section, click the Reporting folder in the
left panel. The configurable fields associated with Reporting appear in the right panel.

Field Descriptions

The following table lists the fields available under Reporting:

Field or Control Name Description

Allow User to regenerate reports The available options are Yes and No.

Determine the minimum length of the  The available options are:
routing comment text length on report

' : No routing comment will be required
routing dialog

*  Minimum length of text required

Use the following procedure to configure reporting.

1. Select the option for Determine the minimum length of the routing comment text length on
report routing dialog.

2. Enter the numeric value in the Minimum length of text required text-box, if applicable.
3. Click Save to save the changes made to this screen.

Configuring E2B
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This screen enables you to configure the E2B fields and items for E2B. Select System
Configuration > System Management to view the Common Profile

Configuration screen

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To view the list of field names associated with the E2B section, click the E2B folder in
the left panel. The field names associated with E2B appear in the right panel.

Field Descriptions

The following table lists the fields available under E2B:

Field or Control
Name

Description

Auto Accept Notes

Blind status during
E2B report
generation

Default DTD
Default view for
E2B(R3)

Default viewing
format of the E2B
report (used in
E2B(R2) reports)

Default viewing

format of the E2B(R3)

report

Drug assessment
method (used by
E2B/Interchange
module)

File attachments
allowed for ICH
E2B(R3) Profile

File attachments
allowed for EMA
E2B(R3) Profile

File attachments
allowed for MFDS
E2B(R3) Profile

Enables you to enter notes (up to 190 characters). It is required for
these notes to be entered for the acceptance of the E2B. The notes
entered here, are automatically provided during E2B acceptance.
The available options are:

e Blinded

e Unblinded

Enables you to select the Default DTD from the drop-down list box.

Specifies the default view of E2B(R3) reports in the ICSR viewer.
Decoded, HL7, and XML are the available options.

The available options are:

. SGML

+ CIOMS

. MEDWATCH

. DECODED VIEW

The default viewing format of the E2B(R3) report will be applicable to
MFDS E2B(R3) and NMPA E2B(R3) reports.

Enables you to incorporate the drug assessment method used by E2B/
Interchange module.

Verifies the applicable files that can be attached with an E2B(R3) report
generated using the ICH profile.

Verifies the applicable files that can be attached with an E2B(R3) report
generated using the EMA profile.

Verifies the applicable files that can be attached with an E2B(R3) report
generated using the MFDS profile.
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Field or Control Description
Name
File attachments Verifies the applicable files that can be attached with an E2B(R3) report

allowed for NMPA generated using the NMPA profile.
E2B(R3) Profile

Onset Date Enables you to configure if the onset date is to be calculated based on
Calculation any suspect drug or on the primary suspect drug only.

Send E2B nullification Enables you to send an E2B nullification report. You can select whether
report to automatically schedule it or to not send the report.

Enable stripping of Enables you to strip line break characters in encoded attachment data.
line breaks in The parameter applies only to the EMA E2B(R3) Profile and has 'Yes'
attachment data for ~ and 'No' values. The default value is 'Yes'.

EMA E2B(R3) profile

Regional Drugs Enables you to select one from a drop-down list. The list values will
Dictionary emulate the WHO dictionaries listin Case Form Configuration
> Drugs drop-down.

Use the following procedure to configure E2B:

1. Enable the check-box option for Drug assessment method (used by E2B/ESM
modaule), if required.

2. Select the option for Blind status during E2B report generation.
3. Select the option for Perform length check of Argus fields against E2B standard.

4. Select the option for Default viewing format of the E2B report (used with Electronic
Submission Module (ESM)).

5. Select the option for Default DTD.
6. Select the required radio button under Onset Date Calculation, as applicable.

7. Enter the comments for the automatically generated notes, when an E2B is accepted,
under Auto Accept Notes.

8. Click Save to save the changes made to this screen.

Configuring eMDR

The eMDR Reporting Configuration screen enables you to modify the options available for
eMDR reporting.

Select System Configuration > System Management to view the Common Profile
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting folder in the
left panel. The eMDR sub-folder is displayed in the left panel. Click this sub-folder to
configure the reporting options. The configurable fields associated with eMDR appear in the
right panel.

Field Descriptions

The following table lists and describes the fields available under eMDR:
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Field or Control Name Description
Default Timeframe for draft Displays a time frame that the Draft report generation required
eMDR generation for populating G7 (gtypeofreport). Without this information,

eMDR throws a validation error and the report cannot be
generated. The default setting for this parameter is 5. The
allowed values for this parameter are 5, and 30. Based on the
value entered, the corresponding NCI code is populated for
data element Type of Report (G7) in eMDR.

File attachments allowed for Verifies the files that are attached to an eMDR. Only
eMDR configured file types are allowed to be attached to an eMDR.

Default view for eMDR Specifies the default view of eMDR in ICSR viewer.

Configuring eVAERS

The eVAERS Reporting Configuration screen enables you to modify the options
available for eVAERS reporting.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The eVAERS sub-folder is displayed in the left panel.

Click this sub-folder to configure the reporting options. The configurable fields
associated with eVAERS appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under eVAERS:

Field or Control Description

Name

Default view for Enables you to select either XML View or HL7 view as the default view
eVAERS for eVAERS.

File attachments Enables you to specify the types of files which are allowed as

allowed for eVAERS  attachments for eVAERS.

Allowed file size for Enables you to specify the maximum file size (in MB) allowed in
eVAERS (in MB) eVAERS.

Expedited Reports Configuration

The Expedited Reporting Configuration screen enables you to modify the options
available for expedited reporting. When configuring expedited reporting rules, be
aware of the following:
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» If the user does not have permission to access Advanced Conditions on the Expedited
Reporting Rules, the system does the following:

— Displays the advanced condition name instead of displaying a blank.
— Does not permit the user to modify or view advanced condition details.
— Disables the Adv Condition button.

* The system enables you configure the Blinding Study Products option for those
included in the case (default unchecked).

— The system track updates to this field in the audit log.
— The Reporting Rules reports print the new options

» For cases where expedited reports are due, you can force-distribute expedited reports
even if processing is incomplete.

»  The reporting rules have a Forced Distribute XXX days before due check box. The
default is unchecked.

— If you checks the Force Distribute option, the # of days before due field is entered
and automatically checks the Auto Distribute check box on the reporting rule
(grayed out).

— You can enter the number of days from 0 - # of days defined within the time frame.

— If you enters a value greater than the defined time frame, the system displays the
following message: Please enter a value less than the Time Frame
defined for the Reporting Rule.

— If you has not checked Force Distribute, the system disables the days before due.
e The system tracks updates made to the new Argus Console fields in the audit log.
* The system prints the new fields on the Reporting Rules report.

Select System Configuration > System Management to view the Common Profile
Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To configure the fields associated with the Reporting section, click the Reporting folder in the
left panel. The Expedited sub-folder opens in the left panel.

Click the Expedited sub-folder to configure the expedited reporting options. The configurable
fields associated with Expedited Reporting open in the right panel.

Field Descriptions

The following table lists and describes the fields available under Expedited Reporting:
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Field or Control Name

Description

Active moiety report scheduling evaluation
(a report scheduled against a product/
license that shares ingredients with a
product in a case)

Allows Bulk Reporting screen to show
Unlocked Cases for Final Report

Allows Bulk Reporting screen to show
Generated Reports Only

Nomenclature System on EU Device
Vigilance Form

Default name of Regulatory Agency for
Draft Expedited English Reports

Text to display as comment when a
downgrade report is scheduled

Auto Distribution Transmission Comments

Auto Distribution Submission Comments

Print Case Version of Expedited Reports
(x.y.2)

SQL mapping for CIOMS/CERFA/MHRA
Spontaneous/EU EMEA Spontaneous/
Spanish Clinical/Spanish Spontaneous
Literature Report Source (Parameters:
P_CASE_ID)

The available options are:

Enable
»  Disable (default)

The available options are:

*  Report by Form and Bulk Report By Case will
filter final reports by Locked Cases only

*  Bulk Report By Form and Bulk Report By
Case will allow selection of unlocked cases to
be submitted as Final

Enables the administrator to allow the Bulk
Reporting screen to display only the generated
reports.

Nomenclature system (Preferable GMDN)" box of
EU Device Vigilance Form. By default, this
common profile switch is set to 'GMDN'.

This enables you to select the Default Name of the
Regulatory agency from the drop-down list.

This enables you to enter the text to display when
a downgrade report is scheduled.

Enables you to enter transmission comments of up
to 2000 characters, for Expedited Reports
Transmission.

These comments are auto-distributed, based on
Expedited Reporting Rules or Reporting
Destinations.

Enables you to enter submission comments of up
to 2000 characters, for Expedited Reports
Transmission.

These comments are auto-distributed, based on
Expedited Reporting Rules or Reporting
Destinations.

This switch enables you to enable or disable the
printing of the case version of expedited reports.

For more details on the default mapping, refer to
the Mapping Document.

5-48



ORACLE

Chapter 5
Configuring System Management - Common Profile Switches

Field or Control Name

Description

Allow Generation of report

If you select Only when previously scheduled
reports are submitted or marked for
"submission not required" (default), the system
retains the existing check for the previous reports
that are in the Submission decision complete
state. For example, the previous report has been
either marked as Submitted or as Submission
not required before a report can be generated.

When the Even when previously scheduled
reports are neither submitted nor marked for
"submission not required” option is selected
and the Create as Follow-up option is selected in
Argus Console > System Configuration > System
Management (Common Profile Switches) > Case
Form Configuration > Report Generation section,
the system removes the existing check for the
previous reports that are in a Submission
decision complete state. For example, the
previous report has been either marked as
Submitted or as Submission not required and
the report can be generated irrespective of the
previous report state (Generated, Approved, New
Data Available states).

< Note:

When a previous
reportisin a
Deleted state, it can
be removed on
subsequent case
save and the current
report can be
generate.

When a previous
report is set to the
Disapproved state,
no further follow-ups
are scheduled.

When a previous
report is set to the
No Longer
Required state,
Only when
previously
scheduled reports
are submitted or
marked for
“submission not
required” option
determines you to
mark the report to
Submission not
required to generate
the current report.
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Field or Control Name

Description

Even when
previously
scheduled reports
are neither
submitted nor
marked for
"submission not
required" option lets
you generate the
current report, but
the change to the No
Longer Required
state of the previous
report does not
determine you to
mark the report for
Submission not
required.

Note:

When you generate
a report while the
previous report is
waiting a submission
decision, the initial or
follow-up sequence
numbering in the
Regulatory
Reporting tab does
not synchronize
consistently with the
report type data
output within the
report itself (for
example, Type of
Report/G7 in
Medwatch).

Use the following procedure to configure expedited reports.

1. Select the option for Active moiety report scheduling evaluation (a report
scheduled against a product/license that shares ingredients with a product in a

case).

2. Select the option for enables Bulk by Form to show Unlocked Cases for Final

Report.

3. Select the option for Default name of Regulatory Agency for New Draft
Expedited Reports from Analysis Tab of the Case Form from the drop-down text-

box.
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4. Enter the text in the Text to display as comment when a downgrade report is scheduled
text-box, if applicable.

5. Enter the transmission comments in Auto Distribution Transmission Comments.
6. Enter the submission comments in Auto Distribution Submission Comments.

7. Select whether to enable or disable printing the case version of expedited reports in Print
Case Version of Expedited Reports (x.y.z).

8. Click Save to save the changes made to this screen.

BIP Reporting

Oracle Argus Safety uses the Bl Publisher reporting technology for the PMDA (R3) Paper
reports and Flexible Aggregate reports (DSUR, PBRER and PMAR). This screen contains the
common fields that are needed for integrating the Bl Publisher server with Argus Safety.

Select System Configuration > System Management to view the Common Profile
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting folder in the
left panel. The BIP Reporting sub-folder is displayed in the left panel.

Click this sub-folder to configure the reporting options. The configurable fields associated with
BIP Reporting appear in the right panel.

Field Descriptions

The BIP Reporting fields are grouped into Common and Aggregate reporting.The following
table lists and describes the fields available under these sections:

Common

The fields under this section are common to both PMDA (R3) Paper Reports and Flexible
Aggregate Reporting. These fields are critical to authenticate Oracle Argus Safety with Bl

Publisher.

Field or Control Description

Name

BIP Common User Enables you to enter the name of the BIP common user.
BIP Common User Enables you to enter the password of the BIP common user.
Password

Aggregate Reporting

The fields under this section are applicable only to Flexible Aggregate Reports.

Field or Control Description
Name
Persist data in BIP Enables you to select whether to persist data in BIP Aggregate Temporary

Aggregate Temp Tables Tables.
The available options are:
* Yes
* No
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Field or Control Description

Name

Number of days for Enables you to specify the number of days for which data in BIP Aggregate
which data of BIP Temporary Tables should be persisted.

Aggregate Temp Tables
should be persisted

Expedited BfArM Reports Configuration

The Expedited BfArM Reporting Configuration screen enables you to modify the
options available for expedited BfArM reporting.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited- BfArM sub-folder is displayed in the left panel.

Click the Expedited-BfArM sub-folder to configure the expedited BfArM reporting
options. The configurable fields associated with Expedited - BfArM Reporting appear
in the right panel.

Field Descriptions

The following table lists and describes the fields available under Expedited - BfArM
Reporting:

Field or Control Description
Name

Causality Value on The available options are:
BfArM Report . beh.Azrt

. Hersteller
¢ Arznel.Komm

Value of field The available options are:

"Grunderkrankung” . pg not output suspect and concomitant product indication in this
on the BfArM/PEI field

form

e Output additional suspect and concomitant product Events &
Indications.

Use the following steps to configure the expedited BfArM reports.

1. Select the option for Causality Value on BfArM Report.

2. Select the option for Value of field Grunderkrankung on the BfArM/PEI form.
3. Click Save to save the changes made to this screen.

Expedited Canada Reports Configuration

The Expedited Canada Reporting Configuration screen enables you to modify the
options available for expedited Canada reporting.

Select System Configuration > System Management to view the Common
Profile Configuration screen.
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The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels

To configure the fields associated with the Reporting section, click the Reporting folder in the
left panel. The Expedited- Canada sub-folder is displayed in the left panel.

Click on the Expedited-Canada sub-folder to configure the reporting options. The
configurable fields associated with Expedited - Canada Reporting appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under Expedited- Canada

Reporting:

Field or Control Name

Description

SQL used to populate the "Health Canada
assigned company identification number"
field on the Canadian Device report form

SQL used to populate the "Establishment
License Number" field on the Canadian
Device report form

SQL used to populate the "Device
Identification No" field on the Canadian
Device report form

SQL used to populate the "Age of Device"
field on the Canadian Device report form

SQL used to populate the "How long was
the device in use?" field on the Canadian
Device report form

Offset from GMT used to calculate
Canada date/time fields (in hours)

SQL used to populate the "If "preliminary"
only, anticipated date for the final report"
field on the Canadian Device report form

SQL used to populate the "Name of
Health Care Facility” field on the Canadian
Device report form

SQL used to populate the "Name and
Address for Manufacturer(A7)" field on the
Canadian Device report form

SQL used to populate the "Is there a new
drug submission for this drug under review
in Canada" field on the Canadian
Expedited ADR report form

SQL used to populate the "Is there a
clinical trial application for this drug under
review in Canada" field on the Canadian
Expedited ADR report form

ORACLE

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This switch enables the GMT offset to the Submitted dates
getting printed in Canadian Device Form.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.

This field enables you to enter the associated SQL syntax.
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Field or Control Name Description

SQL used to populate the "Is there an This field enables you to enter the associated SQL syntax.
ongoing clinical trial for this drug in

Canada" field on the Canadian Expedited

ADR report form

SQL used to populate the "Report ADR This field enables you to enter the associated SQL syntax.
occurred in Phase I-1V Study" field on the
Canadian Expedited ADR report form

SQL used to populate the "Report ADR This field enables you to enter the associated SQL syntax.
occurred in Phase I-Ill Study" field on the
Canadian Expedited ADR report form

Use the following procedure to configure Expedited Canada reports.

1. Enter the SQL syntax for SQL used to populate the "Is there an ongoing clinical
trial for this drug in Canada" field on the Canadian Expedited ADR report form.

2. Enter the SQL syntax for SQL used to populate the "Is there a clinical trial
application for this drug under review in Canada" field on the Canadian Expedited
ADR report form.

3. Enter the SQL syntax for SQL used to populate the "Is there a new drug
submission for this drug under review in Canada" field on the Canadian Expedited
ADR report form.

4. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in
Phase I-Ill Study" field on the Canadian Expedited ADR report form.

5. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in
Phase I-IV Study" field on the Canadian Expedited ADR report form.

6. Click Save to save the changes made to this screen.
Expedited CIOMS Reports

The Expedited CIOMS Reporting Configuration screen enables you to modify the
options available for expedited CIOMS reporting. Select System Configuration >
System Management to view the Common Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel.

The Expedited- CIOMS sub-folder is displayed in the left panel. Click the Expedited-
CIOMS sub-folder to configure the expedited CIOMS reporting options.

The configurable fields associated with Expedited - CIOMS Reporting appear in the
right panel.

Field Descriptions
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The following table lists the fields available under Expedited- CIOMS Reporting:

Field or Control Name

Description

CIOMS Form Selection

CIOMS report format to use

Print Patient ID, Study ID, Center ID in 26.
REMARKS section of the CIOMS form

Print Medically Confirmed in the 26.
REMARKS section of the CIOMS form

Print World Wide Number in the 26.
REMARKS" section of the CIOMS form

This enables you to select the CIOMS form to be used
across the application for Expedited Reporting / Periodic
Reporting.

The available options are:

e  Standard

e Custom

When Custom is selected, a second version of the

CIOMS form is used. This form is almost identical to the
Standard form.

The only difference is that the Custom form includes
superscripts in the label text for boxes 15, 16, 18 and 19.
The superscript is simply an asterisk (*) to draw the
user's attention to the following footnote also included in
the Custom form:

*Boxes 15, 16, 18, and 19 on page 1 contain first dose
regimen information for suspected product #1 and #2.
Suspected Drug(s) information is continued on Additional
Information page, if applicable.

Thus, the Custom form simply provides you the option to
clearly identify fields that have overflow information on
the Additional Information page.

Enables you to print the Patient ID, Study ID and Center
ID fields in the "26. REMARKS" section of the CIOMS
form.

Enables you to print Medically Confirmed in the 26.
REMARKS section of the CIOMS form.

Enables you to print World Wide Number in the "26.
REMARKS" section of the CIOMS form.

Use the following procedure to configure the expedited CIOMS reports.

1. Select the Print Patient ID, Study ID, Center ID in the "26. REMARKS" section of the
CIOMS form checkbox to print these fields in the CIOMS form.

2. Select the Print Medically Confirmed in the "26. REMARKS" section of the CIOMS form
checkbox to print this field in the CIOMS form.

3. Select the Print World Wide Number in the "26. REMARKS" section of the CIOMS form
checkbox to print this field in the CIOMS form.

4. Select the option for CIOMS report format to use.

5. Select the relevant CIOMS form, from CIOMS Form Selection.

6. Click Save to save the changes made to this screen.

Expedited MedWatch Reports Configuration

The Expedited MedWatch Reporting Configuration screen enables you to modify the options
available for expedited MedWatch reporting.

Select System Configuration > System Management to view the Common Profile

Configuration screen.
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Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited- MedWatch sub-folder is displayed in the left
panel.

Click the Expedited-MedWatch sub-folder to configure the expedited MedWatch
reporting options. The configurable fields associated with Expedited - MedWatch
Reporting appear in the right panel.

Field Descriptions

The following table lists the fields available under Expedited- MedWatch Reporting:

Field or Control Name Description

Value for Field E4 on MedWatch Select the applicable value from the available options.
Data to print on follow up The available options are:

MedWatch Device form - Allinformation (initial and follow-up) is displayed.

(Previous Behaviour).
e Only Display changed information from the initial
report.
Number from This field enables you to select the required option from
LM_REF_TYPES.REF_TYPE_ID the drop-down list.
for Reference Type containing
Legacy Case Number (to print
MedWatch forms)

SQL used to print the BLA # Enables you to enter the SQL query used to print the
BLA#.

SQL used to print Unique Identifier Enables you to enter the SQL query used to print the
(UDI #) in MedWatch Device Form  UDI# in MedWatch Device Forms.
License number on MedWatch Drug The available options are:

Report »  Print License # only for the scheduled license on
MedWatch Drug Report
e Print all available license numbers for Drug as
determined by the scheduled license

License number on MedWatch Drug This field enables you to select the option for License

Report number on MedWatch Drug Report.

SQL mapping for MedWatch SQL mapping for the field: "This type includes cases from
Literature Box 3. Report Source literature" for MedWatch.

(Parameters: P_CASE_ID) For more details on the default mapping, refer to the

Mapping Document.

Value for Field G8 on MedWatch Select the applicable value from the available options.

Use the following procedure to configure expedited MedWatch reports.

1. Select the option for the Value for Field E4 on MedWatch.

2. Select the option for the Data to print on follow up MedWatch Device form.
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3. Select the required option for Number from LM_REF_TYPES.REF_TYPE_ID for
Reference Type containing Legacy Case Number (to print MedWatch forms) from the

drop-down list box.

4. Select the option for License number on MedWatch Drug Report.

5. Add an SQL for BLA# and UDI#, if there is a need to change the default logic for these

fields in MedWatch report.

6. Click Save to save the changes made to this screen.

Configuring MedWatch

The MedWatch Configuration screen enables you to modify the customizable fields on the
MedWatch form. Select System Configuration > System Management to view the
Common Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To view the list of field names associated with the MedWatch Configuration section, click the
MedWatch Configuration folder in the left panel.

The field names associated with MedWatch Configuration appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under MedWatch Configuration:

Field or Control Name

Description

Firm Name as it Should Appear at
the Top of Each Page

Use Manufacturer of the License
Used for Report scheduling

Date of FDA Approval to Appear on
the First Page

Disclaimer to appear at the Bottom
of the First Page

Default text to appear on Block H10

Address to be printed at the bottom
of Second page of MedWatch
Device Form

Reset MedWatch Numbering

Enables you to enter the name of the reporting firm on the
MedWatch form.

Enables you to use the manufacturer of the license that was used
for report scheduling, by checking this checkbox.

Enables you to enter the FDA approval date of the manufacturer.

Enables you to enter a brief disclaimer.

Enables you to enter default text.

Enables you to enter the address to be printed at the bottom of
Second page of MedWatch Device Form.

The default address is as follows:

Department of Health and Human Services

Food and Drug Administration

Office of Chief Information Officer

Paperwork Reduction Act (PRA) Staff

PRAStaff@fda.hhs.gov

Enables you to reset the sequence number that appears on the
MedWatch form for the manufacturer.
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Field or Control Name Description

Mfr. Site FDA Number Displays the FDA number for the Manufacturer Site which
submitted the MedWatch 3500 Device report in the year.

Year Displays the year of report submission.

# of Reports Displays the number of submitted reports for products associated

with a Manufacturing Site in that year.

Reset Number Enables you to reset the Sequence Number.

Use the following procedure to configure the MedWatch form options.

Enter the Firm Name as it Should Appear at the Top of Each Page.
Enter the Date of FDA Approval to appear on the first page.
Enter the Disclaimer to appear at the bottom of the first page.

Enter the Default text to appear on Block H10.

@ H w0 d P

Click Reset MedWatch Numbering to reset the sequence number that appears
on the MedWatch form, for the manufacturer as required.

Periodic Reports Configuration

The Periodic Reporting Configuration screen enables you to modify the options
available for periodic reporting.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Periodic sub-folder is displayed in the left panel.

Click the Periodic sub-folder to configure the periodic reporting options. The
configurable fields associated with Periodic Reporting appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under Periodic Reporting:

Field or Control Name Description

Determine Primary Event for use  The available options are:
in ICH PSUR/CTPR report «  Primary Event (Left Most Diagnosis or the left-most
Event if there is no Diagnosis on the Case Form).

*  Most severe event for the product (First left most
Diagnosis Related Serious Event with most weight on
Diagnosis then relatedness and then seriousness).
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Field or Control Name Description

Listedness grouping logic for ICH  The available options are:

PSUR/CTPR report output «  Primary Event (refer to Inclusion criteria of event for a
product in the PSUR/CTPR switch).
e Case level Listedness

Seriousness grouping logic for The available options are:

ICH PSUR/CTPR reportoutput . primary Event (refer to Inclusion criteria of event for a
product in the PSUR/CTPR switch).
e Case level seriousness

Inclusion Criteria for cases in the  The available options are:

ICH PSUR/CTPR report «  Evaluate seriousness, listedness, relatedness, fatal
across all diagnoses/events against product
When this option is selected, the case inclusion
criteria logic in ICH PSUR/CTPR scans all the
diagnoses in the case and matches all the
Seriousness, Listedness, Relatedness, Fatal values
for the diagnosis in the case against the product(s) for
which the report is being run, with the corresponding
values selected by you in the Report configuration.

When there are no diagnosis in the case, the system
scans all the events in the case and matches all the
Seriousness, Listedness, Relatedness, Fatal values
for the events in the case against the product(s) for
which the report is being run, with the corresponding
values selected by you in the Report configuration.

When multiple products are configured in the report, a
match of all the Seriousness, Listedness, Relatedness
and Fatal values against even one product-diagnosis
is considered as a match for including the case.

e Evaluate case inclusion based on following
seriousness, listedness, causality option groups -
Case Inclusion criteria for the ICH PSUR/CTPR report
based on Seriousness OR Case Inclusion criteria for
the ICH PSUR/CTPR report based on Causality OR
Case Inclusion criteria for the ICH PSUR/CTPR report
based on Listedness.

Determine Possible Causality from This field enables you to enter a numeric value.
the causality score

Determine Probable Causality This field enables you to enter a numeric value.
from the causality score

On PSUR, NDA, IND, Medical The available options are:

Review List Reports +  Use Initial Receipt Date for date range search

*  Use Safety Date for date range search

Print footnote 'Non-Serious Listed' The available options are:
for non-serious listed cases in ICH ,  ygqg
PSUR report .« No

Assessment of Listedness and The available options are:
Causality when both Licenses and .  Based on selected liscenses

Studies are selected in CTPR . Based on selected studies

Use the following procedure to configure periodic reports.

1. Select the option for Inclusion Criteria for cases in the ICH PSUR report.
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2. Select the option for Print footnote Non Serious Listed for non-serious listed
cases in ICH PSUR report.

3. Select the option for Inclusion criteria of event for a product in the PSUR.
4. Enter the value for Determine Possible Causality from the causality score.
5. Enter the value for Determine Probable Causality from causality score.

6. Select the option for On PSUR, NDA, IND, Medical Review List Reports.
7. Click Save to save the changes made to this screen.

Scheduling Reports Configuration

The Scheduling Reports Configuration screen enables you to modify the options
available for scheduling reporting. Select System Configuration > System
Management to view the Common Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Scheduling sub-folder is displayed in the left panel.

Click the Scheduling sub-folder to configure the scheduling report options. The
configurable fields associated with Scheduling Reports appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under Schedule Reports:

Field or Control Name Description
Report Scheduling The available options are:
*  Report Scheduling will be run by the Middle Tier
Service

e All report scheduling will be done locally on the
client machine

Enable separate scheduling of device The available options are:

reporting rules from drugs and e Yes

vaccines . No

Report Scheduling Causality Enables you to select from the causality operands
Operand AND/OR to use for scheduling a report.

Use the following procedure to configure scheduling.

1. Select the option for Report Scheduling.

2. Select the option for Enable separate scheduling of device reporting rules from
drugs and vaccines.

3. Select the operand to use for scheduling a report from Report Scheduling
Causality Operand.

4. Click Save to save the changes made to this screen.
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The Security Configuration screen enables you to modify the options available for security.
Select System Configuration > System Management to view the Common Profile

Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field labels
associated with that section.

To configure the fields associated with the Security section, click the Common Profile >
Security folder in the left panel. The configurable fields associated with Security appear in

the right panel.

Field Descriptions

The following table lists the fields available under Security:

Field or Control Name

Description

Number of previous passwords that
cannot be repeated

Number of non-alpha characters in
password

Minimum number of characters in the
password

ORACLE

Enables you to configure the number of passwords that can
be allowed.

For example, if you enter 4 in this field, it configures the
system to enable up to 4 previous passwords that cannot be
used as passwords again. The default value is 3.

Password rules:

e The password should contain at least 2 non-
alphanumeric characters.

e The password should have at least 8 characters.

e The previous 3 passwords cannot be repeated.

e The account will be locked after 3 failed login attempts .

Enables you to configure the number of non-alpha
characters that should exist in a password. Non-alpha
characters include characters such as @, $, etc. The default
value is 2.

" Note:

To avoid bad configuration, we
recommend that the value of
this switch is kept as 0 or 1
only.

Enables you to configure the minimum number of characters
that a password must have. The default value is 8.

For example, if you enter 8 in this field, it configures the
system to ensure that every password contains at least 8
characters.
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Field or Control Name Description

Use Secure property for cookies Enables you to select whether to use secure property for
cookies.

Number of consecutive failed login Enables you to configure the number of consecutive failed

attempts before account is locked out login attempts that can be allowed before an account is

locked out. The default value is 3.

For example, if you enter 3, it means that up to 3
consecutive failed login attempts are allowed. If the fourth
consecutive login attempt also fails, the account gets locked
out.

Use the following procedure to configure security.

1. Enter the value for the number of unique previous passwords in Number of
previous passwords that cannot be repeated.

2. Enter the value for the number of non-alpha characters in Number of non-
alpha characters in password.

3. Enter the value for the minimum number of characters for a password in Minimum
number of characters in the password.

4. Enter the value for the number of consecutive failed login attempts in Number of
consecutive failed login attempts before account is locked out.

5. Click Save to save the configured values.

6. Click LDAP to configure the LDAP fields.

The configurable fields associated with LDAP appear in the right panel.
Field Descriptions

The following table lists and describes the fields available under LDAP:

Field or Control Name Description

Enable LDAP at system level The available options for this are :
* Yes
* No

Use the following procedure to configure security:

1. Select the option for Enable LDAP at system level.

2. Click Yes to enable the LDAP Search Domain Account. This displays the LDAP
Search Domain Account dialog.
The following table describes the fields of the LDAP Search Domain Account
dialog:

Field or Control Description

Name

Use Secure Socket  If your LDAP Server is configured to use SSL for communication,

Layer please check this box. Use of SSL enables for a Secure
communication between the client and the server using secure
keys.
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Field or Control
Name

Description

Force Anonymous
Binding for Search

UserDN

Password

Server Name

Port Number

BaseDN

Time Out (Sec)

LDAP Search Key

When setting up the LDAP Server, you have the option to force
users to bind (authenticate) to the LDAP Server prior to being able
to search the LDAP Tree. If this option has been setup in your LDAP
server, this option must be checked.

During the setup of the LDAP server, the distinguished name and
tree structure is created for users to be configured under. Enter in
the defined structure as defined in your LDAP server into this box.
This is required only if the server is setup for Force Anonymous
Binding for Search.

Enter in the password for the User entered in the UserDN box for
the bind to the server.

Enter in the LDAP Server name or IP Address to which LDAP
Authentication needs to occur on.

Enter the port on which the LDAP Authentication Services are
enabled on the LDAP Server (Default Value: 389).

Enter in the topmost distinguished name of your tree defined on the
LDAP Server for which you would like to search for users under.

Enter a value in seconds, which will tell Argus how long to wait for a
response from the LDAP Server during any authentication before
timing out (Default Value: 10).

Enter the key to authenticate the user name against in the LDAP
Tree structure. For Example, when using Microsoft Active Directory,
to authenticate using the Windows Username (Not Full Name),
enter in SAMAccountName.

* If you select the Use Secure Socket Layer (SSL) checkbox, the Port Number is
auto-populated with the value 636.

» If this checkbox is not selected, the Port Number is auto-populated with the value

389.

* A generic LDAP server can accept anonymous as well as non anonymous binding,
based on the configuration.

* If the Force anonymous binding for search? checkbox is not selected, both
UserDN and Password are enabled.

Enter the LDAP username and password in the UserDN and Password fields,

respectively.

Enter the values for Server Name, Port Number, Base DN, Time Out and LDAP Search

Key, as required.

* The field length for Port Number and Time Out is 5 characters, while the Server
Name, BaseDN, LDAP Search Key, UserDN and Password can be up to 255

characters.

5. Click Save to save the changes made to this screen.

Configuring Cryptography within Common Profile > Security
Common Profile > Security > Cryptography contains two key settings:

e Configured hashing algorithm to use - This setting determines the Hashtag algorithm that
will be used in encrypting passwords.
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*  *De-optimizer counter for hashtag routine* - This setting determines the strength of
encryption (for example, the higher the value of this setting, the stronger will be the
encryption, and vice-versa). The default/recommended value is 1000.

Configuring Single Sign-On

ORACLE

A common profile switch determines whether the system uses the Single Sign-On
function. The Enable Single Sign-On checkbox enables you to configure the system to
use the single sign-on feature.

Before enabling the single sign-on feature, you must enter the Single Sign-On HTTP
Header element that the Argus application uses for authentication. This field can
contain a maximum of 40 characters.

1. The following new entries which are common across all enterprises have been
added in Argus Console > System Management (Common Profile
Switches) > Single Sign-On:

A checkbox called Enable IAMS Integration has been introduced. IAMS is an
Oracle suite of products used for Identity and Access Management mainly for
Oracle Argus Cloud releases. Enabling this switch allows the application to
integrate with IAMS.

A checkbox called Use Oracle Access Server SDK for LDAP Validation under
Single Sign-On tree will become available for selection only when Enable Single
Sign-On is checked.

This configuration is used to identify use of Oracle ASDK for user action
confirmation , ESM login and EOSU Login functionality.

» If this checkbox is checked, Oracle ASDK is user for action confirmation , ESM
Login and EOSU Login when Argus Safety is configured for Single Sign-On.

» If this checkbox is not checked, LDAP server information is used from Argus
Safety database for user action confirmation, ESM Login and EOSU Login.

2. A new textbox called Oracle Access Server Login URL has been added under
the Use Oracle Access Server SDK for LDAP Validation checkbox.
This is the base URL which is be passed to Oracle ASDK for user validation
against Oracle Access Manager.

3. A new textbox called Short Org ID HTTP Header has been added under the Use
Oracle Access Server SDK for LDAP Validation checkbox.
This is an HTTP Header variable for retrieving the short org ID which is to be
passed with ASDK Login URL.

4. If the Use Oracle Access Server SDK for LDAP Validation checkbox is
checked, the application ignores any LDAP configuration present in the Oracle
Argus Safety database and you cannot select LDAP Server Alias for any user
from the user configuration screen (Access Management > Argus > Users)
in the Argus Console.

The following table lists dialog boxes in the Oracle Argus Application that require
passwords. In such cases, the system Single Sign-On feature redirects the password
to Oracle Argus for validation. When single sign-on is enabled, the system locks the
user account if the user enters an incorrect password three consecutive times. You
must then unlock the account to enable the user to log in to the application.
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Function Section Procedure

Case Locking Activities|Lock Locking a case

Case Unlocking Activities|Lock Unlocking a case

Case Closing Activities|Close Closing a case

Case Unclosing Activities|Close Unclosing a case.

Case Unblinding General|Blinding Status Breaking a blind

E2B Incoming Accept Reports|incoming E2B Reports Accepting E2B Reports

E2B Incoming Reject Reports|incoming E2B Reports Rejecting E2B Reports

E2B Incoming Follow-up Reports|incoming E2B Reports Accepting E2B Follow-up Reports

Accept

E2B Incoming Follow-up Reports|incoming E2B Reports Rejecting E2B Follow-up Reports

Reject

E2B Incoming Nullification E2B Incoming Nullification Accepting E2B Nullification Reports

Accept Accept

E2B Incoming Nullification E2B Incoming Nullification Rejecting E2B Nullification Reports

Reject Reject

LAM Incoming Local Affiliate Incoming Review Accepting an Affiliate Event

Workflow Routing Workflow Routing on Password Workflow Routing on Password on
on Route Route

Oracle Access Server SDK Support for LDAP Validation in a Single Sign-On
Environment

Oracle Argus Safety has been enhanced to support action confirmation (user id/password)
using Oracle Access Server SDK.

If customers do not want to store the LDAP information in the Argus database for a single
sign-on environment, this new feature of Argus Safety can be used to validate a user's
actions through ASDK.

This feature is available only while using Oracle Access Manager as the Single Sign-On tool.

The following is a list of places where the Oracle Argus Safety web dialog which requires
action confirmation to perform respective actions, has now been enhanced to validate a user
using Oracle ASDK:

* Case Lock/Unlock

» Case Routing

* Case Delete/Undelete
e Case Archiving

* LAM Routing

e Study Unblinding

« ESM Login
 EOSU Login

There is no change in the user experience while performing actions which require password
validation for a logged-in user.
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The following modules launched in the Oracle Argus application continue to use the
Single Sign-On feature:

*  Oracle Argus Insight
*  Oracle Argus Affiliate
* Oracle Argus Safety Japan

The following modules do not use the Single Sign-On feature:

e End of Study Unblinding

e Oracle Argus Safety Services

e Oracle Argus Interchange Services (ESM)

e Oracle Argus Interchange Mapping (ESM Mapping Utility)

Configuring Single Sign-On re-authentication

Before you can configure Single Sign-On re-authentication, make sure that the Service
Provider IDM (for example, Oracle Access Manager) supports Re-Authenticate URL
and sets the last re-authentication header every time a user is re-authenticated.

To configure re-authentication, use the following common profile switches under
Console > System Management > Single Sign-On:

1. The Enable Re-Authentication checkbox (selectable only when the Enable
Single Sign-On checkbox is checked), which enables Single Sign-On re-
authentication. You can edit the re-authentication fields only if this checkbox is
checked.

2. The Re-Authentication URL text field, where you enter the re-authentication URL
of the corporate LDAP system. The URL must be in the following format:
<protocol>://<hostname>:<port>/oamreauthenticate?redirect url= (for
example, https://acme.idm.com:8787/oamreauthenticate?redirect url=).

3. The Re-Authentication HTTP Header text field, which is populated by default. The
default setting is OAM LAST RE-AUTHENTICATION TIME.

4. The Re-Authentication HTTP Header Date Time Format text field, which is
populated by default. The default setting is Dy Mon dd hh24:mi:ss TZD yyyy.

If re-authentication is enabled, user association with LDAP is not required, and you
can configure Argus Safety users without providing LDAP details.

Single Sign-On re-authentication has the following impact on the LDAP settings at the
user configuration level, which you can access under Console > Access
Management > Argus > Users:

1. The Enable LDAP Login checkbox is available if either LDAP is enabled at the
system level (under Argus Console > System Configuration > System
Management > Security > LDAP node), or Single Sign-On re-authentication
is enabled. If neither is enabled, then the checkbox is disabled.

2. The LDAP Server Alias drop-down list is disabled and blank when the Enable
Re-Authentication checkbox is checked.

3. If both re-authentication and LDAP are configured, then priority is given to re-
authentication.
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Error Messages

Once the user is configured, the system automatically logs the user into the Oracle Argus
Safety Application without requiring re-authentication on the Argus Login application. If there
is an authentication error, the system displays the current login page so the user can log in
manually.

Configuring SMTP

This screen enables you to configure SMTP.

Currently there are multiple issues such as, Outlook related problems with AG Service due to
new security features introduced by Microsoft. Due to these security enhancements, a new
method to submit emails from AG Service has been implemented using the SMTP Protocol.

Select System Configuration > SMTP Configuration to view the SMTP
configuration pop-up dialog.

Field Descriptions

The following table lists and describes the fields associated with this section.

Field or Control Name Description

Server IP or Name Enables you enter the SMTP server name / IP address.

Port Enables you to enter the port number to use for SMTP server.

Authentication Enables you to select the Authentication mode for SMTP configuration

SMTP User Name This is the username that the AG Service authenticates with for SMTP
Emailing.

SMTP Password This is the password that the AG Service authenticates with for SMTP
Emailing.
This field is required when Basic Authentication is selected in Authentication.

Enable SMTP When this checkbox is checked, SMTP is used by AG Service to send emails.

Use the following procedure to modify SMTP.
Enter the SMTP Server IP or Name.

Enter the Port number to use for SMTP server.

Select the Authentication mode for the SMTP configuration, from the drop-down list.
Enter the SMTP User Name.

Enter the SMTP Password.

Select Enable SMTP? to ensure that the AG Service implements SMTP to send e-mails.

N o g M w N PR

Click OK to save the changes made.
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< Note:

If Oracle Argus Safety needs to use the proxy set up for SMTP configuration,
ensure that the Proxy setting is configured under System Configuration
> System Management > Network Settings > Proxy.

Configuring Workflow Items

The Workflow Items screen enables you to modify the options available for Workflow
ltems.

Select System Configuration > System Management to view the Common
Profile Configuration screen.

Tip:

The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders. Each folder contains all the field
labels associated with that section.

To configure the fields associated with the User Interface section, click the Common
Profile > Workflow folder in the left panel. The configurable fields associated with
Workflow appear in the right panel.

This section enables you to configure the total number of hours remaining for the
present workflow state as well as the Total Number of hours remaining for the case
lock.

*  The first element displays the number of hours remaining for the case to be
processed with the current workflow state.

* The second element displays the number of hours remaining for the entire
workflow for the case till Case Approval (Case Lock).

» If the time remaining is less than the specified value in % for Yellow Indicator on
the Case form for Dynamic Workflow, the elements are highlighted in yellow.

» If the time remaining is more than the specified value in % for Yellow Indicator
on the Case form for Dynamic Workflow, the elements are highlighted in green.

» If the time remaining has exceeded the allocated time for the case process, the
value is displayed in red, with the time displayed in negative.

*  The exceptions to this feature are those cases, which are archived and locked.

The Worklist > New and Worklist > Open also display a ! status beside
Priority, denoting that the time remaining has exceeded the allocated time.
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Filier ‘Group Membership
[Case Number vl [0 _search | All vl

) Only view locked Cases requiring Follow-up [open ] View ® Individual O Group O Al

Total Number of Rows (10) Displeyiog Rows Page Sizs =n
Priority Receipt Date Days Open/ Case Number Product Name Event PT SIUR Case Type Reporter Type Assigned To
Lock State SUSAR Aware Date Remaining Workflow State | Group Generic Name Event Verbatim FLTorH Study ID Country Owner
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v][7-7720000 ] vl I J J V] J J X
O initl 0 27-Apr2020 33 2020.04-1-50-000004 RabiesVac X Arthralgia Yoy Spont Nurse veena
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O inital 0 27-Apr2020 3% 2020-04-LIT-000032 Penicilin Ocular hyperaemia Mg Lterat veena
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O initial 0 27-Apr-2020 336 2020-04-SP0-000033 RabiesVac-X Ocular hyperaemia Yy S Nurse veena
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Routing Details

Print List

The total number of units is calculated by navigating across the possible routes the case can
traverse. In case a case has to traverse through multiple possible routes, the preferred route
is selected.

* The Days Remaining Calculation in Worklist common profile switch enables you to select
either of the following options:

— Use earliest due date of reports pending submissions (default)

When... ...populate Due Soon date based on:

Auto-scheduling is done Earliest due date of the report.
for the reports and the

case contains

scheduled reports.

Auto-scheduling is done Latest aware date and duration as specified in the Due Soon

for the reports but the Duration (in Days) for Worklist Calculation common profile switch.
case does not contains

any scheduled reports.

Neither auto-scheduling Latest aware date and duration as specified in the Due Soon

is done for the reports  Duration (in Days) for Worklist Calculation common profile switch
nor likely to schedule a

report.

Auto-scheduling is not  Earliest due date of the possible reports.
done for the reports but

the reports are likely to

be scheduled.

— Use latest aware date

When... ...populate Due Soon date based on:

Auto-scheduling is done Latest aware date and duration as specified in the Due Soon

for the reports, and may Duration (in Days) for Worklist Calculation common profile switch.
or may not contain any

scheduled reports.

Neither auto-scheduling Latest aware date and duration as specified in the Due Soon

is done for the reports ~ Duration (in Days) for Worklist Calculation common profile switch.
nor likely to schedule a

report.
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When... ...populate Due Soon date based on:

Auto-scheduling is not  Earliest due date of the possible reports.
done for the reports but

the reports are likely to

be scheduled

Field Descriptions

The following table lists the fields available under Workflow:

Field/Control Name Description

Case Routing The available options are:

*  Case form to close after use performs a manual routing
»  Case form to remain open

Days Remaining The available options are:
Calculation in «  Use earliest due date of reports pending submissions
Worklist

e Use latest aware date

Minimum length of The available options are:
the routing comment . None

text length

»  Text field

Due Soon Duration Enter the number of days in which the worklist calculation is due.
(in Days) for Worklist
Calculation

Due Soon Red Enter the number of days in which the red indicator is to due to be
Indicator (in Days) for displayed for the worklist.
Worklist Display

% for Yellow Indicator Enter the percentage for the yellow indicator on the case form for
on the Case form for dynamic workflow. This field cannot have a value more than 99.
Dynamic Workflow

Enable Dynamic Select this checkbox to view the dynamic workflow indicators on the
Workflow Timing case form.

Use the following procedure to configure workflow items.

g H @ b P

Select the option for Case Routing.

Select the option for Display Locked/All cases on the worklist.

Enter the Minimum length of the routing comment text length in the text box.
Select the option for Display date for cases in the worklist.

Enter the number of days in which the worklist calculation is due in Due Soon
Duration (in Days) for Worklist Calculation.

Enter the number of days in which the red indicator is to due to be displayed for
the worklist in Due Soon Red Indicator (in Days) for Worklist Display.

Enter the percentage for the yellow indicator on the case form for dynamic
workflow in % for Yellow Indicator on the Case form for Dynamic Workflow.

Select the Enable Dynamic Workflow Timing checkbox to view the dynamic
workflow indicators on the case form.

Click Save to save the changes made to this screen.
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Configuring Workflow

When a case is received by the company and initial details have been entered and saved into
Oracle Argus Safety, its status in the system becomes 'New' or 'Data Entry'. Various actions
may be required before a case makes the transition from one workflow state to another.

For the example:

The case may require review, letters may need to be issued, the case may need to be
reported elsewhere in the company, or regulatory reports need to be submitted to regulatory
authorities. The case can be closed after all outstanding actions have been carried out and it
flows through its life cycle.

For each stage in case processing, Oracle Argus Safety enables responsibility for cases to
be assigned to specific user or group of users. Click the following link for information about
how worklist permissions have changed.

For more information, see:
e Worklist Updates

e Configuring Case Workflow

e Worklist Intake

Worklist Updates

ORACLE

The Worklist is driven by the group permissions defined for each user.

e Granular permissions have replaced the current worklist options for the following worklist
elements in group permissions:

—  Worklist - New

—  Worklist - Open

—  Worklist - Reports

—  Worklist - Action Items

—  Worklist - Coding Action Items
—  Worklist - Contacts

—  Worklist - Bulk Transmit

—  Worklist - Bulk Print

—  Worklist - Bulk E2B Transmit
— Worklist - Local Labeling

— Worklist - Coding Status

—  Worklist - Letters

—  Worklist - Intake (default is disabled)

» If the worklist is disabled during the upgrade, then all the sub-elements are disabled;
otherwise, all are enabled.

*  The default for New Group Creation is enabled.

* The User Group Permissions Report has been updated to reflect granular permissions.
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Configuring Case Workflow

ORACLE

Configuring case workflow involves configuration of:

Workflow States
Workflow Rules

Configuring Workflow States
This screen enables you to configure the workflow states.
Field Descriptions

The following table lists and describes the fields available under Total Number of
Rows:

Field or Control Description

Name

State Name Displays the name of a workflow state.

State Description Displays a brief description about the workflow state.

Site Displays the site associated with a workflow state.
Tip:

Click Add New to add a new workflow state to the list of existing workflow
states.

Use the following to modify workflow states

1. Enter the name of the workflow state under State Name.

Tip:
This name is displayed as Case Status in the General Information
section of the Case Form.

2. Enter the description of the workflow state under Description.

3. Select the site to be associated with the workflow state from the Site drop-down
list.

4. The drop-down list is populated with the configured user sites.
5. Click Save to save the changes made.

Configuring Workflow Rules

This screen enables you to configure workflow rules. The following illustration shows
the fields associated with this section.
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WORKFLOW

R .|

Group v |[ Administrator Group v [w] v v
0 O
‘Apply Fitor Clear
Total Number of Rows (3)
From. . To AIC Name Normal Time/Max Time User Defined Attribute 1 User Defined Attribute 2
Data Entry CT Review CT_Case /
|Data Entry Medical Review (NONE) !
New Case Data Entry (NONE) '
AddNew ][ Copy Delete Print
Modify WorkFlow Rules
¥ From ¥ To ¥ Group
[New Case <] [Data Enty <] [Administetor Group
Product Group Time(days) Norm. / Max. / Units.
Advanced Conditi
[(None)
Reason for Not Being Able to Route
(0] Restrictto Workfow Group
User Defined Aturibute 1 User Defined Aturibute 2
() Email (] Lock Case on Route (0] Require Password on Route
Sav

Field Descriptions

The following table lists the Field Descriptions for this section.

Field or Control Description

Name

From Defines the original state for the transition.

To Defines the destination state for the transition.

Group Specifies the group which will own the case once it moves from the From

state to the To state (via this transition).

The drop-down list displays all the configured user groups of Oracle Argus
Safety.

Normal Time (days) The workflow system monitors the time frames of each case in a state with
Max Time (days) respect to the Normal and Maximum parameters through AG Service.

e The AG Service evaluates the status of each open case.

« If acase has existed in its current state longer than the Normal time
specified for the transition, the system raises the priority of the case by
one level.

This escalation occurs only once for a case within a given state.

e The case priority is not reset to its assigned priority upon transition.

« If acase has existed in its current state longer than the Maximum time
specified for the transition, the system raises its priority to level one (the
highest priority).

e In addition, an email notification is sent to the group's supervisor,
indicating that the case has exceeded its maximum time.

*  The email message identifies the Case ID, Current State, Current Owner,
and the time it has spent in its current state.

User Defined Attribute  Lets a user define a custom attribute for a work flow rule such as logically
1 grouping workflow rules. Used only for filtering purposes on the same screen.
/

User Defined Attribute
2

ORACLE"
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Field or Control
Name

Description

Units
Product Group

Restrict to Workflow

Group

Email

Require Password on
Route

Lock Case on Route

Reason for not being
able to route

Privileges to others

Preferred State

Enables you to specify the number of units.

Enables you to associate a specific Product group as additional criteria for
the workflow transition.

Enables you belonging to the identified workflow rule group to have case
access rights, based on the definitions of only the identified group.

When checked, the system sends an email notification to the user group
address specified in group information whenever a case makes this particular
transition.

By default, the checkbox is unchecked.

e If the switch PASSWORD_ON_ROUTING" is disabled (0), the password
option on the Workflow Dialog is not displayed and the Routing dialog
does not ask the user for a password.

e If the switch PASSWORD_ON_ROUTING" is enabled (1), the password
option on the Workflow Dialog is displayed to users. If the Workflow Rule
has the password option checked and the case being routed passes that
workflow rule criteria, the password option is displayed on the routing
dialog.

e If the Workflow Rule that the case has passed does not have the
Password option checked, no password option is displayed on the routing
dial.

Enables you to lock the case on routing. Users might need to enter a
password when routing to the case.

Enables you to enter the description needed by the system to display while
routing the case, when the case is ineligible to be routed to any of the
configured To State.

Specifies the access rights for groups other than To Group' of the transition

have to the case when it follows that transition. The choices are:

No Access
Read-Only
Read/Write (default)

Enables you to specify the preferred state for the rule.

Use the following procedure to modify workflow rules.

1. Select the appropriate Filter Criteria.

»  Execute the following steps to apply a filtering criteria to search for specific

workflow rules.

» Select the check boxes to enable the drop-down lists containing a filtering

criteria.

» Select the appropriate filtering criteria from the drop-down lists.

» Click Search to remove the selected criteria or click Apply Filter to apply the
selected criteria. This displays the search results under Total Number of Rows.

2. The entities in Total Number of Rows display the From and To states, the
Advanced Condition, Group, Normal Time/Max Time and Number of User Defined
Attributes in the Workflow.

3. Select the rule displayed under Total Number of Rows that needs to be modified.
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The Modify Workflow Rules section is populated with information about the selected rule.
Select the original state of the workflow rule from the From drop-down list.

Select the destination state of the workflow rule from the To drop-down list.

Select the group from the Groups drop-down list.

Select the product from the Product Group drop-down list.

Select the Email checkbox, if required.

. Select the Lock Case on Route checkbox, if required.

Select the Require Password on Route checkbox, if required.
Enter the number of days in the Normal Time (days) field.

Enter the number of days in the Max. Time (days) field.

Enter the number of units in the Units field.

Select the preferred state for the rule from Preferred State.
Select the relevant Advanced Condition, if any from the button.

Enter the reason for not being able to route, if applicable, under Reason for not being
able to route.

Specify the access levels available to others from the Privileges to others drop-down
list. The options available under this list are No Access, Read-Only and Read/Write.

» Select the No Access option to disallow users outside the transition's group to open
the case when it follows the transition.

» Select the Read-Only option to enable users outside the transition's group to view the
case, but not to modify it.

* Select the Read/Write option to enable users outside the transition's group to modify
the case when it follows the transition.

Specify the checklist of items to appear under Checklist.

Tip:

The Checklist row cannot be left blank. Click Add and Delete to add and delete
checklist items.

Define custom attributes for a workflow rule under User Defined Attribute.

Click Save to save the changes made.

This section provides information about the Worklist Intake feature.

Pending tab

The system enables the user to view a list of incoming attachments in Worklist View. In this
view, the user can select an attachment for the case creation for Oracle Argus Safety and
Oracle Argus Affiliate cases in the Pending dialog.

The following table lists and describes the fields available for the worklist:;
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Field or Control Description Bookin Field Property
Name
Priority Enables you to view the priority N/A Non-scrollable
of a case field label
Initial Date Enables you to view the Initial Initial Receipt Date Non-scrollable
Receipt Date of the case. field label
Intake Date Enables the user to view the N/A Non-scrollable
date the system imported the field label

Product Name

Generic Name

Event PT

Event Verbatim

Serious

F LT, orH

Case Type

Study ID

Reporter Type

attachment in the Intake
Worklist.

Enables you to view the
suspect product in questions.

Enables you to view the
generic name of the suspect
product in question.

Enables you to view the
primary event and verbatim as
reported.

The following format will be
used:

Primary Event (Verbatim as
Reported)

Enables you to view the Case
Level Assessments Serious
(Y/N).

Fatal (F), Life Threatening (LT),

or Hospitalized (H)

. If the case is Fatal, print F.

e Ifthe case is Life
Threatening, print LT.

. If the case is Hospitalized,
print H.

» If any of the preceding are
present together, Fatal
takes precedence followed
by LT, followed by H.

» If the case is neither,
display No.

Product Name

Generic Name

N/A

N/A

N/A

Death for F

Hospitalized for H

Life Threatening
for LT

Enables you to view report type Report Type

information.

Enables you to view the Study
ID for the study cases

This field is empty for cases
where the Study ID is not
available.

Enables you to view the
reporter type for the primary
reporter in the case.

This field is empty if the
reporter type is not available.

Study ID

N/A

Scrollable field
label

Scrollable field
label

Scrollable field
label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label
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Field or Control Description Bookin Field Property
Name
Country Enables you to view the Country of Scrollable field

country of incidence. Incidence label
Central/Affiliate Site Enables you to view the current N/A Scrollable field

Oracle Argus Safety or Oracle label

Argus Affiliate site of the case.

You can view all the source

documents from the site folder

the user belongs to.

Workflow enterprise users can

view all cases across all site.
Attachment Enables you to view the N/A Non-scrollable

Classification

Description

View All

View Individual

attachment associated with the
case. If there are multiple files,

they are separated by a
comma.

Enables you to view the
attachment classifications
associated with the
attachment.

Enables you to view the
attachment description
associated with the case.

Enables the administrator and

Classification

Description

N/A

workflow manager/enterprise to

see all items in the system
across all sites.

Enables you to view all items

assigned to this user site.

. If there are no sites
defined then all users

N/A

have access to the case

attachment.
e This button is disabled

if

the user is not a workflow

manager or enterprise
user.

field label link

Scrollable field
label

Scrollable field

label

Radio button

Radio button

Worklist Intake View

The following table describes the Worklist Intake View:

Oracle Argus Site Folder Worklist Intake View

us C:\USINTAKE All users belonging to the US site can see the case
and workflow enterprise users.

DE C:\EUINTAKE All users belonging to the DE, FR, CH site can see
the case and workflow enterprise users.

CH C:\EUINTAKE All users belonging to the DE, FR, CH site can see
the case and workflow enterprise users.

FR C:\EUINTAKE All users belonging to the DE, FR, CH site can see

the case and workflow enterprise users.
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Oracle Argus Site Folder Worklist Intake View

JP C:\JPINTAKE All users belonging to the JP site can see the case
and workflow enterprise users.

Worklist

* The system reads the XML that contains the preceding fields as tags and creates
the Worklist based on the tags.

<Cases>

<Case>

<PRIORITY>: Single number from 1 - 8. All others to be ignored
<INITIAL DATE>: Format of Date DD-MMM-YYYY

<PRODUCT NAME>: Text Field up to 70 Characters

<GENERIC NAME>: Text Field up to 70 Characters

<EVENT PT>: Text Field up to 250 Characters

<EVENT VERBATIM>: Text Field up to 250 Characters
<SERIOUS>: Yes / No. All others are ignored

<FLTH>: Format of F. All other after that are ignored
<LT>: Format of LT All other after that are ignored

<H>: Format of H. All other after that are ignored

<CASE TYPE>: Text field of report type

<STUDY ID>: Text field of Study ID

<REPORTER TYPE>: Text field of Reporter Type
<COUNTRY OF INCIDENCE>: Text field of Country

<ASSIGNED TO>: Text field of User

<GROUP>: Text field of Group

<SITE>: Text field of Site

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name

<DOCID>: Document ID from Document Storage System
<CLASSIFICATION>: Text field of Attachment Classifications
<DESCRIPTION>: Text field of Attachment Classifications Descriptions

*  The text on the worklist prints as specified in the XML and no lookup is performed.
* If any of the Tag elements are empty they will be empty in the Intake Worklist.

» If any fields are not available on the initial case entry, the system ignores them.

» If there are multiple tags for the same element, the system retrieves the first tag
element.

» If the values do not match any elements in the Initial Case entry, the system
ignores them.

e The minimum fields required for the Attachment to be visible in the Intake Worklist
are

— Filename
— DoclD

— DoclD is only required if a central document system is enabled. If DoclID is
blank then the physical file with the same name as specified in the tag
<Filename> is also required in the same folder.
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If there is an error occurs while processing the Worklist, AG Service sends an e-mail to
the General E-mail address.

The system enables you to select only one case at a time when creating cases in the
Initial Case entry dialog.

When you select an attachment row and click Create Case, the system locks the file
to prevent others users from booking in the same case.

The system displays the following message:

The case attachment is being currently used by XXXX user.

where:
XXXX is the full name of the user who has locked the attachment row.

The system displays the standard Initial Case Entry where the system populates the
fields within the XML Properties to the Initial Case entry dialog and display the PDF
file for 40% of the screen.

If multiple attachments are available, the system opens them. The end user system
must be setup to open multiple documents in the same window in Internet Explorer.

If the system is setup to use a central document storage system and the user clicks
Create Case, the system retrieves the PDF from the central document system.

The system adds the attachment to the Initial Case entry dialog and also includes the
Classifications and Descriptions for the attachment.

If the system is setup to use a central document storage system, Oracle Argus Safety
stores the document ID from the central document system. The file attachment will
not be stored in Oracle Argus Safety.

The system fills all available fields in the Initial Case Entry dialog with data from the
XML Messages.

If you choose to open the cases after book-in, the system keeps the Attachment
open in the split screen to enable the user to complete the case data entry.

If you book in the case from the Worklist Intake and chooses not to open the case
from the Initial Case Entry dialog after book in is complete, the system returns to the
Worklist Intake dialog.

When you perform a Duplicate Search and select a Case from the list, you can attach
an incoming file to an existing case.

The system displays the Accept As Follow-up button and enables it when the user
selects a case from the Duplicate search for the current Attachments to be added.

When you click Accept as Follow-up, the system opens the selected case and
continues to display the Source attachments.

The system adds the attachments with the Classification and description (if provided)
to the follow up case.

The system opens multiple attachments if they are available. The end user system
must be setup to open multiple documents in the same window.

Once you accept the initial or follow-up case and successfully create the case in Oracle
Argus Safety or Oracle Argus Affiliate, the system generates an Acknowledgement in the
OUT folder at the same level. For example, if the incoming folder for Site US is
C:\USSITE\Incoming, the system generates ACKS in the C:\USSITE\OUT folder.

The Message format for the ACK is as follows:
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<CASES>

<CASE>

<CASE NUMBER>: Argus Generated Case Number

<PRODUCT NAME>: Text Field up to 70 Characters for Primary Suspect
Product of Case

<DATETIME>: The Date and time in the DD-MMM-YYYY hh:mm:ss format when
the file was accepted / rejected by the system

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name

<DOCID>: Document ID from Document Storage System

» If you click Copy to copy a case in Oracle Argus Safety, the system generates an
ACKS and puts it into the out folder for the site the original case belongs to. For
example, Case A belongs to US Site and the user copies the case to Case B. The
system creates an ACK in the US\Out Folder as configured in the US Site.

Rejected Cases

In Oracle Argus Safety, the Workflow Manager or Enterprise User can click Reject
Case to reject cases from the Intake Worklist.

e Oracle Argus Affiliate users can reject cases in the Intake Worklist.

— When you try to reject a case, the system presents the Standard Justification
dialog.

— The Status row displays the following message:

Case Rejected by XXXX on YYYY at MMM due to: ZZZZ

where:

XXX is the User Full Name,

YYYY is the Date when the case was rejected in GMT

MMM is the time in GMT

777 is the justification for rejecting the case as entered by the user.

— Rejected Date: Date in GMT when the user rejected the case
— Rejected By: User Full Name who rejected the case.
e The system displays the Total number of Rows in the Worklist header section.

* You can select the number of cases to display on the by selecting a value from
page size drop-down list on the Worklist dialog.

e The page drop-down list contains the following values:
- 50
— 100 (default)
- 250
— 500
— 1000
— 2000

e The system displays the number of cases currently in view and updates the range
automatically. For example, if you select 100 from the page size drop-down list,
the system separates the displaying rows into groups of 100 cases.

e The system enables you to go directly to a range of cases from the Displaying
Rows drop-down list.
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The system enables you to scroll through the Worklist page-by-page increments as
defined by the Page Size drop-down list.

The system enables you to sort on ALL the columns in the Worklist view by clicking the
header column. The system displays a triangle to show which column is sorted currently.

— The initial sorted column is Initial Date.
— The default sort order is ascending
— Clicking the column header again, toggles between ascending and descending order.

The system maintains the worklist view with the sorting and filtering options defined by
the user.

The Intake Worklist enables you to filter on each element.
The system enables you to filter on any element when you click the Filter button.

— The system provides a Type Ahead feature to enables users to filter on any text/date
element.

— The system enables you to Close the filtering options by clicking the X icon on the
filtering options.

— If filtering criteria are specified, the Filter icon has the paper clip icon to indicate
there are filtering elements.

— The system permits a Like search (e.qg. if you search for Cure, it returns all elements
starting with Cure).

— The system enables wild card searches . For example, if the user searches for
%Cure, the system returns all elements containing Cure.

— Clicking the Search button enables you to filter for the reports in the list of reports.

— These are filtering options are available from Worklist-specific views and when you
drill down for cases or reports.

The system saves all user preferences for future use.

Clicking the Search button enables you to filter the elements on the dialog.

User Site Updates and Access Management

You can configure the Path for the File Intakes per Site (Oracle Argus Safety and Oracle
Argus Affiliate) in the Site configuration.

When you click the Browse button, the system enables you to browse to the Folder for
the Site where the XMLS and the PDFs are stored.

The Path length is up to 255 characters.

The current Worklist options are replaced with granular permissions for Worklist elements
in the Group Permissions as per the Worklist Intake (default is disabled).

The Audit Log tracks the updates made to Site Configuration.
The User Site print out displays the File Intake Path.

Configuring System Numbering

This screen enables you to specify the case numbering preferences. Select System
Configuration > System Numbering to view the LAM System Numbering screen.

The screen appears as shown.

ORACLE
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SYSTEM NUMBERING

Format

t
20(YYHCCTTT {##e#]

» Field Descriptions

Field Descriptions

The following table lists and describes the fields for this section.

ORACLE

Field or Control
Name

Description

Manually Number
Cases

Automatically
Number Cases

Start at

Separate sequence
for each site

Separate sequence
for each report type

Separate sequence
for each year

Separate sequence
for each month

Separate sequence
for each product
abbreviation

Numbering Format

Enables you to manually number the cases on booking or while copying
the case, using the save as' option on the case form.

On selection, the system automatically numbers the cases as defined
by you in the numbering format.

Enables you to initialize the counter of the sequence number.

Enables you to separate the sequence numbering for cases on site by
site basis. If there are cases being entered from two different sites then
each site will have different sequencing of case numbers.

Enables you to separate the sequence numbering for cases by the
report type of the case.

Enables you to reset the sequence numbering for cases after each year
based on the initial receipt date of the case.

Enables you to reset the sequence numbering for cases after each
month based on the initial receipt date of the case.

Enables you to reset the sequence numbering for cases for each
different product abbreviation.

Enables you to select the numbering format by selecting the different
placeholders.

Define the numbering format by typing in custom keywords to print on
every case number and selecting different placeholders.

[YY][IMM]-[###] is the default format.
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Field or Control
Name

Description

Placeholder

Placeholders are used to pickup values from the database to be used in
the Case numbering format.

The possible values populated in this list are:

# - Number: defines the digits to be used as the sequence number
in the format. The field is used to display the sequence number on
the case numbers.

CC- Country Code: When selected, this uses the A2 code for the
country of incidence for the case number.

DD - Day: When selected, this uses the date of the Initial receipt
date' field of the case.

MM - month: When selected, this uses the month of the Initial
receipt date' field of the case.

P - When selected , this uses either of the two values:

If report type is Spontaneous' or other' during booking: the system
uses the value of the Product Abbreviation' field specified in the
Product configuration for the selected Primary suspect product.

If report type is of the type report from study' during booking: the
system uses the Product Abbreviation' field specified in the study
configuration.

SSS - User Site: When selected this uses the Site abbreviation of
the site belonging to the user who booked in the case.

TTT - Report Type: When selected this uses the report type
abbreviation of the report type selected during booking of the case.
YY- Year: When selected, this uses the year of the Initial receipt
date' field of the case.

Use the following procedure to configure LAM system numbering.

1. Select the Numbering feature as required. This can be manual numbering or automatic

numbering of cases.

2. Select the Sequencing Options as required.

Tip:

For the complete explanation of the sequencing options refer to the Field
Descriptions

3. Select the Numbering Format.
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Q Tip:

To customize the Numbering Format, use the placeholder values.

For

the example: To select Country Code, Month and Year (as values to

be incorporated from the database) as the Case numbering format,
execute the following steps.

Click Country Code. This appears in the Numbering Format field.

Click on Month. This appears in the Numbering Format field next to
the Country Code.

Click on Year. This appears in the Numbering Format field next to
the Country Code and Month.

The final data listed in the Numbering Format field is the Case
Numbering Format.

4. Click Save to save the changes made.

Configuring Field Properties

This section enables you to change field label names and hide or display fields in the
Case Form.

Select System Configuration > Field Properties to view the Case Form
Field Configuration screen shown in the following illustration.

I cototisss | usiness Contiguration

| Acosss Managoment | Systam Contigumion | Toas

CASE FORM FIELD CONFIGURATION

|| [Field Name..
c:

[ oereret ntomaton
Drug Device Vaccine

Organized by | Field Label
Sy

25 ARGUS SAFETY
L GENERAL

Reporter

(aDosage Regimen
[HEUICA Device
[APMDA Device

Field Form Label ICSR Field Research Field
Cen Date

[User Def
\User Defined Number 3

‘Modify General Information

Field Name Field Form Label

AProduct Vaceine.

Help Text Hidden Read Only. Max Length Null Flavors
No Drug
Yes Device Safo Longth
ICSR Field Vaceine

Print All

ORACLE"
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The Case Form tabs appear in the left panel and are categorized as folders. Each
folder contains all the field labels associated with that section.

Example: The General Tab in the Case Form contains sections such as Study,
Follow-Up, Case Literature etc.

e To view the list of field names associated with the Study section, click Study in
the left panel.

« The field names associated with Study appear in the right panel.

For more information, see:

* Field Descriptions

Field Descriptions

The following table describes the fields associated with this section.

Field or Control
Name

Description

Field Name
Field Form Label
Help Text

Read Only

Drug

Device

Vaccine

Hidden

E2B Field
Max Length

Null Flavors

ORACLE

Enables you to view the field name. This is a read only field.

Enables you to enter the field label names for those fields that can be edited.
Enables you to enter help text for fields that can be edited.

Enables you to make drug, device, or vaccine field read- only.

Enables you to make a field Read only in the Product tab, when the Oracle
Argus Safety user chooses Drug option on the Product screen.

Enables you to make a field Read only in the Product tab, when the Oracle
Argus Safety user chooses Device option on Product screen.

Enables you to make a field Read only in the Product tab, when the Oracle
Argus Safety user chooses Vaccine option on Product screen.

Enables you to hide or unhide a field by selecting the radio button.

Select Yes to hide the field on case form; select No to unhide the field on
case form.

# Note:

Some fields cannot be hidden. Hidden fields do
not appear in the case form printout.

When checked, displays which fields are required for E2B.

Displays the maximum data length allowed for the fields. This information is
displayed for all fields except for Date and Codelist fields.

This drop-down list displays the Null Flavor sets that are configured in Null
Flavor codelist. Null Flavors are displayed in the Case Form field as per Null
Flavor set associated.
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Field or Control Description
Name
* Safe Length Allows you configure the safe length for all fields except for Date and Codelist

fields. Safe length is populated by default for E2B R2 fields which have been
extended as per the E2B R3 Regulation.

This field is not used in the application for this release.

Use the following to modify case form field names.

1. Select the folder (or section) in the left pane, for which the field names are to be
modified.

2. The places the list of field labels associated in the right panel.
3. Click the Field Name to be modified.

4. The system highlights the selected row is highlighted and puts the details about
this field in the Modify section at the bottom of the screen.

5. Enter the new field name in Field Form Label.

Tip:
This label will appear in the Case Form section.

6. Select the Hidden preference. Select Yes if you want to hide the field on the Case
Form.

7. Click this checkbox to indicate which fields are required for E2B.

8. Select any or all of the following options Drug, Device or Vaccine as Read Only
based on your requirement.

9. Click Save to save the changes made.

¢ Note:

Label Changes will not be reflected in Oracle Argus Safety Case Form
unless IIS is reset.

Adding User Defined Fields

ORACLE

User defined fields of type Text, Date, and Number may be added to a Case Form.
Follow the steps listed below to add a user defined field to a Case Form and/or confirm
that the Case Form supports user-defined fields:

1. In Argus Console, navigate to System Configuration > Field Labels.

2. Inthe left-hand section, select a Case Form by clicking on its name.

3. Inthe right-hand section with a title bar matching the selected Case Form, scroll
down till the words "User Defined.." are visible in the Field Name column.

4. Click on the desired Field Name.
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5. Inthe lower, right-hand section, make the appropriate corrections and save any changes.

# Note:

Oracle Argus Safety controls the total number of User Defined Fields on any given
Case Form by only allowing a single occurrence of each sequence number.
Therefore, if "User Defined Number 1" is used, "User Defined Text 1" and "User
Defined Date 1" cannot be activated. If a Date and/or Text field is desired the user
must select from the fields that have a higher sequence number such as User
Defined Date 2, User Defined Date 3, etc., thus always ensuring that the sequence
number is unique.

Configuring User Defined Fields

ORACLE

The Oracle Argus Safety administrator can customize a user-defined field as a drop-down
list. These drop-down lists may contain customized lookup data which can be independent of
Oracle Argus data.

Use the following procedure to create a user-defined field.

Identify the User Defined field in the CMN_FIELDS table.

Create a custom table containing lookup information.

Create a custom index and specify the required values for the table.
Update the record in the CMN_FIELDS table for the User Defined Field.

Create a Role and Synonym for the table.

© o p W NP

Restart I1S.
7. Verify the update made in the application.

Consider the following example that show a sample set of scripts required to configure User
Defined Fields as a drop-down list. Assume the requirement is for a User Defined Field (UDF)
with the following features:

Requirement: A User Defined field SOURCE_OF _INFORMATION to be created, with its
drop-down values as Fax, E2B, Letter, Email and Telephone under Case Form >
General Tab > General Information.

Attribute Value

Field Name SOURCE_OF_INFORMATION

Field Type Numeric (Text field type would not work)
Drop-down Values Fax, E2B, Letter, Email and Telephone

Field Location Case Form > General tab > General Information

Use the following procedure to create a user-defined field:

1. Loginto Oracle Argus Safety> Argus Console > System Configuration >
Field Labels.

2. Select User Defined Number <N> at desired page from tree shown in the left pane.
3. Choose No at Hidden.
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4. Check Selectable.

5. Click Add and specify items stored in the drop-down in both English and Japanese
if the field is multi-language, otherwise specify only in the English text box.

Goto General tab > General Information and check thatthe configured
user-defined fields display the updated drop-down text.

Configuring Local Data Entry

Oracle Argus Safety supports a concept of global lock that indicates the readiness of
case data for global reporting, and a concept of local data locks that indicates the
readiness of case data for local reporting having fulfilled the local data entry and
assessment needs.

The application allows local users to open a case for entering local data without
globally unlocking the case and at the same time maintain the integrity of the “global”
case data.

In order to achieve this:

1. The fields in the application are categorized into global and local fields. The local
fields have been identified as local to one or more countries. The local fields for
only Japan are supported in this release.

2. All Oracle Argus Safety Japan users are considered as Japan Local user in this
release and as having access to edit the Japan local fields.

For more information, see:

* About Local Fields

e Access Local Case Data Lock Functionality

*  Process an Outlier

e Activate Local Locking in Oracle Argus Safety

» Activate Local Reporting in Oracle Argus Safety

About Local Fields

ORACLE

A field is identified as a Local field to one or more countries based on a new attribute
in the CMN_FIELDS table. The local fields for only Japan are supported in this
release.

Customers can configure any field in the Case Form > General, Patient,
Products, Events tabs, andinthe Analysis > PMDA tab as a Local field for
Japan through back-end updates to the CMN_FIELDS table.

The Enterprise copy configuration action will copy these updates as per existing
functionality.

If a customer configures a field that could update global value as a local field, it is
expected that the customers maintain the integrity of the global data by business
SOPs or custom software processes.

All the fields in a case that is not a Local PRPT case are simply treated as global
fields.

All Argus J users are considered as having access to edit the Japan local fields.
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All Japanese text fields, including J User-Defined fields are considered as Local fields for
Japan.

* All Japanese text fields are the fields that currently has separate _J columns.

« All fields from PMDA tab, PMDA Device Information section.

Oracle Argus Safety allows selection of secondary LLT (stored in LLT_J or LLT_CODE_J
field) or Synonym (SYN_CODE_J) encoding using MedDRA J browser that does not change
the base MedDRA hierarchy of English.

The Event Assessment > Listedness field in the tab for the licenses of the local country
corresponding to the local user is considered as local field. However, this field is available for
editing for the user only when the local user has listedness privilege for that local country
assigned to them viathe User Group > Listedness Determination - Countries
access and the datasheet associated with that local country license is configured with
Global INo Local Assessment Required checkbox as unchecked.

The Events tab > Infection and Event Exclusion checkbox are also considered as local field
for Japan.

Any field where an update to a global field can occur is NOT considered as Local field.

All numeric fields, date fields, drop-down fields which share same data value for English and
Japan sides are not considered as Local fields.

However, there are exceptions to this rule where some fields that contain global values are
available for update to local users and in such a scenario, it is expected that the global value
should be protected by customer's business SOPs.

Case Classification is such a field that can cause update to global value and it is available as
a Local field in the application out-of-the-box.

Study section under General tab requires special handling by the application during local
editing. Study Name, Study Description, Protocol Number, Clinical Compound Number and
Center Name are local fields.

When the study is a configured study, all these fields are disabled for local editing except
Center Name (J). Center Name (J) is available as an editable local field.

The Product Information section in Products tab requires special handling by the application
during local editing. J Drug Code type and the corresponding J Drug Code/OTC Drug Code/
Temporary Code (i.e., DRUG_CODE_TYPE_J, DRUG_CODE_J,), J Generic Name and J
Product Name fields are local fields.

Any field that is already editable after case lock will remain editable even after local lock.

An auto-narrative generation performed during Japan Local data entry (after global lock) only
updates the J field value and does not update the English or any other language field value.

Access Local Case Data Lock Functionality

ORACLE

This section lists the different sections where the functionality for Local Case Data Lock has
been documented in the Oracle Argus Safety documentation.

Refer to the following table for the list of features and the corresponding guides where they
have been documented:
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Local Lock
Feature

Overview

Documented in

ORACLE

Local Locking and
Local Unlocking -
Configuration

Changes to the
Case Locking
Mechanism in
Argus Safety -
Case Form
Changes

Changes to the
Case Locking
Mechanism in
Argus Safety -
Changes to global
locking, One Step
Global and Local
Lock

Changes to the
Case Locking
Mechanism in
Argus Safety -
Changes to Global
Unlocking -
Configuration

Introduction of new switches: Allow Local Locking -
to allow a local user to be set up with the privilege
to locally lock or unlock a case.

Enable Local Unlocking - to provide a system level
control permitting local users to locally unlock a
case and make any corrections to the previously
entered local data.

Introduction of action icon - Local Lock - to allow a
user to locally lock or unlock a case

Allow Global locking and triggering of global and
local reports, and allow one step global and local
locking

Introduction of new switches:Allow Forced unlock
(Global and Local) - to allow users to be set up with
the privilege to forcibly unlock a case that been
globally and/or locally locked but pending report
generation.Allow Global Unlock on Pending Local
Lock - to allow users to be set up with the privilege
to forcibly unlock a case that is still pending a local
lock.

Oracle Argus Safety
Administration
Guide > 2 Access
Management >
Configuring Users

Oracle Argus Safety
Administration
Guide > 4 System
Configuration >
Configuring System
Management -
Common Profile
Switches

Oracle Argus Safety
User's Guide >
Global User
Management

Oracle Argus Safety
User's Guide > 1
Getting Started >
Quick Launch
Toolbar

Oracle Argus Safety
User's Guide >
Locking a Case

Oracle Argus Safety
Administration
Guide > 2 Access
Management >
Configuring Users

Oracle Argus Safety
Administration
Guide > 2 System
Configuration >
Configuring System
Management -
Common Profile
Switches

Oracle Argus Safety
User's Guide >
Global User
Management
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Local Lock
Feature

Overview

Documented in

Changes to the
Case Locking
mechanism in
Argus Safety -
Changes to global
unlocking - Case
Form changes

Case Form
changes - Local
Reports
Configuration -
Local Reporting
Rule and Local
Reports

Triggering Local
Reports - Changes
to Report
Scheduling and
Generation
Algorithm - Auto
Scheduling

Triggering Local
Reports - Changes
to Report
Scheduling
Algorithm - Manual
Scheduling

Triggering Local
Reports - Changes
to Report
Generation
Algorithm

Changes to
Expedited Reports
and Periodic
Reports on DLP

Control globally unlocking a case based on local/
global reports pending generation and /or cases
pending local lock.

Configuring Local Reporting Rules and Local
Reports.

Changes to report auto-scheduling for scheduling
local reports.

Changes to report manual scheduling for
scheduling local reports.

Changes to report generation for generating local
reports.

Changes to DLP while generating local expedited
and periodic reports.

Oracle Argus Safety
User's Guide >
Unlocking a Case

Oracle Argus Safety
Japan
Administration
Guide > 3 System
Configuration >
Configuring Local
Reports - Local
Reporting Rule and
Local Reports

Oracle Argus Safety
User's Guide >
Report Scheduling -
Auto-Scheduling

Oracle Argus Safety
User's Guide >
Report Scheduling -
Manual Scheduling

Oracle Argus Safety
User's Guide >
Triggering Local
Reports - Report
Generation
Algorithm

Oracle Argus Safety
Japan User's Guide
> Reports

Process an Qutlier

ORACLE

When a suspect product with local license is removed on a follow-up, the case remains a
Local PRPT Case (Local Potential Reportable Case) until the corresponding nullification/
downgrade local reports is generated.

If a customer wants to change Local Reports configuration data after being in production with
this release, it is recommended that customers ensure that cases/reports under processing
be completed before changing configuration data to avoid unpredictable results. Note that if a
customer changes the Local Reports configuration data mid-way where the reports are mid-
way processing (e.g., scheduled), the reports will be determined as local/global based on
what type it was at the time when the report was scheduled and will be completed processing
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that way irrespective of current configuration even if inconsistent with the
configuration. Also note that presence of local reports will determine that the case is
local case.

It is also recommended that customers ensure that cases/reports under processing be
completed before up taking the Local Locking feature and (thereby) installing the local
lock configuration data (refer to Activate Local Locking in Oracle Argus Safety). Note
that if the case was mid-way processing (e.g., case was open in data entry workflow)
when customer up took the Local Locking feature, a subsequent case save will
determine if the case is local or global.

Activate Local Locking in Oracle Argus Safety

ORACLE

In order to activate the Local Locking feature in Oracle Argus Safety, the installer
provides the users with an option to install the underlying metadata that enables the
local lock feature in the application. A customer, who may not prefer to turn on the
local locking feature due to existing business processes that already handle the local
processing needs for a company, could choose not to install the metadata and thus not
uptake the local lock feature in the application.

A separate database script is provided so that the user can run to turn on the Local
lock feature after an upgrade or fresh install. On executing this script, it prompts the
user to choose to turn on the local locking feature and uptake the Local Locking seed
data.

The application assumes the default value of 1, parses the user input and installs the
Local Locking seed data for each of the enterprise specified in the comma separated
list.

Enter Local Reports Configuration Seed Data
A new table is seeded to identify Local Reports for Japan:

e Country — The seed data is the country id for Japan (from codelist Countries) for
this release.

* Reporting Destination — The script prompts the customer to provide the default
value of reporting destination for PMDA as Please enter Agency Name for
the PMDA reporting destination as configured in the
"Reporting Destination" codelist. This name will be used to
identify Local Reports for all enterprises.

* Report Form — The seed data is the following Japan reports:
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i EFa EMRSE BIEEI - 2 (Mkid1,2)
i EEL MEFRESHAERSET FEIS - 4 (Mktd 3, 4)
iii EXmL AETOEEHRS REEEDS - 6 (Mktd b, 6)

iv. (EERE EMFREF FEEFIVL - 2 (lovl, 2)
v. EEE MEHHFHEREE FGREFEI.S - 4 (Jav 3, 4)
vi. EEE AETOEENRS BAERFEINS - 6 (v b, 6)
vii.  REFIL: EREETES - BREEMHREE
viti,  FREFIN  EEEEOHERESHNERES T ERENEREE
ix. EZB

i

Enter Local Users Seed Data

The upgrade installer script prompts the user to choose if all the Argus J users will be
updated to have local locking privileges.

Enter Local Fields Seed Data

Note that the CMN_FIELDS are always seeded as part of install/upgrade factory data to
identify the Local fields for Japan and will be present irrespective of if the customer chooses
local locking feature or not.

In case of Multi-tenancy, the customer input value is used to set the seed values across all
enterprises.

This seeding of Local users data is audit logged with the system user.

After install/upgrade, if customer has turned on the local locking, the icons in the applicable
screens start reflecting the local/global lock status of the case.

Activate Local Reporting in Oracle Argus Safety

ORACLE

The changes described below are applicable only when there are local reports configured in
the application (i.e. there is data in the Local Reports Configuration table).

The Report Generation functionality does not generate any Japan Local reports, including the
reports that were scheduled by the local reporting rules that were marked as Active Moiety
or Super Rules, until a local lock occurs. The global reports are generated on global lock.

In Case Form > Regulatory Reports tab, the Final hyper link for a local report is NOT
available for a case that is not yet locally locked (similar to the existing functionality for global
report on a global unlocked case).

In Case Form > Regulatory Reports tab, the Regenerate Report menu for a local
report is NOT available for a case that is not yet locally locked (similar to the existing
functionality for global report on a global unlocked case).

The Final checkbox in Case Actions > Case Open > Batch Print dialog box will
remain disabled and grayed out when any of the case selected is locally unlocked as it does
today when a case is globally unlocked.
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If report generation is invoked from the Batch Report Generation AG Service, the AG
Service skips the case that is not yet locally locked similar to the existing global
unlocked cases.

Note that Worklist > Bulk ICSR Transmit > Re-Transmit and Re-
Transmit Multiple Reports puta failed report back in generation to be picked
up for processing by Batch Report Generation AG Service. The above point will apply
in this scenario.

If report generation is invoked from other AG Services listed below, the AG Service
today ignores the global locked status and generates reports. This has been corrected
so that the AG Service skips the case that is not yet globally locked when generating
global reports similar to the existing Batch Report Generation AG Service. Similarly,
the AG Services listed below skip the locally unlocked cases while generating local
reports:

*  Bulk Report Transmit

*  Bulk Report Transmit Email
*  Bulk Report Print

*  Bulk Report Transmit Fax

*  Bulk Report Transmit ICSR

Enabled Modules

You can use this menu option to enable or disable the usage of particular Oracle Argus
modules such as Oracle Argus Affiliate, Centralized Coding, FAR, or Oracle Argus
Interchange.

The the new CFG_MODULES table stores module names in individual columns.
Enabling or disabling a module in the Ul checks or unchecks the module flag in the
table. For fresh installations, license keys are created in the table without any
CMN_PROFILE key entries. Enabled modules are migrated per user setup during
upgrade. CMN_PROFILE key entries are removed from the table as part of the
upgrade.

The out of the box configuration of the following modules is as follows:

Module Name Enabled or Disabled
Oracle Argus Affiliate Enabled
Oracle Argus Dossier Disabled
Oracle Argus Insight Disabled
Oracle Argus Interchange Enabled
Oracle Argus Safety Japan Disabled
BIP Reporting Disabled
Central Coding Disabled
Oracle Argus Affiliate Enabled

The Reconciliation and the Documentum modules are no longer part of the
configurations list.
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Interchange Mapping

You can use this menu option to access the ESM Mapping Utility from the Oracle Argus
Console Web instead of from the client server network. The ESM Mapping desktop utility is
part of the Oracle Argus Cloud hosting and is used only for the setup and configuration of the
Service INI File.
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Code List Configuration

This chapter allows administrators to configure and maintain code lists in Oracle Argus Safety
through Argus and the Flexible Data Re-categorization feature.

These are detailed in the following sections:

*  Configuring Code Lists > Argus

»  Configuring Code Lists > Flexible Data Re-Categorization

Configuring Code Lists > Argus

Code List items appear at several locations in the Case Form. It is essential to configure
relevant Code List items in order to ensure that case entry in Oracle Argus Safety is done
according to your company's policies. Before configuring Code List items, the Administrator
should consult the company's policies and the terminology used by the company.

To ensure that the Administrator does not have to enter excessive amounts of data during
Code List configuration, Oracle Argus Safety is shipped with factory data for many of the
Code List items.

Tip:

The following Code List Items have been described to familiarize you with the Code
List configuration.

e For the complete set of Code Lists refer to the Argus Console > Code
List section.

e The default help text associated with each code list item is displayed at the
bottom of the left panel.

Code List Item Description

Autosignals This screen helps in capturing Auto Signal information. Users can define the
criteria that triggers Autosignal within Oracle Argus Safety.

Batch Reports This screen helps in capturing Batch Reports information.

Letters The screen helps in configuring the system to create and schedule letters
automatically, according to pre-defined business rules.

Justification This screen helps in capturing justification information.

Electronic Transmission This screen helps in capturing electronic transmission recipient information.

Recipient

Literary Citation This screen helps in capturing information about Literary Citations.

Reporting Destination  This screen helps in capturing Reporting Destination information.

Routes of This screen helps in capturing Routes of Administration information.
Administration
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Code List Item Description

Study Center

This screen helps in capturing Study Center information.

For more information, see:

Configuring Autosignals

Configuring Batch Reports
Configuring Letters

Configuring Justifications
Configuring Electronic Transmission
Configuring Event Groups
Configuring Literary Citations
Configuring Message Type
Configuring Reporting Destination
Configuring Routes of Administration
Configuring Study Center
Configuring Holiday Calendar

Other Code List Items

Configuring Autosignals

This screen enables you to capture the Auto Signal information.Using this screen, you
can define the criteria that triggers Autosignal within Oracle Argus.

For the example: If an event is reported within X number of days, an email is sent to
the defined individual or workgroup. The system checks for patterns each time new
data is entered, and sends e-mails to the appropriate individuals or departments on
finding a matching pattern.

Select Code Lists > Argus to view the Code List Maintenance screen.

Q Tip:

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured. The details of this code list item appear in the

right panel.

For more information, see:

Field Descriptions

Field Descriptions

The following table describes the fields associated with this section.

ORACLE
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Field or Control Name Description

Name Enables the user to enter the name of the Autosignal. This is a required field.

Number of Occurrences Enables the user to enter the number of occurrences of the autosignal.

Occurrences of Enables the user to enter the user to select or create an advanced condition

for the autosignal through Select icon.

Number of days Displays the number of days for the autosignal.

As cases are entered Enables the user to perform autosignal as cases are entered.

Every N Days Enables the user to enter the number of days, when autosignal should be
executed.
Email Enables the user to enter the email address of Argus users to whom the

email about autosignal occurrence should be sent.

Use the following procedure to configure Autosignals.

1.

10.
11.
12.

13.

14.

Click on the Autosignals folder in the left panel. The associated autosignal data appears
in the Total Number of Rows section in the right panel.

Click on the Name (or row), to view the details associated with the selected autosignal.
The details appear in the Modify Autosignal section.

You can use the Autosignals Filter to make your search specific to an autosignal. The
filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.

* Alternativley, click Add New to create a new auto signal.

» Click Copy to make an editable copy of an existing autosignal.

* Click Delete to delete a selected autosignal.

Enter the name of the autosignal in the Name field.

Enter the number of occurrences of the autosignal in the Number of Occurrences field.

Select or create an Advanced Condition, if any from the button in the Occurrences of
field.

Enter the number of days for the autosignal under the Number of days field.
Select the As cases are Entered checkbox to perform autosignal as cases are entered.

Enter the number of days when the autosignal should perform under the Every N Days
field.

Enter the e-mail address that receives email about autosignal occurrence in the Email
field.

Click Save to save the changes made to this screen.
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Configuring Batch Reports

This screen enables you to configure Batch Reports information.

» Scheduled reports can be automatically generated and stored in the database by
Oracle Argus Safety Service. This screen displays a list of all the existing Batch
Reports.

* By default the Batch reports shown are memorized reports. The Oracle Argus
Safety user can see the list of scheduled reports for memorized reports, using the
Memorized Reports option.

» toview the Code List page, select Code Lists > Argus, and click the Batch
Reports folder in the left panel.

The associated report data appears in the Total Number of Rows section in the right
panel.

Tip:

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured. The details of this code list item appear in the
right panel.

For more information, see:

* Field Descriptions

Field Descriptions

The following table describes the fields associated with this section.

Field or Control Description

Name

Title This is the unique name for the batch report name.
Report Enables you to select a report that has to be scheduled.

* Report Regeneration
*  Memorized report

Product Enables you to select a product for which the report is generated.

Frequency: Every Enables you to enter the number of days after which the report is to be

Days. generated. The value has to be greater than 0.

Next Run Date Enables you to enter the next date from which the report has to be
scheduled.

Advanced Condition  Enables you to select the Advance Condition that satisfies the criteria
which will trigger the Signal. You can either select an existing criteria or
create a new one.

Report Type Enables you to select the type of the report.

Group Enables you to select the group to which the report must be assigned.

Use the following procedure to configure Batch Reports
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14.
15.
16.
17.
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Click the Report Title (or row), to view the details associated with that report. The details
appear in the Modify Batch Report section.

Use the Batch Reports Filter to make your search specific to a batch report. The filtering
criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value
Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.

Tip:
You can alternatively click Add New to create a new report.

« Use Copy to make an editable copy of an existing report.

e Use Delete to delete an existing report.

Enter the Title Name for the batch report.

Select the Report Type from the drop-down list.

Select the Group to which the report must be assigned.

Select the report to be scheduled as Memorized Reports or Reports Regeneration.

Select the Frequency of generating the report after the specified number of days have
elapsed.

Select the Product for which the report is to generated, from the drop-down list box.
Select the Report from the drop-down list.

Enter the Next Run Date. This is the next date from which the report has to be scheduled.
Select the Advanced Condition associated with the report configuration.

Click Select icon to launch the Advanced Conditions browser.

Click Save to save the changes made to this section.

Configuring Letters

Oracle Argus Safety enables the customizing of letter templates in order to correspond with
reporters or health officials and keep them updated with case activity. Access to the Letter
Configuration dialog can be granted to any user or user-group, as found appropriate by the
Administrator.

ORACLE

To automatically generate a letter, the system reads a template that specifies the
information that must appear in the letter.

The template is a file in Rich Text Format (.rtf format) that contains the letter text and
some field identifiers (also called placeholders). The system substitutes information
specific to the current case for the placeholders in the template. Thus, a letter containing
case-specific information is automatically generated.
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*  The administrator can set up the system to create and schedule letters
automatically, according to pre-defined business rules. This section discusses the
creation, modification, and deletion of letter templates.

Select Code Lists > Argus to view the Code List page.

Tip:

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured.
The details of this code list item appear in the right panel.

Configuring letter (RTF) templates
RTF Document can be created using the required placeholders such as:

[patient_last_name], [product_name]:[n], [rec_vacc_date]:[n]:[m],
[event_prior_hist:primary_event], [reg_report_timeframe]

Most of the placeholders have one parameter or two and these are almost always
linked to sort order.

Here are some examples of how these placeholders extract data:

For single value columns:
[age],[case_id],[comments],[case_status],[country_of inc]

For multiple value columns:

[event_death:primary_event] picks data from case_primary_event table
[event_death]:[n] picks data from case_event/lam_event table based on Sort order
[case_notes]:[n], [concentration]:[n],[drug_code]:[n]

For multiple parameter columns:

[ingredient]:[n]:[m] - It lists nth case product and lists its mth ingredient

For more information, see:

*  Field Descriptions

Field Descriptions

ORACLE

The following table describes the fields associated with this section.

Field or Control Description
Name
Name Enables you to specify the name of the letter as it will appear in the

Letters menu.

Name (J) Enables you to specify the Japanese name of the letter as it will
appear in the Letters menu.

Edit Template Enables you to open the letter (template) for editing. Use only
WordPad for editing letter templates.
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Field or Control Description
Name
Regulatory Cover Enables you to indicate whether this letter template should appear in
Letter the Regulatory Rules dialog Cover letter drop-down list box.
The available options are: No, Yes — RTF Format, and Yes — PDF
Format.
Schedule - Letter Enables you to enter the number of days (from the receipt date) when

the letter will be due.

Schedule - Action The Action field enables the Administrator to specify the number of

days (from the current date) after which the Action Item for following up
on this letter will be due.

Sites Argus Console provides the ability to configure letters to user sites.

Enables users to select single or multiple sites for that letter. The
system will only allow users to see letters that are configured to their
site.

Action Items The action items list is a drop-down list of action item codes from the

Action Type List Maintenance.

Return Email Address Enables you to enter a default email address where the mails will be

sent. This address is displayed by default in the Activities tab of the
Case Form.

Advanced Condition Enables you to configure Advanced Conditions. If the case matches

with the Advanced Condition, the configured letter is scheduled for the
case.

Use the following procedure to configure letters.

1.

9.

ORACLE

Click the Letter Configuration folder in the left panel. The associated data appears in
the Total Number of Rows section in the right panel.

Click the Name (or row), to view the details associated with that letter. The details appear
in the Modify Letter Configuration section.

Use the Letter Configuration Filter to make your search specific to a letter. The filtering
criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.
Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.

Tip:
You can alternatively click Add New to create a new letter.

* Use Copy to make an editable copy of an existing letter.

e Use Delete to delete an existing letter.

Click Select to specify the path of the letter template to be used.
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14.

15.

16.

17.
18.
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Tip:

Click Edit Template to save the existent template on to your local drive
of the system.

You can edit this template and repeat the step listed above, to ensure
that the updated template is used for letters.

Enter the name of the letter, as it will appear, in the Letters Menu section in Enter a
new item.

Click Add or Delete to configure letter to the user Sites.

Select the Action Item from the drop-down list box. The action items list is a drop-
down list of action item codes, from the Action Type List Maintenance.

Configure the Advanced Condition for the case.

Enter the Schedule (days)-Letter. This is the number of days from the receipt date
when the letter is due.

Enter the Schedule (days)-Action. This is the number of days from the current
date, after which the Action Item for the follow up on this letter will be due.

Enable the Regulatory Cover Letter option to indicate whether this letter template
should appear in the Regulatory Rules dialog.

Enter the default e-mail address in Return Email Address.

Click Save to save the changes made for this section.

Letter Placeholder for the IND Cover Letter

You can define a placeholder for the IND_SIMILAR_EVENTS table. The system
uses data from this table to populate the Case Number, Protocol Number, Subject
ID, and Adverse Event terms for previously submitted cases reporting the same
events.

If no reports were submitted, the system prints None Submitted instead of the
table.

The placeholder only prints this information when it is used in the cover letter for
the Regulatory Report. The system uses the license associated with the scheduled
report to track other cases where the same product license was previously
submitted for the same events in the current case.

Configuring Justifications

This screen enables you to capture justification information.

ORACLE
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CODE LIST MAINTENANCE
Organized by | Code List v
<] [ Contains v
e = Il I [iter ]
(i Type Dispaying v T Poces BT IEEIEN P
[ZCase Classification ETS TR
EaCausalty Category [Acton Code Notspecilied
[aCausalty Method /Action tem Camplation Date Not specifed
|Action Item Description Not specified
(Xaclinical Reference Type |Action tem Descripton (3) Not Specifed
[aCondiion Type [Acton kem Due Date Notspeciled
a |Action Item Group Not specified
[AContact Type |Action Item Open Date Not specified
[ACountries. |Action Item Responsibility Not speciied
[4Date Ranges. |Additional manufacturer narrative Not specified
—— |Address Notspecilied
eiivery Types |Advanced Condion Hit List Case Notspeciled
[ ADevice Preliminary Comments. |As Determined Listedness Not specified
RDvice Subcomponents [Assocated Accessaries Not specifed
- |Associated Devices Notspeciled
(aDevics Type [Atachment Classifcation Notspecifed
[aDosage Frequency [Atachment Keywords Notspecilied
. [Atachment Keywords (J) Not Specifed
[SDosage Units |Attachment Notes Not specified
[ JElectronic Transmission Recipient | Attachment Notes (J) Not Specified
} Au Number Notspecilied
[ JEthnicit P
v ation Type Not speciied
Result Availabiity Not specified
DEvent Frequency [Avatabtty of Device Notspeciled

. AW Causalty Notspeciled
CaEvent Groups Bl Not specifed
[Event Intensity Body Area Notspecilied
DREvent Oceurred as Consequence of Case Abbreviated Narative Not speciled
Case Abbreviated Narative (1) Not Speced

Zavent Ovtcome Case Assessment Evaluation Comment Not speciied
[ etal Outcome Case Assessment Evaluation Comment (1) Not Specified

- Case Contral Safety Date Not speciied
(AFormulation Case Classifcation Notspecilied
[Gender Case Closed By Not specifed
ERHolidey Calondar (Cass Closure Date Not speciied

- Case Closure Notes Not specifed
ingragients o S ]
Cinstuton Case Comment Text () Not Speciied
aintomodary Gasedagnosi s repored ot specied .
25 Juscations | T T om
[Z3Lab Resut Assassment Terms -

Oracle Argus Safety users can enter the reasons for overriding system determinations using
the Justifications dialog. The Justification items appear on the Action Justification dialog on
the screen.

Select Code Lists > Argus to view the Code List page.

Q Tip:

The code list items are displayed in the left-panel. Click the required Code List
folder to be configured.
The details of this code list item appear in the right panel.

For more information, see:

» Field Descriptions

Field Descriptions

The following table describes the fields associated with this section.

Field or Control Description
Name

Type Enables you to configure the type.

Justification Enables you to enter the justification.

Use the following procedure to configure justification.

1. Click the Justifications folder in the left panel. The associated report data appears in the
Total Number of Rows section in the right panel.

2. Click the Type (or row), to view the details associated with that justification. The details
appear in the Modify Justification section.
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3. Use the Justifications Filter to make your search specific to a justification. The
filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

6. Enter the justification reason in Justification.

7. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Q Tip:
You can alternatively click Add New to create a new justification.
e Use Copy to make an editable copy of an existing justification.

e Use Delete to delete an existing justification.

8. Select the Type from the drop-down list.
9. Enter the Value for the justification.

10. Click Save to save the changes made for this section.

Configuring Electronic Transmission

This screen enables you to configure electronic transmission recipient information.

» Details of electronic transmission recipient such as name, title, address etc. are
submitted here.

* Select Code Lists > Argus to view the Code List page.

CODE LIST MAINTENANCE

Electronic Transmission Recipient Filter

Field Value

< <] [Contans ol ) e

Total Number of Rows (2)

Name Address Country. Phone
Title. City/State/Province Postal Fax

Rajani 9886289874
Mrs 123124214
\Veena-Test 123124214

[ raaver [ I |-

"Add New Electronic Transmission Recipient

¥ Name Address StatelProvince Phone
|

[ [ ]
Tite Country Fax
[ [ ]
city Postal Cods Emai

recipient such as name, flle, address stc. are subitted
here
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Tip:

The code list items are displayed in the left-panel. Click the required Code List
folder to be configured. The details of this code list item appear in the right panel.

more information, see:

Field Descriptions

Field Descriptions

ORACLE

The

following table lists and describes the fields associated with this section.

Field or Control Name Description

Name Enables you to enter the name of Electronic Transmission Recipient.

Title Enables you to enter the title of Electronic Transmission Recipient.

Address Enables you to enter the address of Electronic Transmission Recipient.

City Enables you to enter the city of Electronic Transmission Recipient.

State/Province Enables you to enter the state/province of Electronic Transmission
Recipient.

Country Enables you to select your country.

Postal Code Enables you to enter the postal code of Electronic Transmission Recipient.

Phone Enables you to enter the phone number of Electronic Transmission
Recipient.

Fax Enables you to enter the fax of Electronic Transmission Recipient.

Email Enables you to enter the email of Electronic Transmission Recipient.

Preferred Method Enables you to select the preferred method of transmission from the drop-

down list. This can be by fax or by email.

Use

1.

the following procedure to configure the electronic transmission recipient.

Click the Electronic Transmission Recipient folder in the left panel. The associated
data appears in the Total Number of Rows section in the right panel.

Click the Name Title (or row), to view the details associated with that electronic
transmission. The details appear in the Modify Electronic Transmission Recipient section.

Use the Electronic Transmission Recipient filter to make your search specific to an
electronic transmission recipient. The filtering criterion is essential as it helps you to
search for specific items

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.
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Q Tip:

You can alternatively click Add New to create a new electronic
transmission recipient.

* Use Copy to make an editable copy of an existing electronic
transmission recipient.

* Use Delete to delete an existing electronic transmission recipient.

8. Enter the Name of the electronic transmission recipient.

9. Enter the Title of the electronic transmission recipient.

10. Enter the Address of the electronic transmission recipient.

11. Enter the City of the electronic transmission recipient.

12. Enter the State/Province of the electronic transmission recipient.

13. Select the Country of the electronic transmission recipient, from the drop-down
list.

14. Enter the Postal Code of the electronic transmission recipient.
15. Enter the Phone of the electronic transmission recipient.

16. Enter the Fax of the electronic transmission recipient.

17. Enter the Email of the electronic transmission recipient.

18. Select the Preferred Method of communication (by fax or email) for the electronic
transmission recipient.

19. Click Save to save the changes made to this section.

Configuring Event Groups

This screen enables you to configure Event Groups information.

Business | Access | system i [ Tools

[ codeusts |

CODE LIST MAINTENANCE

Event Groups Filter
Code List o || Field Value ‘

Organized by
~ | [ Contains v

[ AClinical Reference Type A
-[ACondition Type

~[AContact Type

~[ACountries

[ dDate Ranges

Total Number of Rows (2)

Event Group Name. .
intestinal disorder
Intestinal Disorders.

~[Delivery Types

~[Device Preliminary Comments
~[Device Subcomponents

-~ [Device Type

- [iDosage Frequency
~[Dosage Units

| AddNew |[ copy || Delete |[ Pt

Modify Event Group

¥ Event Group Name
Intestinal Disorders

~[Electronic Transmission Recipient
-~ CEthnicity

~[JEvaluation Reason

Torms (4) \

# | Torms

|
- _lEvent Frequency Event Groups | smQ

Term Type
O 1. | Intestinal fibrosis PT

O2. | Pepic uicer PT

(3. | Hepatobiliary disorders soc
(4. | Intestinal infections HLT

(.5 Event Groups

[ JEvent Intensity

-~[JEvent Occurred as Consequence of
~[Event Outcome -

RRKIES

The values entered here will appear in the Console-
>Business Configuration->Products and Licenses- ~
>Product Family->Datasheet->Add Event Groups.

AddTerm | Jl Export || impot ||  save

e The list of terms which are used across labeledness determines are defined in a
central location for users. These users can update these event groups (list of

ORACLE"
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terms) when the product configuration updates are required or when MedDRA versions
are upgraded when MSSO releases the new MedDRA updates.

The values entered here and marked as Display appear in the Console > Business
Configuration > Products and Licenses > Product Family >
Datasheet > Add Event Groups section.

For more information, see:

Terms tab

Event Groups tab

*  SMQ tab
Terms tab
The following table describes the fields associated with Event Groups > Terms tab.
Field Name Description
Event Group Name Allows you to enter a new Event Group name.
Event Group Name (J) Allows you to enter a new Event Group name in Japanese. This screen and
its print form will be visible to only the Japanese users.
Display Allows you to display the Event Group in Business Configuration >
Products and Licenses > Product Family > Datasheet
Terms The Terms tab contains terms selected from the MedDRA browser. These
terms are displayed in the following format for English users:
MedDRA Term in English
These terms are displayed in the following format for Japanese users:
MedDRA Term in English (MedDRA Term in Japanese)
The count of the total number of MedDRA terms present for the case is
displayed on the header of the Terms tab.
Term Type Displays the type of the MedDRA term. This field can contain the MedDRA
term type values such as PT, HLT, HLGT or SOC.
Use the following procedure to configure Terms:
1. Click Event Groups on the left pane of the Code List.
Use the Event Group Filter on the right pane, to make your search specific to an event
group. The filtering criterion is essential as it helps you to search for specific items.
2. Select the appropriate Field as the filtering criteria from the drop-down list.
3. Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.
4. Enter the search criteria in Value.
5. Click Filter to apply the selected criteria.
6. This displays the search results under Total Number of Rows.
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Tip:
You can alternatively click Add New to create a new event group.
* Use Copy to make an editable copy of an existing event group.

e Use Delete to delete an existing event group.

Enter the name of the event group under Event Group Name.

If it is also required for a Japanese user, enter the Japanese name of the event
group under Event Group Name (J).

Check the Display checkbox to display the Event Group in Business
Configuration > Products and Licenses > Product Family >
Datasheet.

Click Export (or Import) to export (or import, respectively) a file in a valid file
format from (or into) your local system. Valid file formats require that the file be
in .xlIs, .xlIsx, or .csv formats.

Important: The format of the data in the csv, xls or xIsx file must be as follows:
It must have only a single column of data. An import file can have ~ 16 K Terms.

The first/header row must have text as "PT" or "HLT" or "HLGT" or "SOC" in upper
or lower case.

All the rows below the header row must contain corresponding terms (text) such
as PT text or HLT text or HLGT text or SOC text.

Click Save to save the changes made to this tab.

Event Groups tab

ORACLE

Click the Event Groups tab to configure event groups.

The following table describes the fields associated with Event Groups > Event
Groups tab.

Field Name Description

Event Groups The Event Group, selected from the Select button > Available Event

Groups dialog, is displayed as follows:
Event Group Name in English

The event group name is displayed in the following format for Japanese
users:

Event Group Name in English (Event Group Name in Japanese)

The count of the total number of Event Group Names present for the
case is displayed on the header of the Event Groups tab.

Select button Click this button to select the relevant event groups from the Available

Event Groups dialog.

This dialog displays the event groups in a tree-format, with the child
event groups being paired under the parent event groups.
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Click the SMQ tab to configure SMQ terms.

The following table describes the fields associated with Event Groups > SMQ tab.

Field Name Description

SMQ The SMQ term is selected from the Add button > MedDRA Browser dialog.

On clicking the Add button, the MedDRA Browser is displayed, as shown below:

MedDRA Browser — Webpage Dialog
MedDRA Browser

Terminology | MedDRA J Brows V23.0J v | MedDRA SMQ: | v (O Full search [ Clear |
Search All Levels ‘ ‘ () Include Non-current terms
soc HLGT HLT PT LLT Synonyms
metabolism ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘
Metabolism and nutrition Acid-base disorders Alcohol related nutritional disorders  Anorexia and bulimia syndrome Anorexia nervosa
disorders Appetite and general Anorexia nervosa and bulimia Anorexia nervosa Slimmers disease
nutritional disorders Appetite disorders Bulimia nervosa
Bone, calcium, magnesium and General nutritional disorders NEC  Diabulimia
phosphorus metabolism Hypersomnia-bulimia syndrome
disorders
Diabetic complications
Electrolyte and fluid balance
conditions
Food intolerance syndromes
Glucose metabolism disorders
(incl diabetes mellitus) v
soc 10027433 Metabolism and nutrition disorders
HLGT 10003018 Appetite and general nutritional disorders
HLT 10002650 Anorexia nervosa and bulimia
PT 10002649 Anorexia nervosa
LLT 10041023 slimmers disease
Synonyms
|| Prnt || cancel

The Export button is enabled in two scenarios - when MedDRA is opened from:i) Argus
Console > Business Configuration > Products and Licenses > Product
Family > Datasheetor, from:ii) Argus Console > Code Lists > Argus > Event
GroupMedDRA terms are selected at any level of the MedDRA hierarchy. On clicking this
button, a dialog is displayed, that allows you to select the file type - .csv / .xIs / .xlIsx file.On
specifying the file type, the selected PT terms are then exported in the Export file. in the <PT
terms> format.

Import:

This button is enabled in two scenarios - when MedDRA is opened from:i) Argus Console
> Business Configuration > Products and Licenses > Product Family >
Datasheetor, from:ii) Argus Console > Code Lists > Argus > Event
GroupMedDRA terms are selected at any level of the MedDRA hierarchy. On clicking this
button, a dialog is displayed, that allows you to browse and upload a .csv / .xIs / .xlIsx file from
the desired location on your local machine. The format of the data in the selected file should
be as follows:It should have only one column of data. The first header/row must display 'PT'
or 'HLT' or '"HLGT' or 'SOC".All the rows under the header row should contain corresponding
terms such as PT text, or HLT text, or HLGT text, or SOC text. The MedDRA terms in the file
should be matched against the MedDRA terms table at the level specified in the header row.
Duplicate terms within the import file should be ignored. If the user enters a search criteria at
any levels of the MedDRA hierarchy and continues to search for terms, the results obtained
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from the Import
Import button.

Save:

The Save butto

will be lost. The user may need to import terms again, using the

n is enabled only on selection of the PT term(s).

Configuring Literary Citations

This screen enables you to configure information about Literary Citations.

*  The information configured in this form is displayed in the Literature Info section of
the Case Form.

 Select Code Lists > Argus to view the Code List Maintenance screen.

[_cometin | suness Contgurion

| Access Management System Configuration Tools

CODE LIST MAINTENANCE

Organized by | Code List ~

1L Literary Citation
Camment Type

Q Tip:

Volume Pages
2 Yoar Digital Object Identifier
I 1234567890123456789012345678901234567890
Anexplorativ sudy ofmrsing schlars and cotemporary scholashp o1 1zasseTeS0asE Oz SO TE 23456000
12345670%01234567650
W 12038t
Role of Vaccines in Public Heath [ o
an .. a6
| I ||
"Add New Litraturo itation
¥ Journal 1 Author Title.
Volume Year Pages
Dightal Object dentier Country of Publication Study 1 Tria Clssifcaton
Note: iicking on the SAVE button wll rflctthe changes made on ths English screen (0 the Japaness pop-up

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured. The details of this code list item appear in the
right panel.

For more information, see:

» Field Descriptions

Field Descriptions

The following table lists and describes the fields associated with this section.

ORACLE"
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Field or Control Description

Name

Journal Configures the name of the journal where the citation appears. This is a
required field.

Author Configures the name of the author.

Title Configures the title of the citation.

Volume Configures the volume number of the journal where the citation appears.

Year Configures the publication year of the journal where the citation appears.

Digital Object Identifier Configures the digital object identifier.

Pages Configures the number of pages in the journal where the citation appears.

Country of Publication  Captures the country of publication of the literature.

Study/Trial Captures the Study / Trial classification for the literature.
Classification

Use the following procedure to configure literary citations.

1.

10.
11.
12.
13.

Click the Literary Citations folder in the left panel. The associated data appears in the
Total Number of Rows section in the right panel.

Click Journall/Author (or row) to view the details associated with the literary citation. The
details appear in the Modify Literature section.

Use the Literary Citation filter to make your search specific to a citation. The filtering
criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.

Tip:

You can alternatively click Add New to create a new citation.

« Click Copy to make an editable copy of an existing citation.
* Click Delete to delete a selected citation.

e Click Print to print the selected information as a PDF.

Enter the name of the journal in the Journal field.

Enter the name of the author of the citation in the Author field.
Enter the title of the citation in the Title field.

Enter the Volume Number in the Volume field.

Enter the year in the Year field.

Enter the digital object identifier in the Digital Object Identifier field.
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14. Enter the number of pages in the Pages field.

15. Click Save to save the changes made.

Configuring Message Type

This screen enables you to configure information about message type.

*  The message type specified in this section enables you to specify auto-submission
of reports.

e Select Code Lists > Argus to view the Code List Maintenance screen.

[ |

CODE LIST MAINTENANCE

EE—
T T —

nents -

nnnnnn

[AGender
[Hoiiday Calendar

() Expedited
Mark a5 Auto Submit & Display
] play

Q Tip:

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured. The details of this code list item appear in the
right panel.

For more information, see:

*  Field Descriptions

Field Descriptions

The following table lists and describes the fields associated with this section.

Field or Control Description
Name
Message Type Displays the message type for a report.
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Field or Control Description
Name

Expedited/Periodic Displays if the message type is expedited or periodic.

# Note:

By default, ICHICSR is considered as
Expedited, while the other message types
are considered as Periodic.

Description Displays a description about the message type.
Auto Submit Displays if the report has been auto submitted.
Display Displays if the report needs to be displayed or hidden.

Use the following procedure to configure message type.

1.

10.
11.
12.
13.

Click the Message Type folder in the left panel. The associated data appears in the Total
Number of Rows section in the right panel.

Click Message Type (or row) to view the details associated with the message type. The
details appear in the Modify Message Type section.

Use the Message Type filter to make your search specific to a message type. The
filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.

Tip:

You can alternatively click Add New to create a new message type.

* Click Copy to make an editable copy of an existing message type.
e Click Delete to delete a selected message type.

e Click Print to print the selected information as a PDF.

Enter the type of message in the Message Type field.

Enter the description for the message type in the Description field.

Click the Expedited checkbox if the message type is for an expedited report.
Click the Mark as Auto Submit checkbox if you wish to mark for auto submission.
Click the Display checkbox if you wish to display the message type.

Click Save to save the changes made.
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Configuring Reporting Destination

Regulatory reports are submitted to the Reporting Destination. Local company contact
information is also provided on this screen.

Use the following procedure to configure reporting destination:

1. SelectCode Lists > Argus to view the Code List Maintenance screen.
2. Click Reporting Destination on the left pane of the Code List screen.

For more information, see:

e Agency Information

* Local Company Contact

»  Configuring EDI

»  Configuring the Base Directory Path

« SMTP

Agency Information

The Agency Information tab is displayed by default, on selecting Reporting
Destination.

[ comuss |

CODE LIST MAINTENANCE

Reporting Destination Filter

Organized by  Code List v P o ke

7] [Contans

[3Event Outcome
Total Number of Rows (49)

[3Fetal Outcome

Ragulatory Authortty

CORH-eMDR_I

Regulatory Authority

Division

[aRoute:
Lastudy Center

23130

Name. Agency Type Department Registration # FAX FAX Cover
(HA} EUROPE EVPM-New Raguiatory Authority Drug Raporting Division 1394-3945
BP}Best Devices Regulatory Authority Department of Devices
dSu
rveilanc:
{(HA} EUROPE EVPM 13943945
{HA) Germ
(HA} ITALY DEVICE
1A} Spain Ragulatory Authority 1394.3945
{(HA) SPAIN DEVICE
{ZLab Result Assessment Terms.
CLeb Ton Group {HA) SPAIN DEVICE PDF
HA) TURKEY DEVICE
Catab Test Type HA} UNITED STATES CDERR2  Regulatory Authority 1-394-3045
urati HA} UNITED STATES EVAERS  Regulatory Authority
HA} UNITED STATES EVPMR2  Regulatory Authority 13943945
HA} UNITED STATES ICH_R2. 1-394-3945

CORH-aMDR M Regulatary Authory 3
Corepris Ragulatary Autnorty Masico Dapartmnt for SR

Manutactuer
Copy o test agancy e -

'Add New Reporting Destination

ooy [ I

|

Contact Information
Title

First Name Middle

Last

Address

Field Descriptions

The fields under the Agency Information tab are described in the following table:

\gency Information | Local Company Contact Eol suTP -
[aReference Type Preferred Method

Agency Namo referred Mot Contact Type
[aReport Media ¥ Ageney o >

v| O Manufacturer

(Report Type Agency Type Registration # () importer
[3Reporter Information P
[aReporer Type Department Fax
25 Ropor sentative
IRepor Email Address FAX Cover

Field or Control

Name

Description

Address 1

Enables you to enter the address of the regulatory contact in line 1.

ORACLE"
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Field or Control
Name

Description

Address 2
Agency Name
Agency Type

Allow WHO Drug
reporting

Attachments
City
Contact Type

Country
Country Code
Department
Email Address

Email Text Body

Ext

FAX

FAX Cover

First Name

Last

Middle

Offline Recipient
Phone

Postal Code

Enables you to enter the address of the regulatory contact in line 2.
Displays the name of the agency. This is a required field.
Enables you to select the agency type.

Enables you to schedule a report for WHO Drug Reporting.

Enables you to select single or multiple attachments.
Enables you to enter the city of the regulatory contact.

e Manufacturer - Enables you to select manufacturer as the type of
contact

* Importer - Enables you to select importer as the type of contact
»  Distributor - Enables you to select distributor as the type of contact

*  Authorized Representative - Enables you to select the Authorized
Representative as a type of contact.

Enables you to enter the country of the regulatory contact.
Enables you to enter the country code of the regulatory contact.
Enables you to enter the name of the department.

Enables you to enter the email address of the agency.

*  Select - Enables you to select a .txt or .rtf file to be uploaded.

< Note:

The file should be in .txt, or .rtf format.

After the uploaded file is saved, the Edit button displays a clip
button, denoting an attachment.

- Edit - Enables you to open the uploaded file / text in a word
document from the server and edit the text inside it. If no file was
uploaded earlier, a blank document is opened.

# Note:

You can save the edited document on the local machine
and click Select to save the file.
Enables you to enter the extension number of the regulatory contact.
Enables you to enter the FAX Number.
Enables you to enter the FAX Cover.
Enables you to enter the first name of the regulatory contact.
Enables you to enter the last name of the regulatory contact.
Enables you to enter the middle name of the regulatory contact.
Enables you to configure the regulatory agency as an offline agency.
Enables you to enter the phone number of the regulatory contact.

Enables you to enter the postal code of the regulatory contact.
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Field or Control
Name

Description

Preferred Method
Registration #

Report for
Investigational
Licenses

Report for Marketed
Licenses

Report per Email

State/Province
Title

FAX

Contact Type

Enables you to select the preferred method of agency information.
Enables you to enter the registration number.

Enables you to select if the reports are to be investigational always or
only for clinical case or no marketed license.

Enables you to select whether reports are to be marketed always or
only for the Spontaneous cases or no Investigational.

Enables you to enter the number of reports to be received in each
email.

Enables you to enter the state/province of the regulatory contact.
Enables you to enter the title of the regulatory contact.
Enables you to enter the fax number of the regulatory contact.

Enables you to select the Authorized Representative, Manufacturer,
Importer, or Distributor check box.

Use the following procedure to configure agency information.

1. Selectthe Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section displays the
information about the selected code list.

2. You may use the Reporting Destination filter to make your search specific to an
agency. The filtering criterion is essential as it helps you to search for specific

items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip:

You can alternatively click Add New to create a new agency information.

« Click Copy to make an editable copy of an existing agency
information.

e Click Delete to delete the selected agency information.

e Click Print to print the selected information as a PDF.

7. Enter the name of the agency in the Agency Name field.

8. Select the type of agency in the Agency Type field.

9. Enter the department in the Department field.
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11.

12.
13.
14.
15.

16.

17.
18.
19.
20.
21.
22.
23.
24,

25.
26.
27.

28.
29.

30.
31.

32.

33.

34.
35.
36.
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Enter the email address in the Email field. Multiple e-mail addresses must be separated
by a comma (,), and not by a semi-colon (;). If you separate the email addresses by a
semi-colon, the transmission service will fail.

Select the preferred method from the Preferred Method drop-down list. The options
available are Fax or Email.

Enter the registration number in the Registration # field.
Enter the Fax Number in the FAX field.
Enter the Fax Cover in the FAX Cover field.

Select the preferred contact type by clicking the checkboxes available under Contact
Type.

The options available are Manufacturer, Importer, Distributor, and Authorized
Representative.

Select the Offline Recipient checkbox to configure the regulatory agency as an offline
agency.

Select the Title of the regulatory contact. The options available are Mr., Miss and Mrs.
Enter the first name of the regulatory contact under the First Name field.

Enter the middle name of the regulatory contact under the Middle field.

Enter the last name of the regulatory contact under the Last field.

Enter the postal contact address of the regulatory contact under the Address 1 field.
Enter the phone number of the regulatory contact under the Phone field.

Enter the extension number of the regulatory contact under the Ext field.

Enter the country code to be dialed in calling up the regulatory contact under the Country
Code field.

Enter the fax number of the regulatory contact under the FAX field.
Enter the fax extension humber of the regulatory contact under the Ext field.

Enter the country code required in faxing up the regulatory contact under the Country
Code field.

Enter the name of the city where the regulatory contact lives in the City field.

Enter the name of the state/province where the regulatory contact lives in the State/
Province field.

Enter the name of the country where the regulatory contact lives in the Country field.

Enter the postal code of the place where the regulatory contact lives in the Postal Code
field.

Enter the number of reports that need to be sent in every email to the regulatory contact
in the Report per Email field.

Select whether to send single or multiple attachments with emails through the
Attachments drop-down list.

Select how the report is to be marketed from the Report to be marketed drop-down list.
The options in this list are Always or Spontaneous or No Investigational.

Select the Allow WHO Drug Reporting checkbox to schedule the report for WHO Drug
Reporting.
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37. Select the type of reports as Investigational always or Only for clinical case or
No marketed license from the Report for Investigational drop-down list.

38. Click Save to save the changes made.

Local Company Contact

ORACLE

This section lists the Field Descriptions and configuration steps for the Local Company

Contact tab.

Field Descriptions

The fields the following table lists and describes the fields on the Local Company

Contact tab.

Field or Control
Name

Description

Company Name
Sender Type
Department
Email Address
Lab Code

Event Term on
Expedited Reports

Title

First Name
Middle

Last

Address
Phone

Ext

Country Code
FAX

Ext

Country Code
City
State/Province
Country
Postal Code

Displays the name of the company. This is a required field
Enables you to select the sender type.

Enables you to enter the name of the department.
Enables you to enter the email address of the agency.
Enables you to enter the lab code.

Enables you to select the event term on expedited reports.

Enables you to enter the title of the local company contact.
Enables you to enter the first name of the contact

Enables you to enter the middle name of the contact.
Enables you to enter the last name of the contact.

Enables you to enter the address of the contact.

Enables you to enter the phone number of the contact.
Enables you to enter the extension number of the contact.
Enables you to enter the country code of the contact.
Enables you to enter the fax number of the contact.
Enables you to enter the fax extension number of the contact.
Enables you to enter the fax country code of the contact.
Enables you to enter the city of the contact.

Enables you to enter the state/province of the contact.
Enables you to enter the country of the contact.

Enables you to enter the postal code of the contact.

Use the following procedure to configure the local company contact.

1. Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section is populated
with information about the selected code list.

2. Use the Reporting Destination Filter to make your search specific to a company.
The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.
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16.
17.
18.
19.
20.

21.
22.
23.

24,
25.

26.
27.

28.
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Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.

Tip:

You can alternatively click Add New to create a new company contact.

« Click Copy to make an editable copy of an existing company contact.
e Click Delete to delete a selected company contact.

e Click Print to print the selected information as a PDF.

Enter the name of the company in the Company Name field.

Select the type of sender in the Sender Type drop-down list.

Enter the name of the department under the Department field.

Enter the email address of the agency under the Email Address field.
Enter the lab code of the agency under the Lab Code field.

Select the type of event term on preferred reports from the Event Term on Preferred
Reports drop-down list. The options available under this list are Preferred and Lower
Level.

Select the Title of the regulatory contact. The options available are Mr., Miss and Mrs.
Enter the first name of the regulatory contact under the First Name field.

Enter the middle name of the regulatory contact under the Middle field.

Enter the last name of the regulatory contact under the Last field.

Enter the postal contact address of the regulatory contact under the Address field.
Enter the phone number of the regulatory contact under the Phone field.

Enter the extension number of the regulatory contact under the Ext field.

Enter the country code to be dialed in calling up the regulatory contact under the Country
Code field.

Enter the fax number of the regulatory contact under the FAX field.
Enter the fax extension number of the regulatory contact under the Ext field.

Enter the country code required in faxing up the regulatory contact under the Country
Code field.

Enter the name of the city where the regulatory contact lives in the City field.

Enter the name of the state/province where the regulatory contact lives in the State/
Province field.

Enter the name of the country where the regulatory contact lives in the Country field.

Enter the postal code of the place where the regulatory contact lives in the Postal Code
field.

Click Save to save the changes made.
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This section lists the field descriptions and configuration steps for the EDI tab.

Use the following procedure to configure reporting destination:

1. SelectCode Lists > Argus to view the Code List Maintenance screen.

2. Select Reporting Destination on the left pane of the Code List screen. The
screen appears as shown below:

Agency Information | Local Company Contact EDI SMTP

MFDS-O-FR

Message Profile

ICH-ICSR V3.0 MESSAGE TEMPLATE - MFDS CUSTOM ~v| O mark

ACK Profile

ICH-ICSR V3.0 ACKNOWLEDGMENT TEMPLATE - ICH v v Primary Receive Agency

Imported Case are assigned to
<site of importing user>

P2 Transmit ICSR

() Suppress Auto-scheduling

Identification Code. Code Qualifier

() Auto Accept ICSR's

Submission date for ICSR's

Initial Workflow State XML Source Classification Selection Source Classification
v v v v

MIR Report Format o
Allowed iz (in MR)

Field Descriptions

The following table lists and describes the fields on the EDI tab.

Field or Control
Name

Description

SGML/XML

Agency ldentifier

Identification Code

Code Qualifier

Message Profile

Mark as Auto Submit
Auto Accept ICSRs

Submission date for
ICSRs

ACK Profile

Enables you to select whether to send the report in SGML or XML
format. When SGML is disabled and XML is selected, it is populated
with default values and is displayed in the read-only mode for the PMDA
E2 (R3) profile.

Enables you to enter the routing ID configured in Cyclone for the sender
community.

Enables you to enter the agency Duns code, a unique identification
code that identifies the trading partner.

This field is disabled for the E2B(R3), eVAERS, MIR, and eMDR profile.
Populated with default values and is displayed in the read-only mode for
the PMDA E2B R3 profile.

Enables you to enter the code qualifier here. The code qualifier is used
to interpret the identification code.

This field is disabled for the E2B(R3), eVAERS, MIR, and eMDR profile.
Populated with default values and is displayed in the read-only mode for
the PMDA E2B R3 profile.

Enables you to select a message profile among the list of message
profiles displayed.

Enables you to mark the report for auto submission.

Click this checkbox to auto accept ICSRs. This checkbox is visible only
when case numbering is set to Automatic.

Enables you to select the submission date for ICSRs. It is blanked out
and disabled if user selects the eVAERS or eMDR profile in the EDI
Tab.

Enables you to select the acknowledgement profile. This field is
disabled for the eMDR, MIR, and eVAERS profile. The PMDA E2B(R2)
Ack profile is also available now.
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Field or Control
Name

Description

Primary Receive
Agency

Imported Cases are
assigned to

Enables you to select the primary receiving agency.

Enables you to select the country, where the imported cases need to be
assigned.

# Note:

This list comprises the configured Argus
sites. The default value is the site of the
importing user.

Initial Workflow State Enables you to configure the initial workflow state of the case.

XML Source
Classification

Selection Source
Classification

Transmit E2B
Attachments
Attachment

Classification

Identification Code

Company Identifier
Code Qualifier

File Name

SGML Declaration
File

# Note:

This list comprises Argus workflow states,
with the default value being blank. If you
select blank as the workflow state, it is
treated as a new case being booked-in.

The system enables you to configure the XML Source Classification
and the PDF Source Classifications used for classifications defined
while the Source E2B File / PDF for Initial Intake or E2B Differences
report is classified.

When a case is accepted as an initial or follow-up case, the system
attaches the source XML and the Initial Selection PDF to the case on
the Additional Info tab.

This field is disabled for the MIR profile.
Enables you to select the source classification from the drop-down.
This field is disabled for the MIR profile.

Click this checkbox to transmit E2B attachments. If this checkbox is
checked in the Reporting Destination Code List, case form attachments
are sent to the specified reporting destination.

Enables you to select the attachment classification.
This field is disabled for the MIR profile.

Enables you to enter the company Duns code, a unique identification
code that identifies the trading partner. This field is disabled for the
E2B(R3), eVAERS, MIR, and eMDR profile.

Enables you to enter the company identifier.

Enables you to enter the code qualifier here. The code qualifier is used
to interpret the identification code. This field is disabled for the E2B(R3),
eVAERS, MIR, and eMDR profile.

Enables you to enter the file name.

Enables you to enter the SGML Declaration File. This field is disabled
for the E2B(R3), eVAERS, MIR, and eMDR profile.
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Field or Control
Name

Description

Maximum # of reports
to include in the msg

Method

EDI Header Required

XML Version

URL for Message
Schema

Encoding

Allowed Attachment
File Size (in MB)

Allowed Report Size
(in MB)

URL of ACK Schema
Incoming Folder
Outgoing Folder
ICSR Attachment

Outgoing Folder

Suppress Auto-
scheduling

MIR Report format

Enables you to enter the maximum number of reports that will be
transmitted in one message. This field is disabled for the E2B(R3),
eVAERS, MIR, and eMDR profile and set to 1. This parameter can be
used for English E2B(R2) reports. But in case of PMDA E2B(R2), this
parameter should be left blank or set to 1.

Enables you to select a method here. This field contains E2B ESTRI
Gateway and E2b Media values.

Enables you to generate the EDI Header. This field is disabled for the
E2B(R3), eVAERS, MIR, and eMDR profile. Populated with default
values and is displayed in the read-only mode for the PMDA E2B(R3)
profile.

Enables you to enter the XML Version. This field is disabled for the
E2B(R3), MIR, and eMDR profile and set to 1.0. Populated with default
values and is displayed in the read-only mode for the PMDA E2B(R3)
profile.

Enables you to enter the path where the message schema resides on
the internet or enter full path if it is located on the disk. This field is
disabled for the E2B(R3), eVAERS, MIR, and eMDR profile. Populated
with default values and is displayed in the read-only mode for the PMDA
E2B(R3) profile.

Enables you to select the character set encoding used in XML. This
field is disabled for the E2B(R3), eVAERS, MIR, and eMDR profile and
set to UTF-8. Populated with default values and is displayed in the read-
only mode for the PMDA E2B(R3) profile.

Enables you to specify allowed attachment file size (in MB).

This field is disabled for the MIR profile.

Enables you to specify allowed Report size (in MB).

This field is disabled for the MIR profile.

Enables you to enter the path where the ACK schema resides on the
internet or enter the full path if it is located on the disk. This field is
disabled for the E2B(R3), eVAERS, and eMDR profile.

Enter the path to the folder where incoming files are stored.

This field is disabled for the MIR profile.

Enter the path to the folder where outgoing files are stored.
This field is disabled for the MIR profile.

The path to the folder where outgoing E2B attachments are processed.
This field is disabled for the MIR profile.

If the checkbox for Suppress Auto-scheduling is marked for an
Agency in the Reporting Destination codelist, the system does not
schedule reports (Initial, Follow-up, Amendment, Nullification) for that
specific Agency during Auto-scheduling (via AG services, Clicking on
Auto-scheduling, Auto-scheduling of f/p reports for a manually
submitted report). However, reports can be manually scheduled to the
Agency that is set for Suppress Auto-scheduling.

Enables you to select the MIR Report format from a drop-down list
(PDF and XML).
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Field or Control Description

Name

Allow Multiple Enables you to schedule a report for each suspected Investigational
Reports for drug for the case.

Investigation drugs

# Note:

This field is applicable for PMDA reports
only. Do not check this option for non-
PMDA reports.

Allow Multiple Enables you to schedule a report for each marketed drug for the case.

Reports for Marketed

drugs

# Note:
This field is applicable for PMDA reports
only. Do not check this option for non-
PMDA reports.
# Note:

For Oracle Argus Safety Japan users, an additional field called Message Profile 2 is
displayed for the configuration of the PMDA - J profile. This field is required for the
PMDA agency to specify the PMDA J profile.

Use the following procedure to configure EDI:

1.

ORACLE

Select the Agency Name (or row) of the reporting destination displayed under Total
Number of Rows that needs to be modified. The Modify section is populated with
information about the selected code list.

You may use the Reporting Destination filter to make your search specific to an EDI.
The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.
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29.
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Tip:

You can alternatively click Add New to create a new EDI.

* Click Copy to make an editable copy of an existing EDI.
e Click Delete to delete a selected EDI.

*  Click Print to print the selected information as a PDF.

Select the format in which the report is to be sent by selecting the SGML and XML
radio buttons.

Click the Mark as Auto Submit checkbox if you wish to mark the report for auto-
submission.

Select the country where the imported cases need to be assigned.
Select the initial workflow state of the case.

Enter the routing ID configured in Cyclone for the sender community under the
Agency ldentifier field.

Enter the Agency Duns code under the Identification Code field.

Enter the Code Qualifier under the Code Qualifier field.

Select the message profile from the Message Profile drop-down list.
Select the acknowledgement profile from the ACK Profile drop-down list.
Enter the Agency Duns Code in the Identification Code field.

Enter the Company Identifier in the Company Identifier field.

Enter the Code Qualifier in the Code Qualifier field.

Enter the name of the file in the File Name field.

When a case is accepted as an initial or follow-up case, the system attaches the
source XML and the Initial Selection PDF to the case on the Additional Info tab.

Select the SGML file in the SGML Declaration File drop-down list.

Enter the maximum number of reports that need to be included in the message
under the Maximum # of reports to include in the msg field.

Select the method from the Method drop-down list. This list contains options like
E2B - Gateway, Physical Media and XML Transmission.

Click the EDI Header checkbox to generate an EDI Header.
Enter the version of XML in which it is coded in the XML Version field.

Enter the path where the message DTD resides on the internet or enter full path if
it is located on the disk under the URL of Message DTD field.

Select the character set encoding used in XML in the Encoding drop-down list.

Enter the path where the ACK DTD resides on the internet or enter the full path if it
is located on the disk in the URL of ACK DTD.

Click Auto Accept ICSR's to auto accept ICSR's.
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< Note:

When the Auto Accept ICSR's checkbox is checked and the value All or Initial
is selected from the drop-down list, you must select valid values from the drop-
down lists for both Imported Case are assigned to and Initial Workflow State.

30. Click Transmit E2B Attachments to transmit E2B attachments.
31. Click Save to save the changes made.

Use the following procedure to configure reporting destination.

1. SelectCode Lists > Argus to view the Code List Maintenance screen.

Q Tip:

The code list items are displayed in the left-panel. Click the required Code List
folder to be configured. The details of this code list item appear in the right
panel.

2. Select Reporting Destination. The screen appears as shown below.

CODE LIST MAINTENANCE

Reporting Destinaton Filer
Fila Value
Orgunizby | coce s B2 B . ]
[Total Number of Rows (49)
Name. ‘Agency Type Registration # Conta Fax FAX Cover
(HA} EUROPE EVPH-New Regulatoy Authory jon Manufacturer 13943015
|{BP}Best Devices Regulatory Authority Distribt
(44} AUSTRIA Reguiatory Authory Manufacturer
A} EUROPE EVPH Regulatoy Authory 3943985
(A} ITALY DEVICE Reguiatory Authory Manufacturer
) Spain Regulatoy Authory Manufacturer 13943085
{+4A) SPAIN DEVICE Regulatoy Authory e Manufactrer
EaLab Resul Assessment Terms
» Department of Device Safety and Su et
L Tost Group () SPAIN DEVICE POF Reguiatory Authoriy [Depertme Manufacturer
(A} TURKEY DEVICE Regulatory Authority ntat
Lab Test Type (HA} UNITED STATES CDERR2  Regulatory Authority 1-394-3945
(et Confguraton [44) UNITED STATES EVAERS  Regulatory Authory
EaLierary Citation () UNITED STATES EVPMR2  Reguistory Authorty 13943985
HAJ UNITED STATES ICH_R2. ~ Rogulatory Authory 13943945
Stocal Evaluator Comment Type (Canada R2 Regulatory Authorty 23030
ICBER-EVAERS Regulatory Authority Vaccine Reporting Division Manufacturer
(CORH-oMOR_I Regulatoy Authory 999
(CORH-eMDR M Regulatoy Authory 999 Manutactuer
Catssage Type Coreeris Reguiatory Authory Mesico Depariment for PSR
(Copy ofestagency -
[ assnew || [ Pt
"Add New Reporting Destination
. " Bl | Sirre— -
SaReference Type
Preferred Method Contact Type
[dReport Media on
v [ Manufacturer
SReport Type Agency Type Registration # O importe
[Reporter Information v importer
CReporter Type Department X () Distributor
) Authorized Representative
Email Address FAX Cover
(] Offline Recipient
[Study Center - Contact Information
= Tide First Name Widdle Last ‘
I Rep ) Prons ext Country Code .
.

Configuring the Base Directory Path

ORACLE

A new database only (not shown in the Ul) global level common profile switch
BASE_DIR_PATH_FOR_GATEWAY_FOLDERS is available for providing the base path for
all incoming, outgoing and E2B attachments folders.

Users can configure the base directory path of a machine or network shared path through this
swtich. This path is suffixed with values provided in new configurations and all incoming,
outgoing and E2B attachment folders are created under base directory only. This profile
switch is mandatory for the Oracle cloud customers whereas it is optional for the on-premise
customers. With this optional set up, on-premise customers can retain their existing folder
structure when upgrading from older version of Oracle Argus Safety. Cloud customers would
need to reconfigure their gateway folders based on the new architecture. When the
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BASE_DIR_PATH FOR_GATEWAY_FOLDERS is set, make sure to create the base
directory path along with the enterprise name.

For the example:

If BASE_DIR_PATH_FOR_GATEWAY_FOLDERS is set to C:\BASE_DIR for the
enterprise ENT_DEFAULT, then the folder C:\BASE_DIR\ENT_DEFAULT is created. IF
the Incoming Folder is set to AGECNCY\Incoming, Outgoing Folder to
AGECNCY\Outgoing and ISCR Outgoing Attachment Folder to
AGECNCY\OutAttachment, the actual incoming folder path would be
C:\BASE_DIR\ENT_DEFAULT\AGECNCY\Incoming. The same standard applies for
the outgoing and attachment folder too.

If the BASE_DIR_PATH_FOR_GATEWAY_FOLDERS is not set, the Incoming,
Outgoing and Attachment folders could have the complete directory path.

This section lists the Field Descriptions and configuration steps for the SMTP tab.
Field Descriptions

The following tables lists and describes the fields on the SMTP tab.

Field or Control Description

Name

From Enables you to enter the email address of the sender.

CcC Enables you to enter the email addresses to send email as CC.
BCC Enables you to enter the email addresses to send email as BCC.
Delivery Receipt Enables you to check this box to receive a delivery receipt.

Read Receipt Enables you to check this box to receive a read receipt.

Use the following procedure to configure SMTP.

1. Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section is populated
with information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an
SMTP. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.
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Q Tip:
You can alternatively click Add New to create a new SMTP.
« Click Copy to make an editable copy of an existing SMTP.
e Click Delete to delete a selected SMTP.

e Click Print to print the selected information as a PDF.

7. Enter the email address of the sender under the From field.

8. Enter the email addresses to send email as CC under the To field. Multiple e-mail
addresses must be separated by a comma (,), and not by a semi-colon (;). If you
separate the email addresses by a semi-colon, the transmission service will fail.

9. Enter the email addresses to send email as BCC under the BCC field. Multiple e-mail
addresses must be separated by a comma (,), and not by a semi-colon (;). If you
separate the email addresses by a semi-colon, the transmission service will fail.

10. Click the Delivery Receipt checkbox to receive a delivery receipt.
11. Click the Read Receipt checkbox to receive a read receipt.

12. Click Save to save the changes made.

Configuring Routes of Administration

This screen enables you to configure the Route of Administration information. This describes
the route of drug administered to the patient. This data is reflected in Expedited and Periodic
regulatory reports.

* The values entered here and marked under Display appear in the Route of
Administration list on the Products tab.

e Select Code Lists > Argus to view the Code List Maintenance screen.

CODE LIST MAINTENANCE
Bro Routes of Administration Filter
" i Fiold Value
Organized by Code List ~
i <] [Cortains o el
[aintermediary - R
[Custifcat e et Ro (172) Displaying Rows. Page Size —= =
justiications
 BlLeb Result Assessrment Torms Administration Route. Description E2B Code. Display EDQM Torm ID
Auricular use Aurcular use 001 Yes ROA-20001000
[SLab Test Group Auricular use custom Auricular use custom Yes
[Lab Test Type. Auto_1643051657 on 1
Lottr Configurat AuoE_1643052360 £l Yes
—ueter Configuration AutoE _This_s_test_stiing_to_perform_the_maximum_value_ .. 222 e
[Literary Ctation allow .
ElLocal Evalaator Comment Typs utod_This s est_sting_o_pefom_the_masimum_valve_ 1) i i 22 ves
CaManufacturers Buccal use Buccal use 002 Yes ROA-20002500
BllMedical Status Buccal use custom ST i
[Message Type Conjunctival Conjunctival Yes
[aNature of Event Costal Costal No
E20ccupations Cutaneous use Cutaneous use 003 Yes ROA-20003000
Dental use Dental use 004 Yes ROA-20004000
[Package Units 5
[Product Group Yes
EaProect D 005 Yes ROA-20006000
006 Yes ROA-20007000
CaReference Type 007 Yes ROA-20008000
[Report Media nary u Yes ROA-20008000
. Yes
Report Type
Report Typ 008 Yes ROA-20009000
[aReporter nformation Yes ROA20010000
[aReporter Type Extraamniotic use Extraamiotic use 009 Yes ROA-20011000
ERepeoriing Destination Extracorporeal use Extracorporeal use Yes ROA-20011500
! Gastric use Gastric usa Yes ROA-20013500
[Reporting Destination Type Gastroenteral use Gastroenteral use Yes ROA-20013000
-7 Routes of Administration inaival us : e ROA-20014000 A
[3Study Conter Asanow ]| I Co
[3Study Development Phase. Add New Routes of Administration
[User Sites ~ ||| ¥ Administration Route Short Name E2B Code
| ] Display
The values entered here and marked ‘Display” il appear| | | P2=CrPtion
in the in the Route of Administration listn the Products
tab
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Tip:

The code list items are displayed in the left-panel. Click the required Code
List folder to be configured. The details of this code list item appear in the
right panel.

Click the Routes of Administration folder in the left panel. The associated data
appears in the Total Number of Rows section in the right panel.

For more information, see:

Field Descriptions

Field Descriptions

The following table describes the fields associated with this section.

Field or Control Description
Name

Administration Route Displays information about the route of administration. It displays

information about how the drug was administered. This is a required

field.
Short Name Displays the short name of the administrator route.
Description Displays a description of the administrator route.
E2B Code Displays the E2B Code of the administrator route.
Display Enables you to display the record in the Administrator Route in the

Products screen.

Use the following procedure to configure routes of administration.

1.

ORACLE

Click the Administration Route (or row) to view the details associated with the
administration route. The details appear in the Modify Administration Route
section.

Use the Routes of Administration filter to make your search specific to a route.
The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.
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Tip:

You can alternatively click Add New to create a new route.

* Click Copy to make an editable copy of an existing route.
* Click Delete to delete a selected route.

e Click Print to print the selected information as a PDF.

Enter information about the administration route in the Enter Administration Route field.
Enter a short name about the administration route in the Short Name field.

Enter the E2B Code of the administration route in the E2B field.

Select the Display checkbox to display the record in the Add field in the Products screen.
Enter the description about the administration route in the Enter Description field.

Click Save to save the changes made.

Configuring Study Center

This screen enables you to configure the Study Center information. This screen is used to
enter information regarding each Study Center. The Study Centers defined in this dialog
appear on a drop-down list in the Clinical Studies Information dialog under the Centers tab in
List Maintenance. You can create a Study Center with the same Center ID but with a different
name and address. When you select the studies in the Study Look and Center Lookup in the
Console, the system concatenates the Center Name (Center ID) in the look-up dialog.

Investigators for each Center can also be added via this dialog.
Select Code Lists > Argus to view the Code List Maintenance screen.

Click the Study Center folder in the left panel. The associated data appears in the Total
Number of Rows section in the right panel.

Tip:

The code list items are displayed in the left-panel. Click the required Code List
folder to be configured. The details of this code list item appear in the right panel.

For more information, see:

Field Descriptions

Field Descriptions

ORACLE

The following table lists and describes the fields associated with this section.

Field or Control Name Description

Center ID Enables you to enter the Center ID.
Name Enables you to enter the name of the center.
Address Enables you to enter the address of the center.
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Field or Control Name Description

Copy from Reporters Enables you to copy the information from Reporters.

# Displays the row count of the number of investigators.
Investigator Enables you to enter the name of the investigator.

Phone Enables you to enter the phone number of the investigator.
Fax Enables you to enter the fax number of the investigator.

Notes Enables you to enter comments or remarks.

Use the following procedure to configure study center.

1.

10.

11.

12.
13.

Click the Center ID (or row) to view the details associated with the administration
route. The details appear in the Modify Study Center section.

Use the Study Center filter to make your search specific to a center. The filtering
criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip:

You can alternatively click Add New to create a new center.

e Click Copy to make an editable copy of an existing center.
e Click Delete to delete a selected center.

e Click Print to print the selected information as a PDF.

Enter the ID of the center in the Center ID field.
Enter the name of the center in the Name field.
Enter the address of the center in the Address field.

Select the Copy from Reporters checkbox to copy the information from
Reporters.

Enter the name of the investigator in the Investigators field.

Tip:

Click Add to add a new investigator. Click Delete to delete a selected
investigator record.

Enter the phone number of the investigator in the Phone field.

Enter the fax number of the investigator in the Fax field.
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14. Enter comments, if any, under the Notes field.

15. Click Save.

Configuring Holiday Calendar

This screen enables you to configure the Holiday Calendar information. The Code List allows
the user to define holidays at country level.

The Country of Reporting Destination will be matched with the Country in the Holiday
Calendar to identify the holidays to be adjusted for the Reporting Destination.

Goto Code Lists > Argus to view the Code Lists page and click the Holiday Calendar
folder in the left panel.

The associated report appears in the Total Number of Rows section in the right panel.

Tip:

The code list items are displayed in the left-panel. Click the required Code List
folder to be configured. The details of this code list item appear in the right panel.

For more information, see:

e Field Descriptions

Field Descriptions

ORACLE

The following table describes the fields associated with this section.

Field or Control Name Description

Holiday Name This field displays the unique name for the holiday name.

Date This field displays the date on which the holiday has been scheduled.
Description This field displays a description of the holiday.

Country This field displays the name of the country (or countries) with which the

holiday is associated.

Use the following procedure to configure study center.

1. Click the Holiday Name (or row) to view the details associated with that Holiday
Calendar. The details appear in the Modify Holiday Calendar section.

2. Use the Holiday Calendar filter to make your search specific to a Holiday Calendar
record. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should contain
or start with specific alphabets.

5. Enter the search criteria in Value.

6. Click Filter to apply the selected criteria. This displays the search results under Total
Number of Rows.
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You can alternatively click Add New to create a new Holiday Calendar

« Click Copy to make an editable copy of an existing Holiday Calendar
record.

« Click Delete to delete an existing Holiday Calendar record.

7. Enter the Holiday Name for the Holiday Calendar.

8. Enter the Date for the record.

9. Enter the Country (or countries) with which the holiday must be associated.

10. Enter the Description for the Holiday Calendar record.

11. Click Save.

Other Code List Items

The following table lists and describes additional code list items that you should be

ORACLE

aware of.

Code List Item

Description

Accidental Exposure

Action Taken

Action Type

Age Group

Age Unit

Enables you to capture Accidental Exposure information. Accidental
Exposure is in the Dosage regimen section of the Products tab as a
drop-down list.

Enables you to capture Action Taken information. Action Taken
information is required to capture information about steps taken when
an adverse drug event occurs. The values that you enter in this field
are read-only, and appear in the Dosage Regimen section on the
Action Taken drop-down in Case Form > Products tab.

Enables you to capture Action Type information that describes the
action type required for the case. Values entered in this field are read-
only, and appear in the Code/Description list of the Activities tab.

GotoCode List Maintenance > Code List > Argus
and click Action Type in the browser tree.

Enables you to capture Age Group information. An Age Group is the
range of lower and upper age limits. Patients are categorized in
different age groups. This data appears in Expedited and Periodic
regulatory reports. The values that you enter in this field appear on the
Patient Information Screen, and in the Age Group drop-down list. The
Range values that you specify for new age groups must not contain
numbering gaps or overlapping values.

Enables you to capture Age Unit information. An Age Unit displays
time in periods such as Year, Month, Day, Hours, and so on. This data
appears in the Expedited and Periodic regulatory reports. It also
appears in the Age Unit drop-down, Gestation Period unit, and Device
Age unit fields on the Patient Information screen, as per the settings
made to the Age unit, Gestation Period unit, and Device Age unit flags
in the Age unit codelist.
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Code List Item

Description

ORACLE

Always Serious Term
List

Anatomical Location

Attachment
Classifications

Attachment Keywords

Birth Type

Case Classifications

Causality Category

Causality Method

Causality Source

Clinical Reference

Type

Condition Type

Contact Type

Enables you to select the report types you would like the always
serious to run against. You can select specific Product Families to
have the always serious terms run against.

Enables you to capture information about the location where
vaccinations are given. This data appears in the expedited and
periodic regulatory reports. The values that you enter in these fields
appear on the Anatomical Location drop-down list on the Vaccine
screen.

Enables you to capture the attachment classification that is used to
describe attachment types. The values that you enter in these fields
appear in the Attachment Classification section on the Additional
Information screen. Attachment Classification that are marked as E2B
Additional Doc can be configured to be sent as attachments while
transmitting E2B(R2) and E2B(R3) reports.

Enables you to capture information about the attachment keywords
that are used to define an attachment type. The values appear in the
Attachment Keywords section on the Additional Information screen.

Enables you to capture birth type information when capturing
pregnancy information. This data appears in multiple regulatory
reports and in the Birth Type drop-down list on the Pregnancy
information screen.

Enables you to capture Case Classification to help categorize cases.
This information does not impact any report or screen, but is used
during case searches to narrow the results set.

Enables you to capture information about the causality type. This data
appears in expedited and periodic regulatory reports and on the Event
Causality drop-down list in the Event Assessment section on the Event
screen.

Enables you to capture Causality Method information. It appears on
the Case Form Event Assessment tab.The E2B report uses this
information to determine the drug assessment method.

Enables you to capture Causality Source information. It appears on the
Case Form Event Assessment tab.The E2B report uses this
information to determine the drug assessment source.

Enables you to capture information about the clinical reference type.
The Clinical Reference Type appears as a drop-down list in Study
Configuration.

Enables you to capture information about the condition of the patient
such as historical condition, current condition, historical drug, illness at
the time of vaccination etc,. This data appears in expedited and
periodic regulatory reports and in the Condition Type drop-down list on
the Other Relevant History screen.

Enables you to capture information about the type of contact (such as
Follow-up, Investigator). The values appear in the Contact Type drop-
down list in the Contact Log section of the Activity Tab.
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Code List Item

Description

Countries

Date Ranges

Delivery Types

Device Preliminary
Comments

Device
Subcomponents

Device Type

ORACLE

Enables you to capture information about the country where the
adverse event occurred. If you enter A2, A3, or the numeric country
code, the system automatically populates the Country field with the
name of the country.

The 'Countries Grouping' field enables you to create a group of
countries. For example, to group all European Union member
countries, you first create a country called 'EUROPEAN UNION'. You
then select a European Union member country in the countries table,
type 'EUROPEAN UNION' in its Countries Grouping field, and then
click Save. Repeat the process for all European Union member
countries. On screens where you need to enter a list of all European
Union members, you can type European Union, and all countries in
this group will be entered automatically.

The 'Group 2 Country' checkbox enables you to add a Group 2
Country. This is required when the Due Date for expedited reports
differs from country to country, as per their regulations.

For Group 1 countries, the Due Date is based on the Aware Date
received globally for the case. For Group 2 countries, the Due Date is
based on the aware date when the affiliate or a company
representative of that country received information about the case.

Enables you to capture date range information as follows:

«  Description - Enables you to enter a description of the date range.

< Duration - Enables you to specify the exact duration as opposed
to a range of dates. Must be used in conjunction with Amount and
Units. When you select "Duration," the system disables the Range
radio button.

e Amount—The numeric value that specifies the length of the time
period when combined with a value selected from the Units drop-
down list (such as days, weeks, months, years, etc.)

e Units—The unit of the duration (such as days, months, years).

« Range—Enables you to select a specific range of dates. Must be
used in conjunction with the Start and End fields. When you select
Range, the system disables the Duration radio button.

e Start—The initial date of the date range.

«  End—The last date of the date range.

Enables you to capture information about the type of delivery that
occurred during pregnancy. This data appears in expedited and
periodic regulatory reports and on the Delivery Types drop-down list on
the Pregnancy Information screen.

Enables you to capture comments about medical devices. Device
Preliminary Comments appear on the Product screen when the user
selects the Device option.

Enables you to capture information about subcomponents that are part
of a medical device. This information appears on the Product screen
when the user selects the Device option.

Enables you to capture information about patient device types. This
data appears in expedited and periodic regulatory reports.
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Code List Item

Description

Dosage Frequency

Dosage Unit

Ethnicity

Evaluation Reason

Event Frequency

Event Intensity

Event Outcome

Fetal Outcome

ORACLE

Enables you to capture information about how often medication is
given (such as daily, bid, weekly, etc.) This information appears on the
frequency drop-down list on the Products screen.

¢ Frequency—Enables the user to specify how often the dose is
given.

*  Number of doses per day—Enables the user to specify the
number of doses administered each day.

*  Number of separate dosage—Enables the user to define the
dosage verbatim.

e Number of units in the interval—Enables the user to define the
dosage verbatim.

< Definition of Interval—The length of time between doses such as
year, month, day, week (default), hour, minute.

Enables you to capture dosage units information. This information is
required when capturing the quantity of drug on sale and also appears
in expedited and periodic reports.

e Unit Name—The name of the dosage unit.

« E2B Code—The E2B code associated with the Dosage Unit.

. Dosage Unit—When checked, it indicates that the current item is
the dosage unit.

. Lab Test Unit—When checked, it indicates that this is a lab test
unit.

*  Display—When checked, it indicates that the Unit Name is
displayed in the application.

A new Strength Unit column has been introduced. Check the Strength

Unit checkbox to capture strength unit information about the Dosage

unit.

For more information on the Factory data for Dosage Units codelist,
see the Argus_Safety CaseForm_Console_Updates_Summary.xls.

Enables you to capture Race information of the patients. This
information appears in periodic regulatory reports and eVAERS
reports.

Enables you to capture information about why the product is being
evaluated. This information appears in the Evaluation Reason list on
the Case Form > Products tab.

Enables you to capture information about the frequency of the event. It
includes categories such as intermittent, continuous, and single
episode. The values entered in this field appear in the Event
Frequency drop-down list on the Event Information screen.

Enables you to capture information about the intensity of the adverse
event and includes categories such as mild, moderate, and severe.
The values that you enter on this screen appear on the Event Intensity
drop-down list on the Event Information screen.

Enables you to capture event outcome information such as Fatal,
Abortion due to AE/Infection, and Recovered. This data appears in
expedited and periodic regulatory reports and on the Event Outcome
drop-down list on the Event Information screen.

Enables you to capture information about fetal outcome and includes
information such as abnormal development or pre-natal complications.
This data appears in expedited and periodic regulatory reports. The
values entered here appear on the Fetal Outcomes drop-down list on
the Pregnancy Information screen.
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Code List Item

Description

Formulation

Gender

Ingredients

Intermediary

Interval Units

Justifications

Lab Assessment
Terms

Lab Test Type

Lab Test Units
Languages
Literary Citations
Local Evaluation
Comment Type

Location

Manufacturer

Medical Status

Message Type

Enables you to capture information about the formulations (cream,
drop, capsule, etc.) available for a product. The values that you enter
here, appear on the Formulation drop-down list on the Product screen.

Enables you to capture gender information. This information appears
in expedited and periodic regulatory reports.

Enables you to capture information about the ingredients in the
product. This includes the ingredient, the concentration, and the units
of ingredients used to make the product. This information appears in
expedited and periodic regulatory reports.

Enables you to capture information about intermediaries such as sales
representative, licensee, regulatory authority or local affiliate. The
values that you enter here, appear on the Intermediary drop-down list
on the Reporters screen.

This codelist is used to maintain the interval units that are used as
units for Age, Duration, etc.

Enables you to capture justification information. You can enter reasons
for overriding system determinations in the Justifications dialog box.
The values that you enter here, appear in the Action Justification
dialog.

Enables you to capture the lab result assessment terms that define the
terms that describe the patient's results on various lab tests (such as
elevated, depressed, etc). This data is reflected in expedited and
periodic regulatory reports. The values that you enter here, appear on
the Lab Result Assessment Terms drop-down list on the Laboratory
Data screen.

Enables you to capture the lab test type. This defines test type and
whether it has normal, high, or low values. It can be coded as defined
in the MedDRA dictionary. The values that you enter here, appear on
the Lab Test drop-down on the Patient screen.

This codelist is used to maintain the units of measures used in Lab
test.

This codelist is used to maintain the ISO codes of the languages in
which text data entry can be made.

Enables you to enter information about literary citations.

Enables you to capture the category of a local comment such as
French, German, English, etc. The values that you enter here, appear
in the Analysis, Local Comment type.

This codelist is used to maintain the Anatomical locations in which
Vaccines are administered.

Enables you to capture information about the product manufacturer.

Manufacturer is required while capturing, adding, or modifying
information on manufacturer sites. This data appears in expedited and
periodic regulatory reports and on the Manufacturer drop-down list on
the Product Configuration screen.

Enables you to capture medical information about patient status. This
data appears in both the expedited and periodic regulatory reports.
The values that you enter here appear on the Medical Status drop-
down list.

Enables you to enter information about each E2B message type. The
system uses the defined message types when it creates an E2B file.
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Code List Item

Description

Nature of Event

Occupations

Package Units

Product Group

Project ID

Purchased With

Reference Types

Relation

Report Media

Report Types

Reporter Information

Reporter Type

Reporting Destination
Type

Routes of
Administration

ORACLE

Enables you to capture information about the type of adverse event
that occurred.

Enables you to capture information about patient and reporter
occupations such as physician, regulatory agent, and journalist. This
data appears in both expedited and periodic regulatory reports. The
values that you enter here, are marked as ICH Occupation, and
appear in the Reporter's Occupation drop-down list on the General
Screen.

Enables you to capture information about product packaging. The
package units define the number of units in a package.

Enables you to capture information about a specific Product Group.
Users can use the Product group field to categorize Product Families
based on therapeutic area. The values that you enter here appear in
the drop-down list associated with the Project Group field of the
Product Family.

Enables you to capture project ID information used to group similar
studies under a single project. The values that you enter in this field
appear on the Project ID field drop-down on the Study Configuration.

This code list is used to maintain the Funds from which Vaccine was
purchased.

Enables you to capture reference type information and defines a list a
reference types such as Parent-Child Link, Patient ID, etc. The values
that you enter here, appear in the Type drop-down in the References
section on the Additional Information tab.

This codelist is used to maintain the Reporter relation to the Patient.

Enables you to capture Report Media information. The values that you
enter appear on a drop-down field in the Reporter Information section.

Enables you to capture information about report types. The report type
describes the type of report and the abbreviation associated with the
specific type. This data appears in expedited and periodic regulatory
reports. The values that you enter here, appear on the Report Type
drop-down list on the General Screen.

The Considered cases for report type drop-down list determines
whether a case is considered marketed or investigational for a given
reporting destination. When creating a new case report type, the
selected value is Marketed by default.

Enables you to capture reporter information such as First Name, Last
Name, Occupation, and so on.

Enables you to capture information about the person reporting the
adverse event and includes categories such as lawyer, nurse, doctor,
etc. The values that you enter here, appear on the Reporter Type drop-
down list on the Product screen.

Enables you to capture information about the reporting destination.
The values that you enter here, appear on the Reporting Destination
configuration.

Enables you to capture information about how a drug is administered
to a patient such as auricular, cutaneous, dental, and so on.
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Code List Item Description

Study Center Enables you to capture information about the study centers. Values
entered here appear on a drop-down in the Clinical Studies
Information dialog and on the Centers tab in List Maintenances. You
can also add investigators for each center.

You can create a study center with the same center ID but with a
different name and address.

Vaccinated At This code list is used to maintain the Vaccination Facility Type
information.

Configuring Code Lists > Flexible Data Re-Categorization

The Flexible data re-categorization feature allows Argus Safety and its associated
applications such as Argus Mart and Argus Insight to handle the code list values in a
much more flexible manner, as compared to the previously existing Argus Safety Code
List database design.

Working with Flexible Data Re-Categorization

The Flexible Data Re-Categorization feature allows applications and customers to
store and maintain all types of code list values in a single flat database table structure
which shall be easier to maintain. This code list data storage design can be leveraged
to easily add new and custom code lists or values by applications as well as
customers without adding new database tables and columns. This database structure
was added in previous release of Oracle Argus Safety.

Argus Console provides a user interface that displays values for different code list
languages for the flexible data re-categorization code list feature. This user interface
helps add and remove custom languages for an existing code list, present in the
flexible data re-categorization code list tables and also the flexibility of adding new
code list items through this User Interface (Ul).

However, this Ul does not allow users to perform any modification for the languages
which are maintained via the Console Code List feature. Any changes done to the
values through this user interface are audit logged.

The Flexible Data Re-Categorization feature allows administrators to manage and
display the existing and new code list items.

For more information, see:

* Flexible Code Lists
» Flexible Re-Categorization

e Add custom values to a flexible code list

Flexible Code Lists

To access Flexible Data Re-Categorization:

1. GotoArgus Console > Code Lists > Argus > Flexible Data Re-
Categorization.

The following table describes the fields associated with this section:
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Field Name Description

Code List Name This is the unique name of code list which can be used in the application
and reporting for fetching the values of a code lists. This is mostly
derived from the source Oracle Argus Safety code list names. However,
it can be different in some scenarios as per the customer need.

Code List Description  This is the description of code list which can be used to define the
purpose of this code list.

Source Argus: All the code lists which are part of Oracle Argus Safety factory
configuration and can be edited using standard Argus Console code list
Ul show the source as 'Argus'.

Custom: Any code lists added as part of factory data which cannot be
modified from Argus Console standard code list Ul are considered as
custom.

Any code list added by customers has source as 'Custom'.

2. This page is used to add new values or view existing code list values in the code lists.

* Click Add New to add a new flexible code list item.
To make any changes, users can select a code list, modify values in the given text
boxes, and save those changes for modification.

* Click Delete to delete an existing flexible list item.
» Click Copy to copy an existing flexible list item.

3. Click Save to save the new or existing flexible code list item information.

Flexible Re-Categorization

To access Flexible Re-Categorization:

1. GotoArgus Console > Code Lists > Argus > Flexible Re-
Categorization.
The following screen is displayed:

ORACLE Welcome shdhaund, Thursday, September 18, 2014 (ZTre0xs DepauLT) BT RCTTS
I cooeis | owmenc [ s e o | —Toon [

FLEXIBLE CODE LIST MAINTENANCE

Browser Flexible Re-Categorization Code Lists.
(Organized by  Code List v |{ | Code Listh:
- AGCDENTA Re :
=-[iF Flexible Data Re-Categorization
(3 Flexible Code Lists feceotl taponirs SACCIIETAL BXPGSIRG [
(5 Flexible Re-Categorization
er
v X L | [z ] £ |
Z X 2 Eye £
x [}3 Ingestior FOEK
e | r—| | Y| -
Code List Attribute Code List Value
[ i ]
here and marked as Flexcbie Data |
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The following table describes the fields associated with this section.

Field Name

Description

Code List Name

Attribute Name

Code List Display
Value

Add Attribute
Remove Attribute
Attribute Name

Code

<All Language
Attributes>

Right-click > Make
Primary

This is a drop-down list that displays all the available flexible code
lists for selection.

This is the language Decode context for selected code list which
can have language code and other properties of code lists.

The following are possible values for this field for the factory data

rows which will be populated based on the current code list factory

data. Customer can add more language/type values for the new

code list items that they create from flexible re-categorization

screen, based on their usage:

* en: English display value for a code list item

e jp: Japanese display value for a code list item

»  E2B: E2B code value for this code list item

*  RPT: Display value for Reports

e ISOA2: A2 country code for the country code list items

e ISOAS3: A3 country code for the country code list items

« EN_ABBRYV: This is used for defining abbreviation values.

*  SM: This decode context is used by Oracle Argus Mart while
populating data into the SM tables.

e UCUM_CODE: UCUM code value for this code list item. This
is used in E2B(R3) and eVAERS reports.

e E2B_R3: E2B(R3) value for this code list item. This is used in
E2B(R3) and eVAERS reports.

« VAERS CODE: VAERS Code value for this code list item.
This is used in eVAERS and VAERS report mapping.

*  NCI_CODE: NCI code value for this code list item. This is
used in eVAERS reports.

This the re-categorized display value for the code. This display
value shall be based on a code list, code, and language
combination.

Enables you to add a language attribute.
Enables you to remove a language attribute.

This is the language Decode context for selected code list which
can have language code and other properties of code lists.

This is the first column in the gird for all flexible code lists. This
column displays the internal id for the existing 'Code' list value. For
custom code list, the application always populates the code
columns with system generated unique sequence value for the
selected code list. It is possible for customers to provide a custom
'‘Code' value for any of the new rows. This value is always unique
for a code list.

All the language attributes are displayed as a new column in the
grid with Primary attribute being the first one after the Code
column.

Allows you to make the selected language attribute as the primary
attribute. The primary attribute column is moved as the first
attribute in the grid after the 'Code' column. This configuration is
available every time the user opens the same flexible code list.
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Field Name Description
Right-click > Make Allows you to mark the selected cell values corresponding to
Preferred selected language attribute as Preferred in the database. Preferred

values are displayed with an asterisk (*) in the grid for easy
identification. At any given time, only one value can be marked as
preferred within matching values for a language attribute.

Export to Excel Enables you to export all the values of selected code list into an
excel file.

Batch Attribute A collapsible interface, this option displays the list of all attributes

Update available for the selected code list in Flexible re-categorization

screen. It also provides a text box called Code List Value, where
users can enter the required display value of the code list for the
selected attribute.

This page is used to add new values or view existing code list values in the code lists.

Click Edit. The grid cells of corresponding row become editable for all the attributes
added in that code list by the user.
On clicking Edit, a green tick mark is displayed, along with a red colored, cross icon.

Click the green tick mark to temporarily save the grid values (until saved into database
by clicking Save button). The selected row comes out of Edit mode.

Click the red colored cross icon to discard any changes made to the selected row. The
selected row comes out of Edit mode.

On changing the value of a preferred cell, its preferred status is removed upon saving the
grid values.

Click Delete to allow the users to delete an entry from the flexible code lists. The Delete
icon is enabled for only custom code lists, for which protected flag is set to O in
CODE_LIST_CODE_ATTRIBUTES table. Click this icon to delete all the attribute values
corresponding to the selected row from the database.

The Display checkbox is checked by default (except for hidden entries), for a new row
added into the flexible code list.

Click Save to save all the changes made on flexible code list screen.

The following Code Lists are used/provided for BIP Aggregate Reports:

REPORT_TEMPLATE: This code list is used for managing various BIP report templates
available in the system (OOB + Custom) and assign an Oracle Argus periodic
configuration (ICH PSUR or CTPR) using which user want to execute this report
template. Whenever a new report template is added in BIP, this code list should be
modified for providing report template name, its path and corresponding Oracle Argus
configuration.

ADHOC _LINE_LISTING: All the LISTNAME added in adhoc_line_listing code list are
available in the UD Summaries tab of periodic reports configuration for attaching the
memorized reports to a particular line listing section of periodic report. User can renames
these using flexible re-categorization user interface. System provides four adhoc line
listings by default which can be increased using this code list if you have more adhoc line
listing sections in your report. Once configured, use Oracle Argus Ul for attaching the UD
summaries with line listings of your custom report.

SOC_DISPLAY_ORDER: Use this code list to reorder the printing of SOC in various
tabulations.
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AGGREGATE_REPORT_FORMAT: Use this code list to define the report formats
which you want to use with BIP reports execution. Make sure to use only those
formats which are supported by Bl Publisher.

DOSAGE_STRING_FORMAT: This code list can used to restrict/add the dosage
string formats which should be available while BIP report execution. More dosage
string formats can be added with the help of custom code. The following dosage
string formats are provided out of box which print values for dosage string as
mentioned in the EN attribute.

Code EN

Do Dose

DoFo Dose, Formulation

DoFoFr Dose, Formulation, Frequency
DoFoFrRt Dose, Formulation, Frequency, Route
DoFoRt Dose, Formulation, Route

DoFr Dose, Frequency

DoRt Dose, Route

UNIQUE_PATIENT_ID_FORMAT: This code list is used to restrict/add the dosage
string formats which should be available while BIP report execution. More dosage
string formats can be added with the help of custom code. The following dosage
string formats are provided out of box which print values for dosage string as
mentioned in the EN attribute.

Code EN

CePt Center, Patient

InPt Investigator, Patient

Pt Patient

StCelnPt Study, Center, Investigator, Patient

StCePt Study, Center, Patient

StCnCelnPt Study, Country Name, Center, Investigator, Patient
StCnCePt Study, Country Name, Center, Patient
StCoCelnPt Study, Country ISO Code, Center, Investigator, Patient
StCoCePt Study, Country ISO Code, Center, Patient

StinPt Study, Investigator, Patient

LABELING_ALGORITHM: Use this code list to define new labeling algorithm with
the help of custom code. Please see labeling algorithms for more information on
out of the box algorithms.

EVENTSERIOUSNESS: This code list is provided as part of factory data and is
used for printing the actual value of seriousness defined against a serious event.

ORGAN_IMPAIRED_HLT: This code list is added for defining the high level terms
which needs to be scanned through to find out if event reported falls under organ
impairment section or not. This can be used in custom reports.

BIP_DFLT_VALUES: This code list used for configuring the default values for
some of the important fields which are used in various grouping and tabulations.
For example, how to handle/print an event without and SOC. Value configured in

6-48



ORACLE

Chapter 6
Configuring Code Lists > Flexible Data Re-Categorization

this code list corresponding to SOC will be used in PBRER/DSUR tabulation for events
with undefined SOC.

The following Code Lists are used in reports, such as E2B(R3), eVAERS, VAERS, MIR, and

eMDR reports:

Code List

Description

AGE_UNIT

CAUSALITY_SOURCE

CAUSALITY_CATEGOR
Y
CAUSALITY_METHOD
* CODE_SYSTEM

COUNTRY

DEVICE_AGE_UNIT

DEVICE_SUBCOMPON
ENTS

DOSE_UNITS

ETHNIC_GROUP

ETHNICITY

EVALUATION_REASON

FORMULATION

GENDER

INTERVAL_UNITS

LAB_TEST_UNITS
LANGUAGES

LOCATION

This code list enables you to capture Age Unit information. An Age Unit
displays time in periods such as Year, Month, Day, Hours, and so on with
E2B and UCUM code information.

his code list lets you capture the source from which the causality information
was derived, along with the EU_CODE attribute. For each custom value that
you add, you must enter the value of the associated EU_CODE attribute in
order to populate this info in the EMA E2B report. The values that can be
entered for the EU_CODE attribute need to be in the range 1-6, as
permissible values for EVCTM are 1-3, and permissible values for
EVHUMAN are 3-6

This code list lets you capture the category of the causality information with
the EU_CODE attribute.

This code list lets you capture the method by which the causality information
was derived.

For the current release, this codelist is not used in the application (Case
Form, Reports).

This code list maintains the list of Countries with the 1ISO A2, ISO A3, and
EEA attributes.

This code list enables you to capture Device Age Unit information. Device
Age Unit displays time in periods such as Year, Month, Day, and Hours with
eMDR code information.

This code list enables you to capture information about subcomponents that
are part of a medical device, featuring two new attributes: IMDRF_CODE
and DEFINITION.

This code list is used to maintain the units of measures used in Dose with
E2B and UCUM code information.

This code list is used to maintain information about Ethnicity data of Patient
or Parent such as Hispanic or Latino, Not Hispanic or Latino with NCI Codes
information.

This code list is used to maintain Race information along with NCI Codes
information.

This code list is used to maintain the List of reasons for not evaluating
devices with NCI Codes information.

This code list enables you to capture information about the formulations
(cream, drop, capsule, and so on) available for a product with NCI Codes
information.

This code list is used to maintain the Gender with E2B and NCI Codes
information.

This code list is used to maintain the interval units that are used as units for
Age, Duration, and so on.

This code list is used to maintain the units of measures used in Lab test.

This code list is used to maintain the ISO codes of the languages in which
text data entry can be made.

This code list is used to maintain the Anatomical locations in which
Vaccines are administered.
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Code List Description

LOCATION_EVENT_OC This code list is used to maintain the locations where the events occurred.
CURRED This data is used in the eMDR and the MedWatch Device report.
MEDIA_TYPE This code list maintains the file types that can be sent as attachments in

E2B(R3) reports with the ICH, FDA, EMA, and PMDA attributes to indicate if
attachment types are allowed for these agencies.

MEDICAL_DEVICE_INF This code list is used to maintain the risk class of the medical devices.

(@]

MILITARY_STATUS This code list is used to maintain the details of the Military status of the
Patient such as Active Duty, Reserve, National Guard, TRICARE
Beneficiary, and Other with NCI Codes information.

NULL_FLAVOR This code list stores the different null flavors such as UNK, NA NASK, and

ASKU.

Null flavor sets are attributes in the Null Flavor codelist which are used to
create sets with various combinations of Null Flavors. The Null flavor set can
be assigned to Case Form fields in Field Properties Configuration and users
can select the Null flavors associated with a Null Flavor set as a part of
Case Form data.

PRODUCT_IDENTIFIER This code list identifies the type of Product name being used such as

_TYPE Medicinal Product Identifier (MPID), Pharmaceutical Product Identifier
(PhPID).

PRODUCT_NAME_PAR This code list specifies the name of a product as a separated component

TS such as container name, form name, device name, invented name, scientific

name, trademark name, intended use name, scientific name and so on.
PURCHASED WITH This code list is used to maintain the Funds from which Vaccine was

purchased.
RELATION This code list is used to maintain the Reporter relation to Patient.
REPORTER_INFORMAT This code list is used to maintain the Reporter information such as First
ION Name, Last Name, and so on.

RISK_CLASS_TYPE This code list captures a list of values for the risk class type with attributes
such as MDR and IVDR.

REPORTER_OCCUPATI This code list is used to maintain the Occupation with NCI Codes and
ON Device Operator information.

ROUTE This code list enables you to capture information about how a drug is
administered to a patient such as auricular, cutaneous, dental and so on
with E2B and NCI Codes information.

SPANISH_STATES This code list lets you capture the states of Spain with the STATE_CODE
attribute.

SPECIALIZED_PROD_ This code list is used to maintain details of the Product category details as

CATEGORY per FDA specifications such as Convenience Kit of Co-Package, Prefilled

Drug Delivery Device/System, Drug/Biologic Combination, and so on with
NCI Codes information.

US_STATES This code list lets you capture the states of USA with the STATE_CODE
attribute.
VACCINATED_AT This code list is used to maintain the Vaccination Facility Type information.

Add custom values to a flexible code list

1. Click Argus Console.
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From Code Lists, select Flexible Data Re-Categorization.

On the FLEXIBLE CODE LIST MAINTENANCE page on the right, in the Flexible Re-
Categorization Code Lists section, select the flexible code list that you want to add
custom values to.

To avoid the creation of a duplicate custom value, verify that the value doesn't already
appear in the Total Number of Rows section.

Tip:

The number that appears in parentheses is the number of existing custom
values for the flexible code list.

Click Add New.

In the Total Number of Rows section, enter information as necessary for the new custom
value.

Click the green check mark (¥").

To add additional custom values, repeat steps 4 to 6.
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This section explains the report (features and purpose) generated when Tools > ICSR
Length Check is accessed.

When Oracle Argus Safety Code List item length is greater than the E2B field length, the data
is truncated when maximum length is entered and an E2B report is generated.

For more information, see:

* Report Features

* Viewing the ICSR Length Check Report

Report Features

The report prints the code list items that exceed E2B(R2) length specifications and also lists
code list data that has codes not matching with codes required for the E2B(R2) report.

ORACLE

This report does not provide the length check and Code check validations pertaining to
E2B(R3), eVAERS, and eMDR reports.

The report contains the following as illustrated:

ORACLE
HEALTH SCIENCES

ICSR Report Data Check Errors & Warnings
As of 13 September 2017

1. ICH-ICSR V2.1 MESSAGE TEMPLATE

x ICH-ICSR V2.1 MESSAGE TEMPLATE - EMA
3. ICH-ICSR V2.1 MESSAGE TEMFLATE - FDA
4. ICH-ICSR V2.1 MESSAGE TEMPLATE - FDAFIP

e = T S e e

Length Check Validation

Other Validation

A231

A231

AZ231

STUDYNAME

STUDYNAME

STUDYNAME

STUDYNAME

OCCURCOUNTRY

OCCURCOUNTRY

OCCURCOUNTRY

List Maintenancs /
Clinical Studies /
Description

List Maintenance /
Clinical Studies [
Description

List Maintenancs /
Clinical Studies /

Description

List Maintenancs /
Clinical Studies /
Description

General Information /
‘Country of Incidence
General Infarmation |
‘Country of Incidence
General Infarmation /
‘Country of Incidence

Field value exceeds the ICSR
item's maximum field length.
Actual Data Entered = 250,
DD Length = 100,

Data Truncated = 158

Field value exceeds the ICSR
ftern's maximum fiefd length.
Actual Data Entered = 448,
DTD Length = 100,

Data Truncated = 348

Field value exceeds the ICSR
item's maximum field length.
Actual Data Enterad = 274,
DTD Length = 100,

Diata Truncated = 174

Field value exceeds the ICER
item's maximum field length.
Actual Data Entered = 434,
DTD Length = 100,

Data Truncated = 334

Invalid E2B Code - WW
Invalid E2B Code - EU

Invalid E2B Code - RA

2

2

1,2,3,4
1,2,3,4

1,2,3,4

CEL-234-002

CEL-234-001

CEL-234-002

CEL-234-001

WORLD
EUROFPEAN UNION

ASIA
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Viewing the ICSR Length Check Report

This section enables you to view the ICSR Length Check Report.
Use the following procedure to view the ICSR length report.

1. Select Tools >ICSR Length Check.

ORACLE" Welceme Administrator, DRl AT EC

I Code Lists | Business C Access System Configuration Tools

ICSR Length Gheck |

2. The ICSR Length Check PDF report opens in a separate window.

ICSR Report Data Check Errors & Warnings
As of

1 EMA-21-0F

z ICH-ICSR V2.1 MESSAGE TEMFLATE

3 ICH-ICSR V2.1 MESSAGE TEMPLATE - EMA

4. ICH-HICSR V2.1 MESSAGE TEMPLATE - FDA

s ICH-ICSR V2.1 MESSAGE TEMPLATE - FDA PIP

T T T T

S Check Valldat A3 STUDYN, Hmnm IIHE?\?B‘#B“E EHDE%%SJJ‘E ISR 1234 BEGINTHISISSTLND END
Dascription Actual Data %
DD Lengll 1nu
= 1200
List Malntenance / Fisid valie exceeds the ICSR
A3130 | SEMDERTITLE Feguatoy Aumanty ¢ RemTs mamum feg 1234 EMAR2
Local Company Contact/ | Actual Daia Enerad =
Tiie DTD Length = 10,
Cata Truncated = 17
List Malnkenance / Pl valwe exceeds the ICSR
A3130 | SEMDERTITLE oy Aty ¢ | hemie masiTLm fED 1234 ESMFDA1
Local Company Contact/ | Actual Data Emersd = 27,
Tie DD Lengtn = 10,
Caa Tungated = 17
List Malntenancs [ Fidd value sxceeds the ICSR
A3130 | SEMDERTITLE Reguatory Autndty ¢ RerTs maximum feg 1234 ICHRS
Local Company Contact/ | Actual Daia Enerad =
Tiie DD Lengin = 10,
Cata Truncabed = 17
Ust Malntenance / Fisid vallee exceeds the ICSR
A313b | SENDERTITLE oy i Bemfs masimom fed 1.2,3,4  FDA_FIP
LoSal Company Contact/ | Actual Data Emtersd =
Tie oTD =10,
Caa =17
Administrator Saeae Page 1of 11

Q Tip:

This report compares the lengths of the code list elements with the maximum
ICSR length allowed for each of the DTD profiles (ICH, FDA, EMA).

It also displays the elements where the length of the code-list element is
greater than the allowed ICSR length.

ORACLE"
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Using Advanced Conditions

This section discusses how to create and use Advanced Conditions. If you do not have
access to the advanced conditions on certain screens, the system displays only the
Advanced Condition Names you can access (instead of displaying a blank) and does not
permit you to modify or view the advanced condition details. The system displays a warning
message stating that you do not have permissions to update the advanced conditions. The
following screens are affected by this change:

» Expedited Reporting Rules

e Auto Signals

e Batch Reports

e Letters

e Studies

e Case Priority

* Field Validation

* Narrative Templates

«  Profile Switches | Auto Archiving

This option is available from the Advanced Conditions icon.

Oracle Argus Safety provides a powerful search tool that enables complex queries to be built
in order to retrieve data from the system. Detailed knowledge of the database schema is not
required.

Complex or non-standard queries are constructed by means of the Advanced Conditions
dialog, that enable users to define field level search criteria.

Sets of search criteria (advanced conditions) can be saved and retrieved from the Advanced
Conditions dialog. These conditions may then be added, edited, or deleted.

Access rights and permissions can be assigned to individual advanced conditions. You can
execute and modify rights to one or more groups on a per-advanced condition basis.

For more information, see:

*  Features within Advanced Conditions

e Using Advanced Conditions

e Creating Advanced Conditions

e Creating a Query Set of Advanced Conditions

* Rename Query Sets

* Use the Advanced Conditions from the Case Selection Dialog Box
* Use the Advanced Conditions Library

e Case Series (former Hit List) Tab
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Features within Advanced Conditions

By default, the Advanced Conditions drop-down list enables you to view only the New,
None and already selected Advanced Conditions.

1.

Select New or None from the drop-down list and click the AC button to create a
new advanced condition.

Click the lookup icon to filter for existing advanced conditions.
Execute the steps below to filter for existing Advanced Conditions:

Click Lookup in the Case Search Criteria section. The Advanced Conditions
Lookup dialog is displayed.

Select one of the following options from the drop-down list under Filter.

» Contains - Enables you to filter for advanced conditions that contain the
entered criteria.

e Starts With - Enables you to filter for all advanced conditions that start with
the entered criteria.

Enter the search criteria for the advanced conditions in the text box, as applicable.
Click Filter.

The advanced conditions matching the specified filtering criteria are displayed.
Select an advanced condition from the list, as per your search requirements.
Execute any of the actions below, as applicable:

e Click OK. The selected advanced condition is listed in the Advanced Condition
drop-down list.

e Click AC. The details of the selected advanced condition are displayed in the
Advanced Conditions dialog.

* Click Cancel. The Advanced Condition Lookup dialog is closed without saving
any changes.

» Select a previously selected advanced condition from the drop-down list to
apply the search criteria for that condition.

Using Advanced Conditions

Use the following procedure when using advanced conditions.

ORACLE

1.

Click the Select lookup to view/edit/create the Advanced Condition in the
Advanced Condition dialog.

¢ Note:

Only trusted users should be given access to the Advanced Condition,
as users with this access will have complete access to the information in
the Argus schema.
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Chapter 8
Creating Advanced Conditions

To use advanced conditions, the following options are available, depending on how the
set of criteria is to be used:

* To use a set of previously saved criteria, select the appropriate set of criteria from the
Advanced Condition list

 To add a new condition to a set of criteria, select the set of criteria from the
Advanced list and click the adjoining Advanced Condition icon.

* To enable the creation of new advanced conditions by associating logical operators
(like AND, OR) with items from the Case Form, refer to Creating Advanced
Conditions.

» To create an advanced condition query set from existing advanced condition search
criteria, refer to Creating a Query Set of Advanced Conditions.

Creating Advanced Conditions

Use the following procedure to create advanced conditions.

ORACLE

1.

Select New from the Advanced Conditions drop-down list or click the Advanced
Conditions icon.

This displays a confirmation dialog.

Select whether you wish to create a query set by using previous advanced condition
guery sets or by creating one through logical operators.

e Click Yes to create a new advanced condition query set.

e Click No to create a new advanced condition by associating logical operators (like
AND, OR) with items from the Case Form.

If you select No, the Advanced Condition Set dialog is displayed.
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Advanced Condition -- Webpage Dialog

Name | BCG-001 study Description |
gw MM | Case Series |
Properties Conditions
[[B-£ ACTIVITIES . equallo
| _ not equal to
[ ADDITIONAL INFORMATION qrsater than
P £ anaLysis greater than or equal to
less than
EVENTS less than or egual lo
GENERAL missing
MEDDRA DICTIONARY ALL SOC o
begins with
MEDDRA DICTIONARY PRIMARY SOC Containg
) MedDRA SSC (Spacial Search Category) 38 doée not conlain
Field |
Value | | @ | | |
Criteria + Share with other users Permissions | J showsaL J  New -
Property Conditions Value
|SlunyID | equalto BCG-001 | w -
-
SaveAs Save || OK Cancel |
¢’ Note:
»

The Advanced Condition Set dialog enables you to search for those
entities under the Properties tree-list, which are from either the case data
or from the code list. For this, the dialog provides two radio buttons -
From Code List and From Case Data.

*  Select the relevant entity and one of the radio buttons, as applicable.

e This searches the entity based from the code list or case data, as
specified.

e The radio buttons are displayed only if the selected entity belongs to
a code list.

* If the selected entity is part of the code list, and the user selects:

— From Code List - If this option is selected, the Value drop-down
list displays the list of all values configured in the Code List.

— From Case Data - If this option is selected, the Value drop-down
list displays the list of only those values, which are actually
present in the cases.

Select a property type from the Properties tree list.

The items available under the folders in the Properties list represent those fields
on the Case Form that can be used to perform the search in the advanced
conditions.

ORACLE"
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10.
11.

Chapter 8
Creating Advanced Conditions

< Note:

When a Property for which terms can be encoded is selected, the Select button
is enabled. You can use the MedDRA Browser to select (possibly) multiple
terms for the property.

An SMQ icon is enabled when the SMQ-related properties are selected from
the Properties tree-list. Click this icon to view the SMQ Info dialog. The SMQ
Info dialog contains details about the selected SMQ.

In the Conditions list, select a condition that must apply to the item selected above.

The available conditions are "equal to", "contains”, "less than", "greater than", "not equal

to", "missing"”, "greater than or equal to", "less than or equal to", "exists", "does not
contain” or "begins with".

Under Value, enter the value which will apply to the property, or select an appropriate
value from the list, as applicable.

If the condition created in steps 3 through 5 above is to be linked with another condition,
select the appropriate logical operator in the list adjoining Value.

Tip:
The logical operators that can be used to link the existing condition to a new
condition are AND/OR.

Click Add to add the newly created condition to the advanced condition.

Repeat steps 2 through 6 to add more conditions to the advanced condition.

When each of the required conditions for the advanced condition is entered, click Save.

Enter a name for the advanced condition and click OK.

8-5



Chapter 8
Creating a Query Set of Advanced Conditions

< Note:

To enable other users to use the advanced condition, the Share with
other users check box should be selected. More about sharing
advanced conditions:

« |f an Advanced Condition is not shared with other users, it does not
appear in the Advanced Condition list for any user except the
Administrator and the user that created it.

« |f the Advanced Condition is shared, all users can view the advanced
condition, but they cannot modify it.

— Not allowed if the Advanced Condition is in use in the system.

— Argus Console manages access to the Advanced Condition
Library screen.

— The Advanced Condition Library option has been added to
enable or disable (default) access to the following screen:
Access Management > Argus > Groups> Menus>
Utilities (subarea) section

IMPORTANT! Customers should cleanup the aggregate case series data
(such as cfg_adv_cond_hitlist and related tables) from the Advanced
Condition Library which are no longer used or are not likely to be
required in future.

With each periodic execution, the number of aggregate case series can
keep growing in the system and it is up to the customers to manage
these case series either by deleting them manually or by deploying an
Oracle job.

Tip:

To enter a customized date range, select Custom Date Range from the list.
Enter an appropriate date range in the custom date range dialog and click
OK.

Creating a Query Set of Advanced Conditions

The user can configure the Action Items type to be scheduled based on the Advanced
Conditions rules.

For more information, see:

*  New Action Type Fields and Field Description
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New Action Type Fields and Field Description

Field or Control Name Description

Property

Query Action Defines the Action Item as a Query Action used to
generate the letter and used as a placeholder.

Advanced Conditions  Enables you to configure an Advanced Conditions Rule
for creating the Query Type Action Item in the case.

User Group Enables you to define a User group (undeleted user
groups in Access Management) for the Action Item
created in the case.

Letter Placeholder Enables you to enter Letter Text that prints in the letter
Content using the Open Query placeholder.
Due In (days) When the action item is created on the Case form, this

option enables you to define the number of days until
the Action Item is due..

Checkbox

User Selectable

Type Ahead

Text (1000
characters)

Be aware of the following:

* The Advanced Conditions, User Group, Letter Placeholder Content, and Due In fields are

enabled only if Query Action is checked.

* The system tracks any changes made to the profile switch in the audit log.

e The Action Type report prints any additional fields.

* The system has a profile switch to enable you to generate open queries when he/she

saves the case.

— No (Default) - When you click No, the system does not generate open queries in the

case when you save the case.

— Yes - When you click Yes, the system generates all action items with a query action
type based on the advanced conditions defined for the Action Taken due in xxx days

for User group yyy
where:

xxx is the number of action items defined + the System Date for the defined user

group.
yyy is the user group.

— The system tracks changes made to the Profile Switch in the audit log.

Use the following procedure to create a query set of advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced
Conditions icon. A dialog that prompts for the creation of an advanced condition query set

opens.

2. Click Yes to create a set of advanced conditions by linking together those advanced

conditions that have been defined previously.

3. The Advanced Condition Set dialog opens.

In this dialog, previously-created advanced conditions can be linked together using set

operators like UNION, MINUS, and INTERSECT.

ORACLE
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Advanced Condition -- Webpage Dialog

Name | BCG-001 study Description |
gw MM | Case Series |
Properties Conditions
[E+5 actvmes T [equa
e not equal to
=)

|[F-{=) ADDITIONAL INFORMATION

graater than

3 ANALYSIS greater than or equal to
less than
7 EVENTS less than or eoual lo
3 GENERAL missing
) MEDDRA DICTIONARY ALL S0C R
begins with
3 MEDDRA DICTIONARY PRIMARY SOC Contains
{7 MedDRA S5C (Special Search Calsgory) 38 doée not conlain
Field |
Valua | | @ | | |
Criteria +  Share with other users Permizgions I I Show SQL l Naw -
Property Conditions Value
|SlunyID | equalto BCG-001 | w -

SaveAs | save || OK Cancel |

4. Click Add to add an advanced condition to the query set. A new row opens in the

advanced condition selection area. In this row, select an appropriate advanced
condition from the Advanced Condition list.

Q Tip:

To modify, open, or delete advanced conditions, click Open in the
Advanced Conditions dialog. A list of all the advanced conditions will be
displayed. In this list, select the appropriate advanced condition and click
Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced
condition, click Show SQL. Make the required modifications to the SQL
statement, if necessary. The SQL supports the list of parameters as
defined in the profile switch Comma separated list of allowable
parameters for custom advanced conditions.

Select an appropriate set operator from the Set Operator list. This set operator
will link this advanced condition to the next advanced condition.

To add the next advanced condition to the query set, click Add.

Repeat steps 4 through 6 for each advanced condition that must be entered in the
query set.

ORACLE"
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Tip:
If the required advanced condition is not already present in the list, it can be
created by selecting (New) from the list.

* If an existing advanced condition requires modification, select it and click
Edit.

e The advanced condition can be edited by a user only if it was created by
that user.

8. When each of the advanced conditions for the query set is entered, click Save.

9. Enter a name for the advanced condition and click OK.

Tip:

To view or modify the SQL statement associated with an advanced condition,
click Show SQL. Make the required modifications to the SQL statement, if
necessary.

Rename Query Sets

You can save and retrieve sets of search criteria (advanced conditions), and add, edit, or
delete them.

You can select and rename a query set on the Advanced Condition screen based on the
permissions to modify the advanced condition. When you open an advanced condition or
query set, the query name is displayed in the Name field.

* To enable the Save button, in the Name field, enter an advanced condition name.

e To record changes to the advanced condition name, click Save.
The query set is saved with the new name and description, and the Query Set drop-down
list is refreshed.

e To update the changes to the query set name, click Save.

*  When you click New, all the values in the Name, Description, and Query Set fields are
cleared.

Use the Advanced Conditions from the Case Selection Dialog
Box

Users can view a list of Cases that satisfies an Advanced conditions from the Case Open
screen.

1. Select Case Actions > Open.
2. You can do the following:
» Use a set of previously saved criteria.

» Select the appropriate set of criteria from the Advanced Condition list.
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» Select the set of criteria from the Advanced list, and click the adjoining
Advanced Condition icon.

 Add a new condition to a set of criteria.

» Create a new advanced condition by associating logical operators (like AND,
OR) with items from the Case Form.

Use the Advanced Conditions Library

From the Utilities drop-down menu, select Advanced Conditions Library.

From this screen, you can:

Create a new advanced condition
Reassign an advanced condition

Set advanced condition permission levels
Modify an existing advanced condition
Delete an advanced condition

Print a list of advanced conditions

To search for an existing query sets or advanced conditions, enter the search criteria,
and click Search.

Case Series (former Hit List) Tab

The Case Series (former Hit List) tab in the Advanced Condition Set dialog can be
used to search for cases that match the query set criteria.

ORACLE

1. Click Find Now in the Case Series (former Hit List tab) of the Advance Conditions
dialog.
This runs a search based on the selected query set criteria and displays a list of
cases (if any) that satisfy the advanced condition query set.

2. Perform these operations to do the following:

To... Click...

Manually add an existing case to the case series Add and enter the Case ID
(former Hit List)

Remove a case from the Case Series (former Remove

Hit List)

Save the Case Series (former Hit List) result for Store Advanced Condition (former Hit List)
future use

Retrieve results of the saved Case Series Retrieve Advanced Condition (former Hit
(former Hit List) List)

Save the Case Series (former Hit List) as a text Export

file

View SQL for Query Show SQL

Run a Query Find Now
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Data Privacy

The Oracle Argus Safety application provides various methodologies to protect data between
different sites, user groups, and users. This chapter discusses personally identifiable
information (PII) and the methods to protect it.

For more information, see:

e Personally Identifiable Information

» Personally Identifiable Information and Application Behavior

Personally Identifiable Information

ORACLE

Pl (personally identifiable information) or SPI (sensitive personal information), as used in
information security and privacy laws, is information that can be used on its own or with other
information to identify, contact, or locate a single person, or to identify an individual in context.
Pll is any data that could potentially identify a specific individual. Any information that can
distinguish one person from another and can be used for de-anonymizing anonymous data
can be considered PIl. The application protects the sensitive Pll data as per user access.

< Note:

All PIl is personal data, but not all personal data is PII.

In Oracle Argus Safety, the following data is considered as PII:

* Patient Initials
» Patient Date of Birth
e Parent Initials
» Parent Date of Birth

The PII Data can be controlled via user group accesses and common profile switches. The
user group accesses that can be used to control the Pl data fields are:

» Case Patient - Patient Information
e Case Patient - Patient Details
e Case Patient - Parent Information
» Case Patient - Parent Details

These user groups accesses are found under Argus Console > Access Management
> Groups.

In the Case Form, the patient and parent fields are grouped under the Information/Details
sections as shown below.

Patient Information and Details Sections
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Gonoral | Patient)]| Products | Events | Anaiysis | Activiios | Addiionalinformation | Regulatory Reports

Pt o o Repener ] Caren eaea e T )

[rF] |C3 Protect Confidentiality () Child Only Case
Address 1 Ciy® County Country
[ m jmm | Jom [ ]
Adross 2 stte Postal Code Phone Number Email Address
[ m o | m Jem | m
Date of Birth Age Units Age Group Height Weight # Race Information (0)
Toox () Concomitant Therapy N
7277:0000 Jem [ ] ] I ]l [ ] ] Admistered
Gender Pregnant Date of LUP
| [72277-0000 |@3  Breastieeding
Occupation Ago at Vaccination Units (st Vaccination) Ethnic Group Milkary Status Prognant a tme of Vaccination

Parent Information and Details Sections

Gonerel |QUBRGR Protucts | Events | Analyss | Activiies | Addionat nformation | Reguistory Reports |
e =
Tite Firs Name Widdle Name LastNome Parent ndals
[ I Jom | |3 o |
Dato of Birth Age Units Height Weight # Race Information (0) [_Asa_][_osite |
(7770000 |Em | I ] I ] ]l v] B
Gender Dateof LHP Age atVaccination Unisft Vaceination) Ethnic Group

@@ Porent Breastieading [ [ I ]
Wedical Wistory

‘ L

The fields are controlled through the user groups as shown in the table below.

Group Access  Value Case Form Impacted Case Form Fields
Name Behavior

Case Patient - Modify User can add/ Patient Information
Patient View modify all the . Title

Information No Access fields .  First Name

User can only +  Middle Name
view the fields . Last Name

The fields are « Address 1
hidden and «  Address 2
inaccessible .

e City

e  State

e Postal Code

*  Country

e Email Address

¢ Protect Confidentiality
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Group Access  Value Case Form Impacted Case Form Fields
Name Behavior
Case Patient - Modify User can add/ Patient Information
Patient Details View modify all the o Initials
No Access fields Patient Details
U.SH can _only »  Date of Birth
view the fields .
) * Age and Age Units
T.he fields are - Age Group
hldden and *  Weight and Units
inaccessible i )
*  Height and Units
*  Gender
. Pregnant
*  Date of LMP
*  Breastfeeding
e BMI
* Body Area
e Occupation
*  Age At Vaccination and Units
»  Ethnic Group
e Military Status
Country
*  Pregnant at time of Vaccination
Case Patient - Modify User can add/ Parent Information
Parent View modify all the . Title
Information NO Access fields «  First Name
Usercanonly . piddle Name
view the fields . Last Name
The fields are
hidden and
inaccessible
Case Patient - Modify User can add/ Parent Information
Parent Details  \jiey modify all the « Initials
No Access fields Parent Details

User can only
view the fields

The fields are
hidden and
inaccessible

«  Date of Birth

*  Age and Age Units

*  Weight and Units

*  Height and Units

e Gender

»  Date of LMP

»  Parent Breastfeeding

*  Age At Vaccination and Units
e Ethnic Group

*  Medical History

< Note:

The initials field is located under the Information sections, but still controlled through

the Details access group.

ORACLE
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This default behavior can be overridden using a set of common profile switches. The
switches located at Argus Console > System Configuration > System
Management (Common Profile Switches) > Case Processing > Group
Data Access are used for this purpose. These switches help the Initials and Date of
Birth fields to be controlled via the alternate user groups as shown below.

Switch Name Use Default Value

Access on Patient Sets the Patient Initials either to be part Initials part of Patient Details

Initials of Patient Information or Details Group  Access Group

Access on Patient Sets the Patient Date of Birth either to be Date of Birth part of Patient

Date of Birth part of Patient Information or Details Details Access Group
Group

Access on Parent Sets the Parent Initials either to be part  Initials part of Parent Details

Initials of Parent Information or Details Group Access Group

Access on Parent Sets the Parent Date of Birth either to be Date of Birth part of Parent

Date of Birth part of Parent Information or Details Details Access Group
Group

Personally Identifiable Information and Application Behavior

ORACLE

This section provides details about the impacted areas and their behavior.
Case Form Print, Case Summary and Medical Summary Reports

The Case Form Print, and the Case and Medical Summary reports display Pll data
fields only based on the user group access and common profile switches setup.

Case Form Title Bar

For certain report types, the case form title bar displays the Patient initials. These will
now be visible based on user group access and common profile switches.

Case Revision

Case Revisions display Pl data based on the user group access and common profile
switches.

Audit Log Report

The Audit Log reports displays the Pll data based on the user group access and
common profile switches. If the main user group (Argus Console > Access
Management > Groups > Patient Information) is restricted, the new user
group access and common profile switches will be ineffective.

System Reports

Both the Patient and Parent PII data in the system reports are controlled only through
Argus Console > Access Management > Groups > Patient
Information. The sub-level user group access and common profile settings do not
have any effect.

Duplicate Search (Book-in, Local Affiliate and ICSR Pending)

The Duplicate search result displays the Pl data based on the user group access and
common profile switches.

Case Copy and Audit Logging
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Case Copy and the Audit Log continue to handle Pl data even when the fields are hidden or
read-only.

Copy Patient Information from Reporter

Patient initials are copied from the reporter only when the Patient initials field is visible and
editable.

Patient/Parent Initials Automatic Calculation

The Patient or Parent Initials are automatically calculated when the Patient or Parent initials
field is visible and editable.

Accept ICSR/Affiliate Acceptance (Interchange and LAM)

The Accept ICSR/Affiliate Acceptance dialogs and reports work as in the existing version of
Argus Safety. These modules do not follow the PII restrictions levied by user group access
setting and common profile switches.

The following sections provides a sample of the Case Form behavior between two users who
have been set up for PII Data Privacy.

User Details Access Settings

User 1 User ID: usr_pat_info
Group: Patient_info_group
Access Setting: Case Patient - Patient Information: No Access
Case Patient - Patient Details: Modify

User 2 User ID: usr_pat_det
Group: Patient_det_group
Access Setting: Case Patient - Patient Information: Modify
Case Patient - Patient Details: No Access

No changes to the common profile set up from the default values.

With the above set up when user 1 and user 2 logs into the application, the application
behaves as following:

Logged in User Application Behavior

usr_pat_info In the case patient tab, all the fields under Patient-Information group are hidden
except Initials, Child Only case and Country fields.

usr_pat_det In the case patient tab, all the fields under Patient-Details group are hidden.
Patient Initials, Child only Case and Country fields are hidden too.
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